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Preface 

THE Artline User Reference Guide provides detailed descriptions 
of the many features of Version 2.0 of Artline®, the most produc­

tive graphics illustration program for the IBM® PC, Compaq®, and 
other PC-compatible computers. 

Artline offers features and speed, which, combined with 
your own creativity, add up to outstanding graphics for 
business and design professionals, full-time or part-time­
someone like you, who needs a full range of tools for any 
kind of design challenge. 

Artline, Version 2.0, is an entirely new program, although 
it shares some features with its predecessor, GEM® Art­
line™. New features in this version of Artline include: 

o interactive auto tracing 
o layers 
o custom tools 
o custom color management 
o full PostScript® font support 
o masking, merging, and blends 
o text along a path 
o extensive clip art selection 

xv 



Documentation Set 

Documentation Set 

xvi 

The Artline documentation set includes these books: 

o Artline User Reference Guide 

o Artline Installation / Startup / Tutorial 

This book is actually three books in one, containing in­
structions on how to install Artline on your system, 
how to start Artline (including starting Artline from 
Microsoft® Windows®), and a tutorial that introduces 
you to most of the features of Artline, Version 2.0. 

o Artline Utilities Guide 

This book describes three Artline utilities: 

- The filter programs for converting fonts from the 
Bitstream® .PFA, Adobe® Type 1, and Fontographer® 
formats to the Artline .AF4 format. 

- The Output program, with which you can print or 
display your Artline files and save "output lists" of 
files for future printing or display. 

- The MAGICorp® service, which you use in combina­
tion with Output to produce slides, overhead trans­
parencies, and photographic prints of your Artline 
pictures. 

o Artline Clip Art Gallery 

This book contains illustrations of the over 200 pieces 
of clip art included in the Artline package, as well as in­
formation on how to order additional pieces from the 
vendors represented. 



Organization of This Guide 

Organization of This Guide 

The Artline User Reference Guide is not meant to be read 
from beginning to end. It is intended primarily to be used 
as a "dictionary," to look things up as questions arise. 
Using the Index and the chapter listings in the Contents, 
you should be able to find the information you need at the 
moment you need it. 

The following is an overview of the contents of the Artline 
User Reference Guide: 

o Chapter 1, "Introduction to Artline," describes several 
of the basic features and concepts used in Artline. 

If you have used other programs with a similar user in­
terface-for example, GEM Artline or GEM® Draw 
Plus™-some of the information in this chapter may be 
familiar to you. However, make sure you are familiar 
with all the material in this chapter, as several of the 
key features are new and unique to this version of Art­
line. 

o Chapter 2 describes the tools in the Artline toolbox. 
These are the tools you use to draw, enter text, assign 
and create colors, and perform many of the special 
graphics editing functions of the program. 

o Chapters 3 through 9 describe the commands in each 
of Artline's menus. Each menu has a chapter to itself. 

o Chapters 10 through 13 describe additional important 
features of Artline: layers, autotracing, color manage­
ment, and tools creation and management. 

o Appendix A lists the names of the Artline fonts that cor­
respond to the resident PostScript fonts. 

o Appendix B describes how Artline uses memory. Note 
that expanded memory (EMS) is not required for 
tracing. 

o Appendix C illustrates and describes the custom 
toolboxes provided with Artline. 
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Notational Conventions 

Notational Conventions 

Single step. 

Options. You can 
do either one. 

Sequence of steps. 

xviii 

This section describes the notational conventions em­
ployed in the Artline User Reference Guide. 

Bullets 

Bullets (0) set off a list of items or a set of equally valid 
options or choices. Bullets do not indicate a sequence of 
steps to be followed. 

Instructions 

Instructions are preceded by a brief statement of what 
yOlol will be doing, followed by a single instruction, bullets 
(indicating options), or a numbered sequence of steps. 
Below are examples of the three possibilities. 

To do this action: 
You can do only this one thing. 

To do this action: 
o You can do option # 1. 
o You can do option #2. 

To do this action: 
W You must do this step first. 

[]] You must do this step next. 

[]] You must do this step third in the sequence. 

Return Key Symbol 

The symbol.J represents the computer's Return (or 
Enter) key. 

Marginal Notations 

The guide frequently uses marginal notations (like those 
used above) to provide additional information, supple­
menting the information contained in the main text body. 



Developing Your Own Techniques 

Developing Your Own Techniques 

Bon Voyage 

The Artline User Reference Guide provides specific in­
structions on how to do many things with Artline, Version 
2.0. However, as you gain familiarity with the program, 
you will certainly develop your own techniques. Feel free 
to experiment and to learn. 

One word of caution (if you're an experienced user, you 
don't need to be reminded of this): save your files before 
you branch off into uncharted waters. 

Welcome to Artline, Version 2.0. 

We hope you find this exciting program the perfect outlet 
and the ideal medium for your creative work. 
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Introduction to Artline 

THIS chapter describes some of the basic concepts, terms, and 
techniques that apply throughout Artline, including: 

o components of the Artline screen 
o basic mouse techniques 
o elements 
o file types 
o menus 
o dialogs and alerts 
o the I tern Selector 

1-1 



Artline Screen 

Artline Screen 

title bar 

1-2 

This section describes the components of Artline's screen 
as it appears when you first start the program. 

scrollers 

Artline Window 

The Artline screen includes a window that can be moved 
and whose size can be changed. The window is bordered 
by the title bar, toolbox, and scrollers. 

Toolbox 

The toolbox contains icons (pictures) of the tools with 
which you can draw and manipulate the elements that 
make up your Artline pictures. 

The standard Artline toolbox is described in Chapter 2. 

You can also use Artline's Tools Manager to create your 
own custom tools and save custom toolboxes. The Tools 
Manager is described in Chapter 13. 

Artline User Reference Guide 



Artline Screen 

Menu Bar 

The menu bar contains the names of Artline's command 
menus. 

Basic menu techniques are described on page 1-12. The 
commands in each menu are described in Chapters 3 
through 9. 

Title Bar 

The title bar contains the name of the file currently open 
on the drawing surface. 

If you have not opened a file or have not named the pic­
ture you are working on, the title bar reads UNTITLED. 

The title bar also lists the name of the picture's active 
layer. Layers are described in Chapter 10. 

Moving the Window 

You can move the window down or to the right. To move 
the window, drag the title bar. You cannot move the win­
dow off the left side of the screen or up into the menu bar. 
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Artline Screen 

1-4 

L.~, ~. 
f • t .. 

1 

workspace 

drawing surface 

surround 

In these two views, the 
workspace entirely encloses 
the drawing surface. 

drawing surface 

surround 
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Artline Screen 

Workspace, Drawing Surface, and Surround 

The workspace and the drawing surface are not the same 
thing. One way of stating it is that you draw in the work­
space, but you draw on the drawing surface. 

The workspace is the area of the screen enclosed by the 
title bar, toolbox, and scrollers. It is like a frame, through 
which you view the drawing surface. 

The drawing surface is where your picture is actually cre­
ated, like a piece of paper of certain dimensions. 

The surround is the area surrounding the drawing sur­
face. You can place elements and reference points like the 
Thumbtack in the surround. 

The amount of drawing surface visible in the workspace 
at a given time can vary considerably. You can zoom in so 
that only a small portion of the drawing surface is visible, 
and you can zoom out so that the entire drawing surface 
is visible. 

Introduction to Artline 

In this view, the workspace 
encloses only a portion of 
the drawing surface. 
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Artline Screen 

You can also scroll 
lists in several dialogs 
using the same 
techniques. 

1-6 

Scrollers 

Scrolling is only meaningful when some of the drawing 
surface is not visible in the workspace. In that case-for 
example, when you have zoomed in on the drawing sur­
face-the scrollers allow you to bring other parts of the 
drawing surface into view in the workspace frame. 

The scrollers consist of: 

o arrows (up and down, left and right); 
o scroll bars; 
o sliders. 

up arrow --+ ...... 

::::::: +-- scroll bar 

+-- slider 

scroll bar ---. I:::":: 

..... +-- down arrow 

Arrows 

To scroll a small, fixed distance in a given direction, click 
on the appropriate arrow. For example, to scroll toward 
the top of the drawing surface, click on the up-arrow. 

Scroll Bars 

To scroll a larger distance (roughly one screen's worth) in 
a given direction, click on the scroll bar. 

Artline User Reference Guide 
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Artline Screen 

Sliders 

The sliders serve two purposes: 

o They allow you to scroll as much or as little as you like. 
To use a slider, drag it in the direction you want to 
scroll. For example, you can use the vertical slider to 
scroll quickly to the top or bottom of the drawing sur­
face, or you can use it to adjust the position of the 
drawing surface in the workspace. 

o They also indicate how much of the drawing surface is 
visible in the workspace. If the slider entirely fills the 
scroll bar, the drawing surface is entirely visible in 
that direction. If the slider half fills the scroll bar, half 
of the drawing surface is visible in that direction. 

Size Box 

By dragging the size box, you can change the window's 
size, making it smaller or larger. 

Full Box 

Clicking on the full box returns a window to its full­
screen size. 

Redrawing the Screen 

To force a screen redraw, press the Esc key. 
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Basic Mouse Techniques 

Basic Mouse Techniques 

If you are familiar with 
these techniques, you 
can skip this section. 

Artline uses three basic mouse techniques: 

o click 
o double-click 
o drag 

NOTE: All three techniques use only the left button of the mouse. 

1-8 

Click 

To click the mouse, press and immediately release the left 
button. 

In Artline, clicking is used for selecting elements and 
tools, choosing commands, selecting options in dialogs, 
and many other tasks. The click affects whatever is di­
rectly under the tip of the mouse pointer. 

Double-Click 

To double-click the mouse, press and release the left but­
ton twice in rapid succession. 

In Artline, double-clicking is used for selecting files, dis­
playing tool options dialogs, and a variety of other tasks. 
The double-click affects whatever is directly under the tip 
of the mouse pointer. 

Artline User Reference Guide 



Basic Mouse Techniques 

Drag 

Dragging is a technique that is used for-among other 
things-drawing with Artline's drawing tools, placing a 
selection frame around elements, and moving elements. 

To drag with the mouse: 

[]] With the pointer at the starting point (see the illustra­
tion below), press and hold down the left button. 

[]] With the button still down, move the mouse to the 
end point. 

llil Release the mouse button. 

start here --. , ................................................................................................................................................................................... _ ............................................ , 

: ......................................................................................................................................................................... _ ..••• _ ••• _ ••. _ •••••.•••••• _ •••.••••••••••••.•••••••• i .. .-- end here 

In this case, the mouse pointer has dragged a 
selection frame around the drawing of the guitar. 
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Elements 

Elements 

Stacks 

1-10 

The individual pieces of the pictures you create in Artline 
are elements. 

Elements can range from simple geometric shapes like cir­
cles and squares to complex forms made of connected 
lines and curves. Text characters are one example of the 
more complex kinds of elements. 

In most respects, the drawing surface is like a sheet of 
paper. However, it differs from a sheet of paper in that 
the elements in your picture sit on the drawing surface in 
a stack, one element on top of another. Each time you add 
a new element, it is placed on top of the stack. 

The only time you really need be concerned with elements 
stacks is when elements overlap each other (see the ex­
ploded view of the guitar above). In that case, the posi­
tion of an element in the stack determines how you select 
it (described in Chapter 2). In addition, you can change 
the position of the element in the stack (Chapter 6). 
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File Types 

extension 

. GEM 

. COL 

. TLS 

.IMG, .TIF, .PCX 

. COO 

.EPS 

. GMP 

.AF4 

File Types 

Artline uses many different extensions to identify the 
kinds of files associated with the program. The following 
table gives a brief description of each file type. 

description 

An Artline picture file. Also an exported file format . 

Several other programs create files with the .GEM extension. 
Some can be opened in Artline (those created by GEM Draw Plus, 
for example), while others (those created by GEM® Paine) result in 
an empty drawing surface. 

A color palette file . 

A tools file . 

An image format valid for tracing. 

The PostScript File output format . 

Encapsulated PostScript. A file format intended for inclusion in 
desktop publishing documents. 

An exported multiple-page format . 

The Artline font file format. Do not confuse with .AFF, the GEM 
Artline font file format. See the Artline Utilities Guide. 

Introduction to Artline l-ll 



Menus 

Menus 

This section describes some of the basic Artline menu com­
mand techniques, including: 

o displaying menus 
o choosing commands 
o keyboard commands 

Chapters 3 through 9 describe the commands in each of 
the menus. 

Displaying Menus and Choosing Commands 

A command followed 
by three dots (like 
Export ••• ) displays 
a dialog. 

1-12 

To display menus and choose commands, move the 
pointer to the menu bar. Depending on your choice in the 
Preferences dialog (see the description of the Prefer­
ences command in Chapter 9), the menus can operate as 
either drop-down or pull-down menus. 

Drop-Down Menus 

To display the menu, touch the menu's name with the 
pointer. The menu automatically drops down from the 
menu bar. 

To choose a command, click on its. name in the menu. 

Pull-Down Menus 

When menus are set to Pull-Down, you can display 
menus and choose commands in either of two ways: 

o Click on the menu name to make the menu appear and 
then click on the command name. 

o Press and hold down the mouse button over the menu 
name, and then drag through the menu until the com­
mand you want is highlighted (white letters on a black 
background). To choose the command, release the 
mouse button over the highlighted command name. 
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Menus 

\\Undisplayingll Menus 

If you accidentally display a menu (often because your 
menu preference is set to Drop-Down and you've made a 
random mouse excursion into the menu bar), move the 
pointer out of the menu and click. The menu will go 
away, and you will not inadvertently execute a command. 

Unavailable Commands 

Commands that are dimmed (that don't become high­
lighted) are unavailable and cannot be selected. A com­
mand is unavailable when its action is not meaningful. 

For example, if you have not grouped any elements, the 
Ungroup command (Element menu) is unavailable be­
cause there is nothing to ungroup. 

Keyboard Commands 

You can choose many of Artline's commands directly from 
the keyboard. These keyboard commands are listed in 
the menu to the right of the command name. The Ctrl 
key is represented by a caret (A); the Alt key is repre­
sented by a diamond ( • ). 

For example, the keyboard equivalent of the New com­
mand is A W, which means you hold down the Ctrl key as 
you press W. The keyboard command for Cut is • X­
hold down the Alt key as you press X. 

If a menu command is unavailable, its keyboard equiva­
lent is also unavailable. 
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Dialogs 

io rad 
button s 

I 

I 
che 
box 

ck 
es 

A dialog is a box that appears on the screen, often when 
you choose a command. Dialogs are used for many pur­
poses, including specifying the size and orientation of 
your page, creating colors, and moving or scaling ele­
ments by precise amounts. 

This section describes these components of dialogs: 

0 radio buttons 
0 check boxes 
0 direct entry fields 
0 pop-up sliders 
0 pop-up menus 
0 exit buttons 

Text Along a Path Add Color 
Text Scaling Color Nallle I!m~·.~ 
@ None 
() Change Spacing to Fit % Red direct 

entry () Change Size to Fit 
% Green fields 

Options % Blue 
o Show Path 
~ Rotate Text Around Path Color Modd ()CMY @RGB ()HSB 

exit buttons 

I OK II Cancel I OK Cancel 

Radio Buttons 

Radio buttons are so named because they resemble the 
station selector buttons on a car radio. One button must 
always be chosen, and choosing a new button automati­
cally cancels the previous choice. 

Radio buttons are identified by a circle. The selected op­
tion is indicated by the solid dot inside the circle. 

In the Text Along a Path dialog illustrated above, 

Text Scaling -------, 
() None 

there are three Text Scaling options: None, Change 
Spacing to Fit; and Change Size to Fit. In the illus­
tration the None option is selected. If you click on 
Change Size to Fit, the dot moves to indicate your 
new selection (see left). 

() Change Spacing to Fit 
@ Change Size to Fit 
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Dialogs 

Check Boxes 

A check box is like a light switch: it turns something on 
and off. 

Check boxes are identified by a square. When the check 
box is turned on, the square is filled with an X. 

[8J Show Path 
on 

o Show Path 
off 

In the Text Along a Path dialog illustrated on the previ­
ous page, there are two check boxes-one for Show Path 
and the other for Rotate Text Around Path. Either state 
can be on or off completely independently of the other. 
For example, turning the Show Path option on has no ef­
fect on whether the text is oriented to the path. 

Direct Entry Fields 

A direct entry field is one in which you can type directly 
into the field. As soon as you start typing, the field is 
automatically cleared, and your entry appears. 

Active Field 

The active field is the one in which your entry appears. 
Only one direct entry field can be active at a time. 

On color screens the active field is identified by a light 
blue background. On monochrome screens (''black and 
white"), the active field has white letters or numbers on a 
black background. 

Moving From Field to Field 

You can make another field active by: 

o clicking on it with the mouse; 
o pressing the Tab or down-arrow key to move to the 

next field; pressing the up-arrow key to move to the 
previous field. 
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Dialogs 

Some numerical 
direct entry fields 
accept negative 
values. 

NOTE: 

1-16 

Types 

There are two kinds of direct entry fields: text and numer­
ical. Each type is represented in the illustration of the 
Add Color dialog. 

o Color Name is a text direct entry field; it accepts text­
letters or numbers. 

o % Red, % Green, and % Blue are all numerical direct 
entry fields. They accept numbers only. 

Numerical direct entry fields are associated with pop­
up sliders, described on page 1-17. 

The range of values accepted by numerical direct entry 
fields varies according to the field's function. If you type a 
value that is too large or too small for the given field, Artline 
displays an alert and then automatically resets the value to 
the allowed maximum or minimum. 

Text Field Editing Keys 

To move the cursor in a text direct entry field, press the 
left-arrow or right-arrow keys on the numeric keypad. To 
delete the character to the left of the cursor, press the 
Backspace key. 

Numerical Field Editing Keys 

You can change the value in an active numerical field by 
pressing these keys: 

o The plus (+) key on the numeric keypad increases the 
value; the minus (-) key decreases the value. The 
amount of change varies from one field to another, de­
pending on the field's range of values. 

Holding down the Shift key as you press the plus or 
minus key changes the value by a smaller amount. 

o The PgUp key automatically sets a field to its maxi­
mum value; the PgDn key sets the field to its mini­
mum value. If the field is already set to its maximum 
or minimum, the key clears the field instead. 
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A field does not have 
to be active for you to 
use a pop-up slider. 

Dialogs 

Pop-up Sliders 

You can also enter values into numerical direct entry 
fields by using the pop-up sliders. 

To display a pop-up slider, move the pointer to the field 
you want and press the mouse button. 

As you drag the pop-up slider's handlebar, the values ap­
pear in the field. 

If you press the Shift key as you drag the slider, the val­
ues change by smaller increments. 

In most cases the pop-up sliders can enter values only in 
set increments-like 10%,20%,30%, and so on. To enter 
a value of 18%, you must type it into the field. 

Pop-up Menus 

Many dialogs also use pop-up menus to offer a choice of 
several options. Pop-up menus are identified by a down­
ward-pointing arrow at the right end of the menu bar. 

E M d xport o e 
Export Active Layer I" 

Active Layer -
Uisible Layer 

""]1.1(1' 

Spot Colors '\ 

Selected EleMents 

To display a pop-up menu and choose an option, you can: 

o click on the pop-up menu bar (to display the menu) 
and then click on the option you want; 

o press and hold down the mouse button over the menu 
bar (to display the menu), move the pointer through 
the menu until the choice you want is highlighted, and 
then release the mouse button. 
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1-18 

Exit Buttons 

Each dialog has a pair of exit buttons-labeled OK and 
Cancel-with which you close the dialog. 

If you click on the OK button, the options and values in 
the dialog are put into effect. 

If you click on the Cancel button, the options and values 
in the dialog are discarded and nothing is changed. 

Exit Button Keystrokes 

In addition to clicking on an exit button with the mouse, 
you can use the keyboard to exit Artline's dialogs. 

o To choose an exit button that has a heavy outline 
(usually the OK button), press .J. 

o To choose the Cancel button, press the Esc key. 

Layer Manager, Color Manager, and Tools Manager 

The Layer Manager, Color Manager, and Tools Manager 
are special kinds of dialogs that have menus instead of 
exit buttons. To close these dialogs, choose the menu 
Close command or click on the dialog's close box. 

NOTE: In this guide, the phrase "exit the dialog" indicates that you 
should accept the settings in the dialog and exit, usually by 
clicking on OK or pressing .J. 
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Alerts 

Moving Dialog Boxes 

You can only move 
dialogs that have a title 
bar. You cannot, for ex­
ample, move the Item 
Selector. 

Alerts 

You can move dialog boxes so you can see the drawing 
surface underneath. 

To move a dialog box: 
Place the pointer on the dialog's title bar and drag the 
dialog where you want it. 

The next time you display that dialog in the current Art­
line work session, it will appear where you last left it. 
The next time you start Artline, the dialog will appear in 
its default location. 

Artline uses alerts to display error messages and mes­
sages requesting additional information or instructions. 

error message alert No options are available ~ 
for this tool. 

information alert ••• 1.. Merging JIlultiple-lager file. La!Jers 
., Merge to separate lagers in the current 

file or cOJilbine to a single lager? COJilbine 

Exit Buttons 

To exit an alert, click on the appropriate exit button or 
use the keyboard as follows: 

o To choose an exit button that has a heavy outline (usu­
ally the OK button), press.J. 

o To choose the Cancel button, press the Esc key. 
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Using the Item' Selector 

If you have used the 
Item Selector in other 
programs, you can skip 
this section. 

The Item Selector is a special dialog used for opening, 
loading, and naming files. The Item Selector is displayed 
by several commands, including: 

o Open (File menu) 
o Save As (File menu) 
o Load Image (Image menu) 
o Save As (Color Manager's File menu) 
o Save As (Tools Manager's File menu) 

The illustration below shows the Item Selector and its 
components: 

Directory: Directory line 

close box 

directories 

list window 

files 

1-20 

E: \ART LI NE\ARTWORK\ *. G EMJ *. EPS ____ _ 

*.GEM *. EPS 

• MORE ART 

--+-1 '++1, + TRACTNGS APRI COT • EPS 
SAl LBOAT. EPS 
APRI COT • GEM 
APRI COT2 • GEM 
BUFFALO • GEM 
FREEHAND. GEM 
YACHT • GEM 

Selection line 
Selection: 

OK 

I Cancel I 
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wildcard 

B*.GEM 

*.?OL 

Using the Item Selector 

List Window and Directory Line 

The list window identifies the subdirectories and files con­
tained in the current directory. Subdirectory names (if 
any) always appear first in the list and are marked with a 
diamond. 

The Directory line identifies: 

o the current disk drive; 
o the current directory; 
o the filename and extension specification for the names 

listed in the window. For example, the Directory line 

C:\ARTLlNE\ARTWORK\* .GEM,* .EPS 

tells you that the list window contains the names of all 
files with the .GEM or .EPS extension in the directory 
\ARTLINE\ARTWORK on drive C. 

The list window can display nine names at a time. You 
can scroll the window with the arrows, scroll bars, and 
slider (see page 1-6). 

Wildcards 

You can use the asterisk or question mark wildcard char­
acters in the filename or extension specification. The 
asterisk wildcard takes the place of as many as eight char­
acters; the question mark wildcard takes the place of a 
single character. 

what it means 

all .GEM files whose filename starts with B, like B.GEM, BEAR.GEM, 
or BROTHERS. GEM 

all files with a three-character extension ending with "OL" 
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Using the Item Selector 

For information on 
directory structure, 
consult your operating 
system manual. 

1-22 

Editing Keys 

When the Item Selector first appears after you choose a 
command, its text cursor is in the Selection line. To move 
the cursor to the Directory line, you can: 

D click on the Directory line; 
D press the up-arrow key. 

To move the cursor in the Directory line, use the left­
arrow and right-arrow keys. To delete characters, use the 
Backspace and Del keys. To clear the entire line, press 
Shift-Del. 

Changing the Directory Path 

To open or load a file from a directory or disk other than 
the current one, or to save a picture to another directory 
or disk, you must first change the directory path in the 
Item Selector. 

D To move down a level in the directory tree, to a sub­
directory below the current directory, click on the 
subdirectory's name in the list window. 

D To move up, toward the root directory, click on the Item 
Selector's close box. Each click on the close box moves 
you up one level in the directory tree. 

D To change to another disk drive, go to the root direc­
tory and then click on the close box once more. The 
disk drive identifiers now appear in the list window. 

Click on the identifier for the disk you want. The con­
tents of that disk's root directory will appear in the list 
window. You can then click on subdirectory names to 
move down the directory tree of the new disk. 
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Choosing a File 

When opening or loading a file, you must choose its name 
from the current directory in the Item Selector. There are 
three ways you can do this: 

o Double-click on the file's name in the list window. The 
name is chosen, and you automatically exit the Item 
Selector. This is usually the fastest way to choose a 
name. 

If the name is not initially visible in the list window, 
scroll the window to bring the name into view. 

o Click on the file's name in the list window to make the 
name appear in the Item Selector's Selection line. To 
put this selection into effect, press .J. 

o Type the filename into the Selection line and then 
press .J. 

Naming a File 

When providing a name for a new file the first time you 
save, you must type the name into the Selection line. 

You need not, however, type the extension. When saving 
a picture file for the first time, Artline automatically sup­
plies the .GEM extension. Similarly, these other exten­
sions are automatically supplied: .COO or .EPS (PostScript 
file output, depending on the format chosen), .COL (color 
files), .TLS (tools files), and .GMP (exported multiple­
page files). 

Introduction to Artline 1-23 





Toolbo)( 

THIS chapter describes the tools in the standard Artline toolbox, 
as shown below. 

Selector Layer tool 

View tool Magnifier 

Quill Sketch tool 

Trace tool Text tool 

Rectangle tool Circle tool 

Rounded Rectangle tool Line tool 

Fill Color tool Fountain tool 

Line Color tool Line Width tool 

Rotator Plane 

Thumbtack Flipper 

Rolling Pin 

You can also create your own custom tools, as described in 
Chapter 13. In addition, several ready-made custom tool­
boxes are included in your installation. See Appendix C. 
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Selector Tool 

Before turning off the 
toolbox, select the tool 
you will be using. 

Hiding the Toolbox 

To make a larger workspace available, you can ''hide'' the 
toolbox so that it no longer appears on the screen. 
To hide the toolbox, choose the Toolbox command from 
the View menu. To re-display the toolbox (to select a tool, 
for example), choose the Toolbox command again. 

Selector Tool 

The Selector tool's functions include: 

o selecting elements; 
o scaling elements (changing their size); 
o moving elements; 
o copying elements; 
o moving the guide lines. 

Selecting Elements 
The table on page 2-5 
lists all the techniques 
for selecting elements. 

handl8S,\ 

2-2 

Many of Artline's functions require that elements first be 
selected. For example, you must select an element before 
you can: 

o change its fill color or line color; 
o copy it; 
o delete it; 
o move it to the foreground or background. 

A selected element is identified by a selection frame with 
handles at the comers and midpoints. 
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Selector Tool 

To select a single element: 

If your picture is 
divided into layers, 
you can select 
elements only in 
the active layer. 

Click on the element. 

o Click on the element or anywhere within the area of its 
selection frame. 

If you click on an element that is one of several ele­
ments that are already selected, the other elements 
are automatically de-selected. 

o Drag a selector box around the element. 

Click inside the frame. Drag a selector box. 

To select more than one element: 

o Drag a selector box around the elements. 

o If a selector box would enclose elements you do not 
want, Shift-click to select the elements you want. 

Hold down the Shift key as you 
click on each element individually. 

NOTE: When two elements exactly coincide-for example, a circle 
inscribed in a square-their selection frames visually cancel 
each other out, even though the elements are selected. This 
effect is true for all even numbers of coincident selected 
elements. For odd numbers of coincident selected elements, 
the selection frames are visible. 
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Selector Tool 

To select the element on the bottom of the stack: 

Ctrl-click on the element-hold down the Ctrl key as you 
click on the element. 

To select all elements on the drawing surface: 

Choose the Select All command from the Edit menu. 
The Selector tool does not have to be highlighted when 
you choose the Select All command. 

Selecting Overlapping Elements 

This technique works 
only if you select the 
first element with a 
click or Ctrl-click. 

A 

B 

C 

0 

2-4 

When elements overlap, the topmost element at the point 
where you click is always selected. If this element's selec­
tion frame entirely encloses the selection frames of the 
elements underneath, there is a special technique for se­
lecting the other elements. 

To select an element lower in the stack: 

E 

Press the F4 key. The F4 key "steps" the Selector down 
through the stack, selecting only those elements directly 
under the tip of the Selector arrow at the time you click. 

If you select the bottom element in the stack with Ctrl­
click, the F4 key selects upward. 

In the illustration below, element A is on top and is the 
first element selected in each case. 

If you click here, the F4 key selects element Band 
then element C. These are the only elements under 
the Selector arrow. 

If you click here, the F4 key selects element B, then C, 
0, and E. All five elements are under the Selector. 

If you click here, the F4 key selects element Band 
then skips to element E. Elements C and 0 are not se­
lected because they are not under the Selector arrow. 
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Selector Tool 

Selection Techniques 

click 

Ctrl-click 

selector box 

Shift-click 

F4 

Shift-F4 

Ctrl-Shift-click 

Shift-drag 

Alt-click 

Toolbox 

The following table describes all the ways you can select 
elements. 

techniques for selecting elements 

Selects the element whose selection frame is under the tip of the 
pointer. If more than one element, selects the topmost. 

Selects the element on the bottom of the stack under the tip of the 
pointer. 

Selects all elements whose selection frames fall entirely within the 
selector box. 

Selects additional non-overlapping elements individually. 

Selects the next element under the point at which you clicked. If 
starting from the top of the stack, F4 selects downward; if starting 
from the bottom, F4 selects upward. In either case, the previous ele-
ment is de-selected. 

Selects additional elements toward the bottom or top of the stack. 

Selects additional overlapping elements individually. 

Adds elements enclosed within selector box to current selection. 

Makes a selected tool function as a Selector. See page 2-12. 
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Selector Tool 

De-selecting Elements 

2-6 

You will often need to de-select elements, so that they are 
no longer selected. 

To de-select all elements: 

[II Click on the Selector tool. 

~ Click in an empty part of the workspace, including 
the area surrounding the drawing surface. As long as 
you are not clicking inside an element's selection 
frame, all elements are de-selected. 

If you have zoomed in on the drawing surface, you can de­
select elements without zooming out. Display the status 
line (see the description of the Status Line command on 
page 5-4) and then press the F4 key until the status line 
indicates that no elements are selected. 

To de-select individual elements: 

Shift-click on the elements you want to de-select. 
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Scaling Elements 

The Selector arrow 
changes to a hand with 
a pointing finger. 

Dragging the 
corner handle 

down and to 
the left... 

Dragging the 
midpoint 

handle down ... 

Toolbox 

You can scale a selected element with the Selector­
making it larger or smaller. 

To scale an element with the Selector: 
Drag a corner or midpoint handle on the element. 

o Dragging a corner handle scales in two dimensions. 

o Dragging a midpoint handle scales in one dimension 
only, either vertically or horizontally. 

1 

. .. changes both 
the length and 
height of the 
element. 

. .. changes the 
height of the 
element, but not 
its length. 

When more than one element is selected, the other ele­
ments are not scaled, but they remain selected. 

You can also scale elements with the Scale command in 
the Edit menu (page 7-9) and the Element Info com­
mand in the Element menu (page 6-13). 

To scale more than one element, use the Scale command, 
or group the elements (page 6-5) and then drag one of the 
handles on the selection frame enclosing the group. 

Status Line 

The status line (page 5-4) displays scaling percentages. 
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Selector Tool 

Moving Elements 

The Selector arrow 
changes to an open 
hand. 

Using the Selector, you can move selected elements to a 
different position in the workspace. 

To move elements with the Selector: 

[JJ Place the pointer inside the selection frame of one of 
the selected elements. 

[]] Drag the elements to their new position. 

You can move elements as selection frames or outlines. 
See the description of the Selector Options on page 2-11 . 

" •........ ......• 
. .................... . 

. ..... 1··· ................. .: \, 

........................................... \. 
··········, .. f 

\ ...... ~ _ ..... . •••• ••• H •••••••• •••• 

moving as selection frame moving as outline 
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You can also move elements with the Move command 
(page 7-6) and the Element Info command (page 6-13). 

Status Line 

The status line (page 5-4) displays the changes in the 
mouse's position as you drag the elements. 
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Copying Elements 

Using the Selector, you can copy selected elements. 

To copy elements with the Selector: 

[I] Press and hold down the Shift key. 

When the pointer 
changes to an open 
hand, you can release 
the Shift key. 

[]J Place the pointer inside the selection frame of one of 
the selected elements. Press and hold down the 
mouse button. 

[]] Drag the elements' selection frames or outlines to 
where you want the copies. 

[]] Release the mouse button. 

The original elements remain where they were, and 
the copies appear at the new position. 

The table below lists all the ways you can copy elements. 

techniques for copying elements 

command or tool result 

Duplicate command (Edit menu) Copies selected elements one grid increment below 
and to the right of originals. 

Clone command (Edit menu) Copies selected elements directly on top of originals. 

Copy command (Edit menu) Copies selected elements to paste buffer. 

Selector tool (Shift key held down) Copies selected elements to position at which mouse 
button is released. 

Rotator tool (Shift key held down) Makes rotated copies. 

Flipper tool (Shift key held down) Makes flipped copies. 

Move command Makes copies moved by distance specified in dialog. 
(Make Copy turned on) 

Scale command Makes copies scaled by percentage specified in dialog. 
(Make Copy turned on) 

Rotate command Makes copies rotated by angle specified in dialog. 
(Make Copy turned on) 

Toolbox 2-9 



Selector Tool 

Moving the Guide Lines 

The guide lines 
are described on 
page 5-8. 

2-10 

You can use guide lines: 

o to align elements on the drawing surface; 
o as a reference point for rotating and scaling elements. 

To move the guide lines with the Selector: 

Place the tip of the pointer on the guide line you want to 
move, and drag the guide line where you want it. The sta­
tus line (page 5-4) displays the guide line's position as you 
drag it. 

For the greatest accuracy in placing the guide lines, use 
the Set Guide Lines command (page 5-9). 
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Selector Options 
Your choices depend 
on personal preference 
and the task you are 
trying to accomplish. 

Double-clicking on the Selector tool displays the Selector 
Options dialog: 

Selector Options 
Move EleAents As 
~ Selection FraAes 
o Outlines 

Handle Size IIDI pixels 

I OK I I Cancel I 

Move Elements As 

This option determines how a moving element is drawn 
on the screen. See the illustration on page 2-8. 

Selection Frames 

The element's position is indicated by its selection frame. 

Outlines 

The element's position is indicated by its outline. 

Of the two options, Selection Frames is suited to moving 
complex elements or text elements. The Outlines option is 
preferable when accuracy of position is desired. 

Handle Size 

This option sets the size of the handles in an element's 
selection frame, ranging from two to eight pixels. 

[J ~ rJ =3 
2 pixels 8 pixels 
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2-12 

Using Other Tools as a Selector 
You can use any of the tools listed below as a Selector by 
holding down the Alt key. For example, Alt-click with 
the Magnifier selects an element; Alt-drag with the Rota­
tor selects or moves an element or changes its size (de­
pending on where you place the pointer). 

The Alt key turns the following tools into a Selector: 

o Magnifier 
o Sketch tool 
o Trace tool (only after an image is loaded) 
o Text tool 
o Rectangle tool 
o Circle tool 
o Rounded Rectangle tool 
o Line tool 
o Rotator 
o Thumbtack 
o Flipper 
o Rolling Pir .. 

NOTE: One Selector technique is not available for these tools­
Ctrl-click to select the element at the bottom of the stack. 
The Alt and Ctrl keys convert any of the tools listed above 
to a Magnifier. See page 2-18. 
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Layer Tool 

Layer Tool 

The Layer tool displays a pop-up menu from which you 
can select an active layer or add a new layer to your 
picture. 

Layers are described fully in Chapter 10. 

Active Layer 

The name of the active 
layer appears in the 
window's title bar. 

In a picture that has more than one layer, you can only 
work in one layer at a time-the active layer. 

Toolbox 

To make a layer the active layer: 

OJ Click on the Layer tool. A pop-up menu of layer 
names is displayed. 

[]] In the pop-up menu, click on the name of the layer 
you want to make the active layer. 

You can also activate layers by pressing the PgUp or 
PgDnkeys. 

Adding Layers 

To add a new layer: 

[]] Click on the Layer tool. 

[]] In the pop-up menu, click on the New Layer option. 

The Add Layer dialog is displayed. 

[[] Type a name for the new layer and exit the dialog. 

The Add Layer dialog contains additional options for 
creating slides. These options are described on page 
10-8. 

NOTE: Merging a file into your current file always creates at least 
one new layer. See the description of the Merge File 
command on page 3-4. 
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View Tool 

View Tool 

~ 
~ 

The View tool displays a pop-up menu from which you can 
select a view of the drawing surface---one of three preset 
views or a "custom" view you have defined. 

To select a view: 

Click on the View tool to display the pop-up menu of avail­
able views and choose the name of the view you want. 

The New View option is for defining your own views. 
See "Custom Views" (page 2-16). 

Preset Views 

2-14 

Three preset views of the drawing surface are available: 

Full View 

The entire drawing surface appears in the workspace. 

Normal View 

Normal View shows about one quarter ofa standard 
letter size page in the workspace. See the illustration on 
the next page. 

Reduced View 

The drawing surface is centered in the workspace with 
space around it on all sides. You can drag elements par­
tially or entirely off the drawing surface and place them 
in this surrounding space. 

The illustrations on the next page show the three preset 
views and one possible use of the surround. 
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Toolbox 

View Tool 

Normal view 

Full view 

This illustration shows 
the workspace in 
Reduced view. The two 
rectangles show how 
much of the drawing 
surface is visible in Full 
view and Normal view. 

You can use the surround to drag the direction lines of 
large curves, as a temporary holding place for elements, 
or to create a perspective grid, as in the illustration below. 
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View Tool 

Custom Views 

Views created with the 
New View option are 
saved with the file. 

2-16 

With the View tool's New View option, you can define 
and save views of specific parts of each picture. 

To define a custom view: 

[JJ Use the Magnifier (described next) or the scrollers (or 
both) to bring a particular part of your drawing into 
the workspace. 

[]J Click on the View tool. 

[]] In the View tool pop-up, click on New View. 

[]] In the New View dialog, enter a name for this view 
and exit the dialog. 

The new view name now appears in the View tool pop-up. 
To return to this exact place on the drawing surface at 
any time, click on the View tool and choose this view's 
name. 

To remove a custom view: 

[JJ Go to that view by choosing it from the View tool 
menu. 

[]J Display the View tool menu again. Note that the last 
option in the menu has changed to Remove View 
and the view name has a marker next to it. 

[]] Choose Remove View from the View tool menu. 

Artline User Reference Guide 



Magnifier Tool 

Magnifier Tool 

starting 
point for a 
Shift key 

zoom 

Toolbox 

The Magnifier zooms in or out on a specific portion of the 
drawing surface. 

To zoom in on the drawing surface: 

OJ Click on the Magnifier. The pointer changes to a mag­
nifying glass. 

[]] Place the magnifying glass over the center of the area 
you want to zoom in on. Drag in any direction. 

As you drag, a frame appears, centered on the point 
where you started. 

To drag from the upper left corner of the frame, in­
stead of the center, press the Shift key before you 
begin dragging. 

[]] When the frame encloses the area you want, release 
the button. 

To zoom out one level: 

Click anywhere on the drawing surface. 

To display the entire drawing surface: 

starting 
point for a 
standard 
zoom 

Double-click with the Magnifier anywhere on the drawing 
surface. This is the same as choosing the Full View op­
tion of the View tool. 
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Magnifier Tool 
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Other Ways to Change Views 

You can also zoom in or out or change the view in the fol­
lowing ways: 

o You can press the plus key (+) on the numeric keypad 
to zoom in one level toward the center of the drawing 
surface and the minus (-) key to zoom out one level. 

o You can use any of the other selectable tools (like the 
Quill, Rectangle tool, or Flipper) as a temporary Magni­
fier tool. To do so, select the tool, hold down the Ctrl 
and Alt keys, and drag. 

The other Magnifier techniques-Shift to drag from 
the upper left corner of the frame, click to zoom out one 
level, and double-click to display the entire drawing 
surface-are also available. 

o You can use the the View tool options-Full View, N or­
mal View, and Reduced View-as well as any custom 
views (see page 2-14). 

A Note to Logitech Bus Mouse Users 

If you have a Logitech® Bus Mouse (which uses its own 
"bus board" and requires the file MOUSE.COM) and if 
you are using the CLICKTM utility, the Ctrl-Alt-drag tech­
nique described above will change the pointer's speed (as 
indicated by a beep), causing it to move more slowly than 
before. To restore the pointer's normal speed, press Ctrl­
Alt and the mouse's middle button. 

This feature is described in the chapter "CLICK Mouse 
Control" in Getting the Most from Your Mouse in the cur­
rent Logitech documentation set. 
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Drawing Tools 

Drawing Tools 

Artline has several tools for drawing circles, squares, 
curves, lines, and other shapes. These tools are described 
in the next several sections. 

Default Color and Line Attributes 

Defaults are preset choices or values that are used auto­
matically. For example, if you set the default fill color for 
elements to a solid blue, each new element you draw auto­
matically has a solid blue fill. (You can always change the 
fill color of individual elements after you draw them.) 

You can set these defaults in the toolbox: 

o fill color or fountain 
o line color 
o line width and other attributes 

To set defaults: 
You cannot set 
defaults while 
any elements are 
selected. 

ITl De-select all elements by clicking on an empty part of 
the drawing surface or by pressing the F4 key. 

De-selecting elements is described on page 2-6. 

Toolbox 

[]] Click on the appropriate tool to set defaults: 

- interior fill: Fill Color tool (page 2-42) or Fountain 
tool (page 2-42). See the note below. 

- line color: Line Color tool (page 2-42) 
- line attributes: Line Width tool (page 2-47) 

Any color or line attribute chosen while no elements 
are selected becomes a default. 

Defaults remain in effect until you set new defaults or 
until you quit Artline. 

NOTE: You can have a default solid fill color or a default fountain, 
but not both. The last one you choose becomes the default. 
For example, if you choose a solid fill color and then a 
fountain, the fountain is the default. 

2-19 



Drawing Tools 

Anchor Points 

Elements are defined by any of three types of anchor 
points: 

D Tangent points lead from one curve to another. Each 
tangent point has a tangent line passing through it 
and a direction point at either end of the tangent line. 

D Junction points lead from a curve to a straight line or 
from a straight line to a curve. Ajunction point has 
half a tangent line and a single direction point on the 
side of the curve. 

D Corner points lead from one straight line to another. 
They have no tangent lines or direction points. 

~/\~~\ ~l + + + • 

tangent point junction point corner point 

Maximum Number of Points 
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Because some output devices cannot reproduce large or 
complex elements, Artline has a limit of255 points per 
element, including anchor points and direction points 
(page 2-23). With practice, you should be able to draw 
complex figures without exceeding this limit. 
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exploded view 
of the first and 
last points of 
the circle 

Why a circle has 
thirteen points. 

Drawing Tools 

How to Count Points 

The total number of points in an element is the sum of its 
anchor points and its direction points. 

To add up the points in an element, follow these rules: 

o Each tangent point, except for the first or last point on 
the element, accounts for three points-the tangent 
point itself, plus two direction points. The first or last 
tangent point on an element accounts for two points­
the tangent point and one direction point. 

o Ajunction point accounts for two points-the junction 
point itself and one direction point. 

o A corner point accounts for a single point. 

o The first and last points of closed elements like circles 
and squares are separate points, even though they oc­
cupy the same position on the drawing surface. A cir­
cle, for example, has thirteen points (see left). 

To find out how many points there are on a single ele­
ment, select it and then choose the Element Info com­
mand from the Element menu. 

Automatic Closure of Non-Hollow Elements 

Toolbox 

Artline automatically closes elements that contain a fill 
color or fountain, connecting the first and last points with 
a straight line that uses the current line color and width. 

If the element is hollow (no fill color or fountain), the first 
and last points are not automatically connected. 
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Quill Tool 

Quill Tool 

2-22 

The Quill tool draws curves, polygons, and elements made 
of combinations of lines and curves. 

Pointer Form 

The Quill tool pointer can take two forms on the drawing 
surface: 

crosshair ---. ffi The Quill is active but you have not begun to draw. 

cross ---. + The Quill is active and you are in the process of 
drawing. When you complete your drawing, the 
pointer changes back to a crosshair to indicate that 
you can draw something else. 

Default Fill Color and Line Attributes 

Elements drawn with the Quill tool take the current de­
fault for fill color, line color, and line width. 

See page 2-19 for a description of how these default val­
ues are set. 

Outline on Hollow Elements 

The outline on elements with Hollow fill is not necessarily 
"closed." Refer to the section "Automatic Closure of N on­
Hollow Elements" (page 2-21). 

Elements Drawn with the Quill 

You can draw three types of elements with the Quill: 

o curves 
o polygons 
o combinations of curves and lines 
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Quill Tool 

Drawing Curves 

You can draw two basic kinds of curves with the Quill tool: 

o a simple curve-like the letter U 
o a compound curve-like the letter S 

A curve is defined by two tangent points, each with a tan­
gent line and two direction points (see the illustration on 
the next page). Tangent points mark the beginning and 
end of the curve, and the tangent lines and direction 
points determine its direction and shape. 

direction point 

second tangent point 

tangent line 

+ direction point 

first tangent point ----. 0 Components of a curve. 

Toolbox 

The length of the tangent line determines how "tall" the 
curve will be. With practice, you should soon be able to 
gauge the curves accurately. (Ifit is not quite right, you 
can adjust it later with the Plane tool.) 
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Quill Tool 

2-24 

To draw a curve: 

/ 

IT] Position the Quill tool crosshair where you want to 
start the curve. 

[ill Press and hold down the mouse button to set the first 
tangent point. Do not release the button. 

[]] Drag the first tangent line with the mouse. Release 
the button when you finish the tangent line. 

[] Move to the second tangent point. Again, press and 
hold down the mouse button. 

[§] Drag the second tangent line with the mouse. The 
curve connects the two tangent points. 

/ / 
\ 

To draw a simple curve, drag 
the second tangent line in the 
opposite direction from the first. 

To draw a compound curve, 
drag the second tangent line in 
the same direction as the first. 

[]] To continue drawing and add another curve, move 
the pointer to another tangent point, press the mouse 
button, and drag a new tangent line. 

Closing Elements 

You must close the current element before you can draw 
additional elements. 

To close an element: 

Double-click anywhere in the workspace. The element is 
closed and is automatically selected. The Quill is still ac­
tive, and you can continue drawing. 
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Quill Tool 

Drawing Polygons 
To draw a single line A polygon is a shape made up of connected straight lines. 
segment, use the 
Line tool. To draw a polygon: 

Toolbox 

OJ Select the Quill tool and click to set the first point. 

[]] Click to set each additional point of the polygon. 
Each new point is connected to the previous one by a 
straight line. 

[]J Close the element by double-clicking. 

Drawing Elements that Combine Curves and Lines 

Elements drawn with the Quill can combine curves and 
straight lines. 

To add a straight line to a curve, 
click with the Quill pointer to set 
the end point of the line. 

To add a curve to a straight line, hold down 
the Alt key and drag from the end point of 
the line. A tangent line appears, and you 
can draw the curve. You can release the AU 
key when the tangent line appears. 
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Quill Tool 

Additional Techniques 

This section describes the following Quill tool techniques: 

o breaking tangents 
o correcting errors 
Ore-opening a curve or polygon 

Breaking Tangents 

When drawing connected curves, you can "break" the tan­
gent so that the first curve approaches the tangent point 
along one tangent line and the second curve leaves the 
point along a different tangent line. 

To break a tangent and draw a new curve: 

Press the Alt key and then press the mouse button. The 
tangent line is now broken at the anchor point, and you 
can drag the first tangent line of the new curve. 

rl /\ ... ~ / \. \ 

\ 
c 

T 

broken tangent 
.,... 

1. Draw the first curve. 2. Break the tangent by Alt­
dragging the direction point. 

3. Draw the second curve. 

2-26 

NOTE: The angle between the two curves does not have to be 
dramatic. You can use this technique to make subtle adjust­
ments in the direction of connected curves. 
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Toolbox 

Quill Tool 

Correcting Errors 

If you are not satisfied with where you set an anchor 
point, you can easily delete it. 

To delete a point: 

Press the Backspace key. Artline deletes the point and 
the line or curve connecting it to the previous point. You 
can then set a new anchor point and continue drawing. 

Each time you press the Backspace key, Artline deletes 
another anchor point until it reaches the first point. 

You cannot delete the first point of an element with the 
Backspace key. To delete the first point of any element, 
double-click. 

Re-Opening a Curve or Polygon 

After you have closed a curve or polygon, you can re-open 
it and continue drawing with the Quill tool. 

To re-open a curve or polygon: 

[] Choose the Selector tool. 

[]] Click on the element you want to re-open. The ele-
ment is now selected. 

[]J Choose the Quill tool. 

[!] Double-click anywhere on the element. 

Artline re-opens the element. You can continue drawing 
from the last point of the element. You can also edit 
curves, polygons, and other elements with the Plane tool 
(page 2-53). 
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Sketch Tool 

Sketch Tool 

The Sketch tool 
pointer is a cross hair. 
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The Sketch tool draws "freehand" shapes. You can use 
the mouse much as you would a pencil or pen. 

To draw with the Sketch tool: 

OJ Select the Sketch tool. 

[]] Press the mouse button and move the mouse. The 
crosshair follows the movement of the mouse, draw­
ing on the screen the same design you make with the 
mouse. 

~ Release the mouse button when you have finished 
drawing. Your design will disappear for a moment 
while Artline calculates and draws the curves you 
have sketched. 

Default Fill Color and Line Attributes 

Elements drawn with the Sketch tool take the current de­
fault for fill color, line color, and line width. 

See page 2-19 for a description of how these default val­
ues are set. 

Outline on Hollow Elements 

The outline on elements with Hollow fill is not necessarily 
"closed." Refer to the section "Automatic Closure of Non­
Hollow Elements" (page 2-21). 

Grid Snap 

To enable you to draw truly freehand elements, points 
drawn with the Sketch tool never snap to the grid, regard­
less of the state of the Snap to Grid command. 
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Trace Tool 

Toolbox 

Trace Tool 

The Trace tool automatically draws lines and curves that 
follow the contours of scanned images, images created 
with paint programs, or other images converted to the 
IMG, PCX, or TIFF formats. 

When you double-click on the Trace tool, Artline displays 
the Trace Options dialog. Autotracing and the Trace Op­
tions dialog are described in detail in Chapter 11. 

Outline on Hollow Elements 

The outline on elements with Hollow fill is not necessarily 
"closed." Refer to the section "Automatic Closure of Non­
Hollow Elements" (page 2-21). 
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Text Tool 

Text Tool 

The Text tool adds text to your pictures-using many 
typefaces and an almost limitless variety of point sizes. 

The Text tool pointer is 
an "I-beam" text cursor. 

To add text to your picture: 

[]J Select the Text tool. 
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[]] Click the I-beam in the workspace. The text will ap­
pear where you clicked. 

You do not have to click exactly where you want the 
text to be. It is often easier to enter text into an 
empty part of the workspace, work on it there, and 
then move it to its final position. 

[]] Artline displays the Create Text Element dialog. 
Enter your text in the dialog, set the text attributes, 
and exit the dialog. 

Pressing .J inserts a carriage return in your text. To 
exit the Create Text Element dialog and add the text 
to the workspace, you must click on the OK button. 

Create Text EleAent 

Font I Advantage Bold I~I 

Size I 24 I~I pts on 124 I~I 

Align I Left I~I o Auto Kerning 

This is the Artline@ text window., t 
-

"i" 

~@mm~~@ I OK I I Cancel I 

NOTE: Line Width tool options, including width and caps, can be 
applied to text. See page 2-47. In addition, see the descrip­
tions of the Text Along a Path command (page 8-14) and 
the Convert to Curves command (page 8-18). 
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Text Tool 

Create Text Element Dialog 

To scroll more rapidly, 
move the pointer out of 
the font list, just above 
or below "more." 

Toolbox 

The Create Text Element dialog contains a window into 
which you enter your text; pop-up menus for choosing the 
typeface, point size, line spacing, and alignment; and a 
kerning check box. The word "Sample" appears in the 
lower left corner of the dialog to illustrate the currently 
selected typeface. 

Font Pop-up 

The Font pop-up lists the available fonts (typefaces) for 
your text. To select a font, click on its name in the list. 

Advantage Bold 
Advantage Bold 
Advantage Bold Italic 
Advantage Nornal 
Advantage Italic 
Booker Deni 
Booker Deni Italic 
Booker light Italic 
Booker light 
Courier 
Courier Bold 
Courier Bold Italic 
• nore ... Put the pointer here 

to scroll the list. 

You can scroll the list if the name you want is not visible. 
o To scroll down the list, touch the pointer to the word 

"more" when it appears at the bottom of the menu. 

o To scroll up the list, touch the pointer to the word 
"more" when it appears at the top of the menu. 

To stop scrolling in either direction, move the pointer 
into the list of font names. 

Adding Fonts to the List 

You can convert fonts to the Artline format and add them 
to the list. 

Converting fonts is described in the Artline Utilities 
Guide. 

To add fonts to the list, use the Font Manager (page 9-7.) 
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Text Tool 

24 , .. 
12 
14 
18 
24 
36 
48 
72 

(UstOIll 
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Point Size 

The Size pop-up offers seven preset point sizes and a 
Custom option. 

Custom Point Sizes 

The Custom option displays the Custom Size dialog over 
the Create Text Element dialog. Type a number directly 
into the "New Size" field or use the pop-up slider to enter 
a value. You can specify any point size (whole numbers 
only) from two points to 500 points. 

CustOIll Size 

New Size rn pts 

[]i[] , Cancel I 

Line Spacing 

The line spacing setting in the Create Text Element dia­
log controls the distance between lines of text separated 
by a carriage return in the text entry window. 

Type is commonly specified as one point size on another­
for example, "10 on 12." The first number is the point 
size of the text characters; the second number is the line 
spacing. Thus, "10 on 12" is 10-point type with 12 points 
between baselines-the invisible horizontal line on which 
the characters sit. (In traditional typography, 10 on 12 is 
also known as 10-point type with two points of lead, recall­
ing the days when lines of type were separated by quanti­
ties of lead.) 

Line spacing is set in the pop-up menu that follows the 
Size pop-up. The number in the pop-up bar depends on 
the selection you make from the menu's three options, 
Solid, Auto, and Custom. 
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Text Tool 

Solid 

The line spacing is the same as the point size of the text-­
for example, 12 on 12. The text has "zero points of lead." 

When text is set to Solid, there is typically little or no 
space between the lowest point (descender) of a letter on 
one line and the highest point (ascender) of a letter on the 
line below. 

Auto 

The line spacing is automatically set by Artline based on 
the point size of the text. See the table below. 

point size line spacing specification 

2-7 (custom) 1 point more than type size 5 on 6, e.g. 

8-11 (custom) 2 points more than type size 9 on 11, e.g. 

12 14 12 on 14 

14 17 14 on 17 

18 22 18 on 22 

24 29 24 on 29 

36 43 36on43 

48 58 48 on 58 

72 86 72 on 86 

above 72 (custom) 20% more than type size 80 on 96, e.g. 

Toolbox 

Custom 

The Custom option displays the Custom Line Space dia­
log. Type a number directly into the New Line Space field 
or use the pop-up slider to set a value. You can specify a 
baseline distance smaller than the text point size so that 
the lines of text actually overlap. 
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Text Tool 

Alignment 

The Align pop-up gives three choices for aligning your 
text on the drawing surface. 

Quo usque tandem abutere, 
Catalina, 

Quo usque tandem abutere, 
Catalina, 

Quo usque tandem abutere, 
Catalina, 

patientia nostra? patientia nostra? 

Left alignment 
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patientia nostra? 

Center alignment Right alignment 

Auto Kerning 

Kerning is a reduction in the space between specific pairs 
of letters, intended to produce a more visually pleasing 
letter spacing. 

In the example below, the A in the unkerned version of 
WAVE appears separated from its surrounding letters. 
Kerning reduces the space on both sides of the A so that 
the spacing between all the letters in the word appears 
uniform. 

WAVE WAVE 
1 1 1 1 
unkerned kerned 

Text Entry Window 

Type your text directly into the text entry window. To 
start a new line, press....1. 

The window can display four lines of text at a time. To 
bring a line that is not visible into the window, use the 
scrollers at the right side of the window. 
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Home 

End 

PgUp 

PgDn 

Text Tool 

Cursor Keys 

Use these keys on the numeric keypad to move the cursor 
in the text entry window: 

key cursor movement 

to beginning of line 

to end of line 

up four lines 

down four lines 

left-arrow/right-arrow left/right one character 

up-arrow/ down-arrow up/down one line 

Backspace deletes character to left of cursor 

Delete deletes character to right of cursor 

Re-opening Text for Editing 

To re-open a text element for editing, use the Selector to 
select it and then double-click on it. The Create Text Ele­
ment dialog appears, with the text in the text window. 

You can re-open text for editing as long as it has not been 
converted to curves. 

Symbol and Wombat Characters 

See Appendix A for a 
list of Artline's font 
names and their Post­
Script equivalents. 

Characters in the Symbol and Wombat fonts cannot be 
displayed in the text window. You will see the standard 
character for that ASCII decimal value, but the correct 
Symbol or Wombat character will appear on the drawing 
surface and in your picture. 
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Rectangle Tool 

Rectangle Tool 
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The Rectangle tool draws rectangles, rounded rectangles, 
and squares. 

Default Fill Color and Line Attributes 

Elements drawn with the Rectangle tool take the current 
default for fill color, line color, and line width. 

See page 2-19 for a description of how these default 
values are set. 

Drawing with the Rectangle Tool 

The steps for drawing rectangles and squares are almost 
identical. 

To draw a rectangle: 

ITJ Select th 9 Rectangle tool. The pointer becomes a 
crosshair when it is in the workspace. 

[]J Position the crosshair at one of the corners of the 
rectangle. 

[]] Drag the mouse diagonally to the opposite corner of 
the rectangle. 

As you drag, an outline of the rectangle follows the 
crosshair. 

[] To finish the rectangle, release the mouse button. 

To draw a rounded rectangle: 

Set a Corner Radius in the Rectangle Options dialog 
(page 2- 38) and then follow the steps for drawing a 
rectangle. 
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Rectangle Tool 

To draw a true square: 

Follow the steps for drawing a rectangle, but hold down 
the Ctrl key as you drag. 

To draw a square with rounded comers, first set a Corner 
Radius in the Rectangle Options dialog. 

NOTE: The aspect ratio of the pixels on some display monitors can 
affect how squares appear on the screen. On an EGA screen, 
for example, a square can appear as a vertical rectangle. 
This effect is less pronounced on a VGATM screen. The dis­
tortion will not appear in your printed output. 

To draw around a center point: 

To draw a rectangle from the center, hold down the Shift 
key as you drag. To draw a square from the center, hold 
down both the Ctrl key and the Shift key. 

1 

Both rectangles were 
drawn from the same 
starting point. The rec­
tangle on the right was 
drawn from the center. 

starting pOintl-

I I 

[-[~[:: -I I 

l 

I 
l.. ....... . I . ................................... + ..................... + 
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Rounded Rectangle Tool 

Rectangle Options 

When you double-click on the Rectangle tool, Artline dis­
plays the Rectangle Options dialog. 

Rectangle Options 

Corner Radius 11111is11 inch 

o Draw Squared 

OK I I Cancel I 

Corner Radius 

This option sets the radius of the curves at the corners of 
a rounded rectangle. The default value of zero draws a 
rectangle with right-angle corners. 

After you set a corner radius value to draw a rounded rec­
tangle, you must reset the value to zero to draw a normal 
rectangle. 

Draw Squared 

This option makes the Rectangle tool draw only squares. 

Rounded Rectangle Tool 
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The Rounded Rectangle tool is simply a Rectangle tool 
with a pre-set corner radius. You can change this corner 
radius to your own preference by double-clicking on the 
Rounded Rectangle tool to display the Rectangle Options 
dialog. 

In all other respects the Rounded Rectangle tool is identi­
cal to the Rectangle tool. 
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Circle Tool 

Circle Tool 

The Circle tool draws circles and ellipses. 

Default Fill Color and Line Attributes 

Elements drawn with the Circle tool take the current 
default for fill color, line color, and line width. 

See page 2-19 for a description of how these default 
values are set. 

Drawing with the Circle Tool 

Toolbox 

The steps for drawing circles and ellipses are almost 
identical. 

To draw an ellipse: 

[]] Select the Circle tool. The pointer becomes a cross­
hair when it is in the workspace. 

[]] Imagine a rectangle enclosing the ellipse you want to 
draw. Position the crosshair at one of the corners of 
this imaginary rectangle. 

[]] Press the mouse button and drag to the diagonally 
opposite corner of the rectangle. 

As you drag, an outline of the ellipse follows the 
crosshair. 

[}] To finish the ellipse, release the mouse button. 
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Circle Tool 

To draw a true circle: 

Follow the steps for drawing an ellipse, but hold down the 
Ctrl key as you drag. 

NOTE: The aspect ratio of the pixels on some display monitors can 
affect how circles appear on the screen. On an EGA screen, 
for example, a circle can appear as a tall ellipse. This effect 
is less pronounced on a VGA screen. The distortion will not 
appear in your printed output. 

To draw around a center point: 

To draw an ellipse from the center, hold down the Shift 
key as you drag. To draw a circle from the center, hold 
down both the Ctrl key and the Shift key. 

Both ellipses were drawn 
from the same starting 
point. The ellipse on the 
right was drawn from the 
center. 

starting point 

(. 
........... . ................. ,. 
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Line Tool 

Line Tool 

The Line tool draws straight line segments. 

Lines drawn with the Line tool take the current default 
values for line color and line width (see page 2-19). 

To draw a line: 

[]] Select the Line tool. The pointer becomes a cross 
when it is in the workspace. 

\]] Place the cross where you want the line to begin. 

QJ Drag to draw the line. 

To draw connected line segments, use the Quill tool (page 
2-22) or join individual line segments with the Plane tool 
(page 2-59). 

To draw vertical, horizontal, and 45° lines: 

Press the Ctrl key as you drag. The line snaps to the 
nearest 45° interval. 

Line Options 

Toolbox 

When you double-click on the Line tool, Artline displays 
the Line Options dialog. 

Line OJ!tions 

Snap Angle I~I 0 

OK I I Cancel I 

The Snap Angle set in this dialog restricts the Line tool to 
multiples of this angle. For example, if you set the snap 
angle to 15 degrees, you can draw lines only at 15°, 30°, 
45 Q

, 60°, and so on. 
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Fill Color Tool 

Fill Color Tool 

II 
A fill color (in contrast to a fountain) is a solid color or a 
shade of gray. Using the Fill Color tool, you can: 

o assign fill colors to selected elements (see page 2-43); 
o create new fill colors (see page 2-44); 
o choose default fill colors (see page 2-19); 
o set color tool options (see page 2-44). 

Fountain Tool 

•••••••••••• ~ 

Afountain (in contrast to a fill color) is a gradual blend­
ing of one color into another. Using the Fountain tool, 
you can: 

o assign fountains to selected elements (see page 2-43); 
o create new fountains (see page 2-44); 
o choose default fountains (see page 2-19); 
o set color tool options (see page 2-44). 

Line Color Tool 

[] 
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In Artline's initial default, elements are drawn with a 
thin black outline. Using the Line Color tool, you can: 

o assign colors to the outlines around selected elements 
(see page 2-43); 

o create new line colors (see page 2-44); 
o choose a new default line color (see page 2-19); 
o set color tool options (see page 2-44). 
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Using the Color Tools 

Assigning Colors or Fountains 

To assign a color or fountain: 

[]] Select the elements to which you want to assign the 
color or fountain. 

The colors that are 
available depend on 
the currently loaded 
color file (page 12-3). 

[]] Click on the appropriate tool-Fill Color, Fountain, or 
Line Color-to display the color selector. 

The type of selector-List or Palette-is determined 
by your selection in the Color Tool Options dialog 
(page 2-44). 

Toolbox 

~ Click on the color you want. 

NOTE: If you click on the Fountain tool when the current color file 
contains no fountains, the Add Fountain dialog is automat­
ically displayed. Color files and the Add Fill dialog are 
described in Chapter 12. 

Hollow Elements 

The Hollow fill option produces an outline of the element, 
using only the current line color and width values. 

NOTE: The outline on elements with a Hollow fill is not necessarily 
"closed." See "Automatic Closure of Non-Hollow Elements" 
(page 2-21). 
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Using the Color Tools 
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Creating New Colors or Fountains 

The color selectors include an option for creating a new 
color or fountain. 

To create a new color or fountain: 

OJ Display the appropriate color list or palette-Fill 
Color, Fountain, or Line Color. 

[]] Click on the Add Color option or, for fountains, the 
Add Fill option. 

In the color palette, the option appears at the bottom 
of the palette window. See the illustration on the 
next page. 

In the color list, the option is the last item in the list. 

Artline displays the Add Color or Add Fill dialog. 

[ill Fill out the Add Color or Add Fill dialog. 

The Add Color and Add Fill dialogs are described fully in 
Chapter 12. 

Setting Color Tool Options 

Double-clicking on the Fill Color tool, Fountain tool, or 
Line Color tool displays the Color Tool Options dialog. 
The options you choose apply only to the tool on which 
you double-clicked. 

Color Tool Options 

Displa!,! As 0 List 

Color T!,!pe ~ Solid 

~ Palette 

o Fountain 

Assign To ~ Interior 0 Outline 

OK I I Cancel I 
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Toolbox 

Using the C%r Too/s 

Display As 

c:::::J 
1%%%81 
EH -EH 

This option determines how the selected tool displays 
colors. See the illustration below. 

List 

The list format is most suited to comparatively small 
color files. 

To scroll the list of colors, touch the pointer to the word 
"more" that appears at the bottom or top of the list. To 
scroll more rapidly, move the pointer out of the list, just 
above or below "more." 

To stop scrolling, move the pointer into the list. 

Palette 

The palette format is suited to large color files like the 
PANTONE files. 

To scroll the Palette, drag the slider or click on the ar­
rows. Note that a color's name appears in the Palette's 
title bar only when the pointer is on the color itself. 

Hollow ClJ_an 
White CJ~_"_" .. -Light gralJ 
Dark gralJ 
Black 

CTIJ"_"~" 
••••••• IUCKXXK 
••••••• XXI( )C .... _-

Red 
_11r:11II:_III" 
!;;;;;;;I Yellow '\ 

EH Dark lJellow 
mm Green - Dark green 

Add Color ... 1 Hollow 
,.. (!lore ... 

list palette 

The order in which the colors are displayed is set by the 
Sort commands in the Color Manager (Chapter 12). 

,.. 
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Using the Color Tools 
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Color Type 

Solid 

The selected tool assigns solid colors. This option is valid 
for any kind of color tool. 

Fountain 

The selected tool assigns fountains. This option is valid 
only for tools for which the Assign To option (next) is set 
to Interior. 

Assign To 

Interior 

The selected tool's color type-Solid or Fountain-is as­
signed to the element's interior. 

Outline 

The selected tool's color type-Solid only- is assigned to 
the element's outline. 

When to Set Color Tool Options 

You can change a color tool's display format at any time, 
according to your preference or needs. Do not, however, 
change the Assign To or Color Type settings for the stan­
dard color tools. 

If you create a custom color tool with the Tools Manager 
(Chapter 13), you can set all available color tool options. 
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Line Width Tool 

Line Width Tool 

The Line Width tool sets the width and attributes of the 
outline around selected elements (including text) and of 
lines drawn with the Line tool. 

You can also use the Line Width tool to set a default line 
width and attributes. Setting defaults is described on 
page 2-19. 

Setting Line Width 

No Outline 
a.aa3 inch 
a.BB9 inch 
B.B19 inch 
B.B39 inch 
B.B7B inch 
B.11B inch 
B.157 inch 
B.196 inch 
Attributes ... 

Toolbox 

To set the line width: 

[] Select the elements whose line width you want to set. 

[]J Click on the Line Width tool to display the line width 
menu. 

The line widths in this menu use the unit of measure 
currently set in the Page Layout dialog (page 3-10). 

[]] Click on a line width in the menu. 

The No Outline option results in an element with no 
outline. (No Outline has no effect when applied to 
hollow elements or single line segments.) 

[] To set a line width not listed in the menu, click on the 
Attributes option. Artline displays a dialog (see the 
next page) that includes a custom line width option. 

Note the following, imposed by limitations in the resolu­
tion of screens and printers: 

o Most screens cannot display all line widths, especially 
at Full or Reduced views. As the line width increases, 
the displayed line width increases in distinct steps. 

o For phototypesetter output, a minim:um line width of 
0.019 inches is recommended. Artline's default line 
width (0.003 inches) prints as an extremely fine line on 
a phototypesetter, but appears as a heavier line on a 
laser printer. 
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Line Width Tool 

Setting Line Attributes 
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In the line attributes dialog you can set: 

o a custom line width; 
o line end styles; 
o the style of the angle where two lines meet; 
o the line's "pattern"-solid or several dotted line styles. 

To set line attributes: 

OJ Select the elements whose line attributes you want to 
set. 

[Il Click on the Line Width tool. 

[I] Click on the Attributes option. Artline displays the 
Line Attributes dialog. 

Line Attributes 

Width I~I inch 
Caps 0 (. .) 0 Joins o. 

@ '-----' @ o. 
0 I· ·10 @. 
o <~ ~> 0 

Pattern 1·1 I OK I Cancel I 

Width 

To set a custom line width, type a value directly into the 
field or use the pop-up slider. 

Caps 

These buttons set the style of the beginning and end 
points of the line or outline. The left column sets the style 
for the beginning of the line, the right column for the end 
of the line. 

Artline User Reference Guide 



Line Width Tool 

The rounded end caps and long squared end caps extend 
past the end points of the line you draw. The extra length 
is roughly half the current width of the line. For exam­
ple, if you draw a .2-inch wide line that is four inches long 
and has a single rounded end cap, the line is actually 4.1 
inches long, to allow for the rounded end cap. 

a ( .. ) 0_---. 
@ L::J @ 
a I· .10 

a ( .. j a 
o L::J 0 

0<; :>0 ~ 
~@I. ·I@ 

~ 0<; :>0 
@( •• )@~ a ( .. ) a 

o L::J 0 o L::J 0 
o I· .10 
o <; :> 0 

Toolbox 

a I· ·10 
-@<; :>@ 

Joins 

These buttons set the style of the angle between two lines 
at a corner point. 

Pattern 

This pop-up menu contains a selection of dotted, dashed, 
and dot-dash line styles. 

,NOTE: Patterned lines greater than one pixel in width will appear 
as solid lines on the screen and in output to non-PostScript 
printers, but they will print correctly on PostScript printers 
and phototypesetters. 
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Rotator Tool 

Rotator Tool 

The Rotator tool rotates selected elements around a speci­
fied point and also makes rotated copies. You can also set 
Rotator tool options before you rotate elements. 

To rotate elements: 

[] Select the elements you want to rotate. 

[]] Set rotator options (described below). If you do not 
set rotator options, Artline will use the defaults or 
your current settings. 

[]] If you chose the Thumbtack or the guide lines as your 
rotation center, set them in place now. 

[±] Click on the Rotator tool. 

The Rotator's pointer is. []] Rotate the selected elements by dragging with the 
an arrowhead. mouse. The pointer does not have to be on top of the 

elements being rotated. 
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As you move the mouse, a line radiating out from the 
center of rotation follows the pointer. 

If you have set a rotation angle, the elements snap to 
a new position each time they move through one rota­
tion of that angle. 

[]] When you finish rotating, release the mouse button. 

To make rotated copies: 

Press and hold down the Shift key and then drag with 
the Rotator tool. 

Here are two additional rotation techniques: 

o You can rotate elements using the Rotate command in 
the Edit menu (page 7-7). 

o You can create special Rotator tools for specific angles 
of rotation that you use frequently. Creating custom 
tools is described in Chapter 13. 
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Toolbox 

Rotator Tool 

Fountained Elements 

If a rotated element contains a fountain, the fountain 
does not rotate with the element. To create a rotated foun­
tain, use the Color Manager (Chapter 12). 

Rotator Options 

The Rotator Options dialog sets parameters that will be 
in effect when you use the Rotator tool. To display the Ro­
tator Options dialog, double-click on the Rotator tool. 

Rotator OPtions 
Rotate Around Rotate Elel1lents As -

@D Selection Center () Selection Fral1les 
() Thul1lbtack () Outlines 
() Guide Lines 

Rotation Angle I_111° I OK II Cancel I 

Rotate Around 

Selecti()n Center 

A single element is rotated around the center of its selec­
tion frame. 

Grouped elements are rotated around the center point of 
the selection frame enclosing the group. 

Multiple selected (but ungrouped) elements are treated as 
if they were a group, and are rotated around the center 
point of an imaginary selection frame enclosing them. 

Thumbtack 

Elements are rotated around the point set with the 
Thumbtack (see page 2-63). 

If the Thumbtack has not been set, an alert is displayed. 
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Rotator Tool 

Your choice is deter­
mined by personal 
preference and the 
task you are trying to 
accomplish. 
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Guide Lines 

Elements are rotated around the point of intersection of 
the guide lines. The guide lines are described on page 5-8. 

If the guide lines have not been set, an alert is displayed. 

Rotate Elements As 

Selection Frames 

The elements' selection frames are rotated. 

Outlines 

Outlines of the elements themselves are rotated. 

Of the two options, Selection Frames is suited to rotating 
complex elements or text elements. The Outlines option is 
preferable when accuracy of position is desired . 

.......•..•............. 

selection frames outlines 

Rotation Angle 

This option determines the angle through which the se­
lected elements can be rotated. Type a value directly into 
the field or drag the pop-up slider. 

Elements can be rotated only through multiples of the set 
value. For example, if you set a value of 25°, the elements 
will be drawn only at rotations of 25°, 50°, 75°, and so on. 

When the value is set to 0°, you can rotate elements freely. 

Artline User Reference Guide 



Plane Tool 

To turn fill and line 
attributes back on, 
choose the Colors 
command or 
press F10. 

Plane Tool 

Using the Plane tool, you can change the shape of 
elements by: 

o moving anchor points or direction points; 
o adding or deleting points; 
o converting a curve to a line or a line to a curve; 
o joining or splitting points; 
o making curves symmetric or smooth (words that have 

special meaning in connection with the Plane). 

Remember the following about the Plane tool: 

o When you select the Plane, the fill and line attributes 
of all elements are automatically turned off, to give you 
a clear view of curves, lines, and points and to increase 
the speed with which elements are drawn. 

o You cannot use the Plane on grouped elements (includ­
ing text characters that have been converted to curves) 
or on blended elements. 

Selecting Points 

The first point of an 
element is larger than 
the other points. 

Toolbox 

Before you can modify a curve or line, you must select the 
point (or points) with which you want to work. 

Selected points are displayed as black squares; the re­
maining points on the element are displayed as hollow 
squares. When you select a single point, its tangent line 
(if any) is shown, as is the half-tangent (if any) of the 
point on either side of the selected point . 

. ,:+ 
~ selected point \0/ +~ 

... / . 
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Plane Tool 

After selecting all 
points, if you drag one 
of the selected points, 
you move the entire 
element. 
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To select points: 

o To select a single point, click on it. 

o To select more than one point, Shift-click on each point. 

o If you are not sure where a point is, drag a selector 
box. (You can also use this technique to select more 
than one point.) Artline selects all points within the se­
lector box. 

If the selector box includes points you do not want, de­
select the unwanted points by Shift-clicking on them. 

o To add several additional points to an existing selec­
tion, Shift-drag a selector box around the area where 
the points are located. 

To select all points on an element: 

o Hold down the Alt key and click on the element, or 
drag a selector box around the whole element. 

o To select all points on additional elements, hold down 
the Shift key as you Alt-click on the elements. 

Selecting Adjacent Points 

To select a point on either side of the currently selected 
point, press the left-arrow or right-arrow. By continuing 
to press the left-arrow or right-arrow, you can "walk the 
points" to the first or last point of the element. 

Selecting Points in Stacked Elements 

When elements are stacked on top of each other, the 
Plane can select unwanted points. To avoid selecting 
points on other elements, you can do the following: 

o Separate elements into layers. The Plane selects 
points only on elements in the active layer. 

o Lock the elements whose points you do not want to se­
lect. To lock an element, select it and then choose the 
Lock command from the Element menu. 
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Plane Tool 

Moving Anchor Points 

Moving an anchor point (or several selected anchor 
points) changes the shape of the element. You could, fO.r 
example, change a square into a rectangle. The illustra­
tion below shows one example of the effect of moving an­
chor points. 

11 D 

MI@MO 
i I , .. ~ 

Toolbox 

Note the following: 

D All selected points move with the one you are dragging. 

D The position of the selected points relative to each 
other does not change. 

D Unselected points do not move. 

D The angle and length of tangent lines are unchanged 
when you drag an anchor point (see below). 

tangent line before 
moving anchor point 

r \i/i 
--1'\., 1 

tangent line after 
moving anchor point 

l ................. . 
... . ........................................... . 
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Plane Tool 

Editing Curves 

The tangent line is 
solid, unless you 
deliberately break it. 
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Direction points mark the ends of a tangent line. When 
you draw a curve with the Quill, the tangent line is a 
solid line, and the direction points are the same distance 
on either side of the tangent point. 

Moving a direction point changes the shape of the curves 
at the tangent point. There are two kinds of curve edits: 

o solid tangent edits 
o broken tangent edits 

Solid Tangent Edits 

When you drag a direction point on a solid tangent line, 
you change the length and angle of the tangent line, and 
the shape of the curves on both sides of the tangent point 
changes to remain tangent to the modified line . 

............ , 
....... / /6:::;;;;::0-< .. ".... .... , .. "l" 

[fX/' 
......... / ... /.. .... .......... . 

...... / \ .. , .................... . 
. " ........... [<l 

.... ............. ................. . ........ ::',7' 
................................. :::::.: ... : .... : .... ,= 

j 
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Toolbox 

Plane Tool 

Broken Tangent Edits 

By breaking the tangent, you can change the shape of the 
curve on one side of the tangent point. 

To break the tangent, press the Alt key and then drag a 
direction point. You change the curve only on that side of 
the tangent point; the opposite direction point does not 
move. 

Once the tangent is broken, it remains broken; you need 
not press the Alt key again to drag the direction point. 
You can make a broken tangent solid again by choosing 
the Symmetric command from the Plane tool pop-up 
menu (described next). 
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Plane Tool 

Plane Tool Pop-Up 

Add Point 
Delete Point 

x«»xmex«x«x«x«x«x«x«»xx«*cx«») 

To Line 
To Curve 

X«X«X«»XX«)«<X«X«X«)O(oCX«X«)OC(:«<»Co 

Split Point 
Join Points 

X« X« X« X« X« X« X« X«X«X«X«X«X«»X») 

Synnetric 
Snooth 

X« X«:«< X« X« »x X« X« X« X« X« X« X« X« * 

Align Vert. 
Align Horiz. 

2-58 

The Plane tool pop-up menu contains commands for addi­
tional editing of curves. 

To display the Plane tool pop-up menu: 

[I] Select the point (or points) on which you want to 
work. 

[1J Double-click in the workspace, preferably away from 
the selected points. 

The menu appears at the pointer's location, and dou­
ble-clicking near the points could cause the menu to 
appear on top of them. 

Note that the line from the selected point to the next point 
(in the order in which the points were drawn) has become 
a dotted line. This dotted line is affected by several of the 
commands in the Plane tool pop-up menu. 

Add Point Command 

The Add Point command adds a new point to the ele­
ment, located at the midpoint of the dotted line. 

If the selected point is the last point on the element, Add 
Point adds a straight line segment to the element. To 
convert this line segment to a curve, select the next-to-last 
point on the element and then choose the To Curve com­
mand (described below). 

Delete Point Command 

The Delete Point command deletes the selected point. 

When you delete a junction point, the two points on either 
side of the deleted point are connected by a straight line. 

To Line Command 

The To Line command converts the dotted line from a 
curve to a straight line. This command is available only 
when the dotted line is a curve. 
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Toolbox 

Plane Tool 

To Curve Command 

The To Curve command converts the dotted line from a 
line to a curve. This command is available only when the 
dotted line is a straight line. 

The newly created curve initially appears to be a straight 
line, but it now has tangent lines and direction points. 
You can drag these direction points to give the new curve 
the shape you want. 

Split Point Command 

The Split Point command splits a single selected point 
into two points. The element that contained the point is 
split into two elements that can be separately selected, 
moved, rotated, and so on. 

This command is available for any single point, except for 
an element's beginning and end points. 

Join Points Command 

The Join Points command makes a single point of two 
selected end points. You can use the Join Points com­
mand to: 

o bring the first and last points of an element together; 
o join two elements. 

Joining points can change the shape and color of your ele­
ments in the following manner: 

o If you join the first and last points of the same ele­
ment, the last point moves to the first, and the shape 
of the element changes accordingly. 

o If you join points on separate elements, the point on 
the element on the bottom (lower in the stack) moves 
to the point on the top. Again, the shape of the ele­
ment changes accordingly. 

o If you join points on separate elements, the resulting el­
ement has the color and line attributes of the element 
on the bottom. 
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Plane Tool 

2-60 

Symmetric Command 

The Symmetric command turns a broken tangent line 
(see page 2-57) back into a solid line with direction points 
equidistant from the tangent point. 

A symmetric tangent line has these characteristics: 

D The "outgoing" half of the tangent line (the half on the 
side of the curve leading to the end point of the ele­
ment) is matched to the incoming half of the line. 

D The curve flows continuously and smoothly through its 
tangent point. 

D Moving a direction point moves the entire tangent line, 
not just the half-tangent on the side of the direction 
point. 

Smooth Command 

The Smooth command removes the angle between curves 
at a broken tangent or between a curve and line at a junc­
tion point. 

Smoothed Broken Tangents 

When you Smooth a broken tangent, the result is a 
straight tangent line, but a smooth tangent is different 
from a symmetric tangent in two important respects: 

D Although straight, the tangent line is still broken. You 
can drag the direction points independently, without 
pressing the Alt key. 

D The lengths of the half-tangents are not changed; they 
can be different lengths. In a smoothed tangent, the 
outgoing half of the line moves to line up with the in­
coming half. 
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Plane Tool 

Junction Points 

When you Smooth a junction point, the curve is changed 
so that it passes smoothly into or out of the line segment. 
There is no apparent angle where the curve meets the' 
line . 
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Plane Tool 
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Align Vert 

The Align Vert command moves all selected points to the 
left or right so that they line up vertically with the first 
selected point-the point nearest the element's starting 
point. 

Align Hariz 

The Align Horiz command moves all selected points up 
or down so that they line up horizontally with the first se­
lected point-the point nearest the element's starting 
point. 

Align Thrt Align Horiz 
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Thumbtack 

Copying Portions of a Curve 

The Duplicate and 
Clone commands are 
described in Chapter 7. 

To copy portions of a curve or polygon: 

IT] Use the Plane to select all points on the segment you 
want to copy. 

[]] Choose the Duplicate or Clone command from the 
Edit menu. A Duplicate copy is offset by one grid in­
crement (regardless of the state of the grid snap); a 
Clone is copied directly on top of the original. 

copy made with 
the Duplicate 
command 

Thumbtack 

Toolbox 

The Thumbtack, more of an accessory than a tool, is used 
for setting a center of rotation or an alignment point. 

To set the Thumbtack: 

IT] Select the Thumbtack in the toolbox. 

[]] Click the pointer where you want the center of rota­
tion or the alignment point. The Thumbtack form 
appears on the drawing surface at that point. 

To remove the Thumbtack from the workspace: 

OJ Select the Thumbtack in the toolbox. 

[]] Click anywhere in the workspace to "pick up" the 
pointer from the drawing surface. 
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Flipper 

Flipper 

To see the angle of 
the flip line, display the 
status line. 
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The Flipper tool moves or copies selected elements to a 
"mirror-image" position. By dragging a flip line, you con­
trol the placement and angle of the flipped elements. 

To flip an element: 

[] Click on the Flipper tool. 

[]] Drag a flip line. When the flip line is long enough, a 
preview of the flipped element is displayed. 

[]J Release the mouse button. All selected elements are 
flipped across the line. 

lj,eView IE flipped element 

r:::tS flip line 

~ 

To constrain the flip angle to 45° increments: 

Hold down the Ctrl key as you drag the flip line. 

To copy an element over the flip line: 

Hold down the Shift key as you drag the flip line. 

To abandon after you start dragging the flip line: 

[] Drag a short flip line (so that no preview appears) 
and then release the mouse button. Artline displays 
an alert saying that the flip line is too short. 

[]] Click on the alert's OK button. 
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Rolling Pin 

Rolling Pin 

Toolbox 

The Rolling Pin skews a selected element or group, 
distorting it from its original shape. 

To use the Rolling Pin tool: 

[I] Select an element. 

IT] Click on the Rolling Pin tool. 

[ill Drag one of the element's corner handles or a mid­
point handle, depending on the effect you want. 

- Dragging a corner handle can skew the element in 
two directions at once-for example, up and to the 
right, or down and to the left. The element's other 
corner handles remain fixed. 

- Dragging a midpoint handle skews the element 
along the plane on which the handle is located. 

[Z:F2V1~1 

NOTE: The Rolling Pin tool works only on single selected elements 
or groups. If you select more than one element or group, the 
Rolling Pin works only on the element whose handle you are 
dragging. 

2-65 





File Menu 

Y"'lJ'1HIS chapter describes the commands in the File menu, which 
JL are primarily concerned with file operations like opening and 

saving files, reading files into Artline, various kinds of output, and 
defining the Artline page layout. 

New AW 
Open... AO 
Merge File... AB 

~~~~~~~~~-~--~-@---@ Save AU 
Save As... AM 
Export... AX 
Abandon AA 

To App ... 
To Output 
uit 
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Abandon/Save Alert 

Abandon/Save Alert 

If you choose the New, Open, Abandon, To Output, or 
Quit command when the drawing surface contains work 
you have not saved, Artline displays this alert: 

Abandon/Save changes 
to this picture? 

Abandon 

Save 

Cancel 

The alert's exit buttons give you three options: 

Abandon 

Save 

Cancel 

Unsaved work is discarded and the command 
is carried out. 

The file is saved under its current name and 
the command is carried out. If the picture has 
not yet been saved, Artline displays the Item 
Selector so you can give the file a name and 
save it. 

The command is canceled. You return to the 
current picture. 

NewCommand 
The Abandon/Save 
alert is displayed if the 
drawing surface con­
tains unsaved work 
(see above). 

3-2 

The New command clears the drawing surface so you can 
start a new picture. 

The New command automatically loads the color file 
ARTLINE.COL and makes the Color Manager's Load 
command available. Color files and the Color Manager 
are described in Chapter 12. 
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Open Command 

Open Command 

The Abandon/Save 
alert is displayed if the 
drawing surface con­
tains unsaved work 
(see page 3-2). 

The Open command displays the Item Selector so you 
can select a file to open onto the drawing surface. 

To select a file, double-click on its name in the directory 
window (the fastest method) or type the name into the Se­
lection line and then click on the OK button. The Item Se­
lector is described on page 1-20. 

The length of time required to open a file (indicated by 
the rotating "clock face") depends on: 

o the complexity of the picture 
o your computer's processor speed 
o the current Redraw Speed setting (see page 9-4) 

Valid File Formats 

You can open files in either of these formats: 

o .GEM 

In addition to Artline, these are some of the programs 
that create files in the .GEM format: 

- Presentation Team ™ by Digital Research® 
- GEM Artline (Release 1.0 - Digital Research) 
- GEM Draw Plus by Digital Research 
- PerFORM by Delrina Technology Inc. 

o encapsulated PostScript-Adobe Illustrator format 
(extension .EPS or .AI) 

Much clip art is provided in this format. 

CAUTION: The EPSF files produced by Artline are intended for use 
with desktop publishing programs and cannot be opened in 
Artline itself. If you create an EPSF file of a picture that 
you want to be able to edit later, make sure you also save 
the picture as a .GEM file. See the description of the Save 
As command (page 3-6). 
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Merge File Command 

Merge File Command 
Merging has no effect 
on the file you are 
merging from. 
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The Merge File command loads any file in the .GEM for­
mat (including other Artline files) or the Adobe Illustrator 
encapsulated PostScript format into the current file. The 
Merge File command makes it possible to assemble 
libraries of pictures you can read into your Artline files. 

When you choose the Merge File command, the Item Se­
lector is displayed. Select the file you want by double­
clicking on its name in the directory window or by typing 
the name into the Selection line. 

Files with Layers 

Merging a file always adds at least one new layer to the 
current file. 

D If you merge a one-layer file, a single layer is added. 
The new layer takes the name of the merged file and is 
placed on top of all other layers. 

D If the merged file has more than one layer, Artline dis­
plays this alert: 

Merging Rultiple-la~er file. 
Merge to separate la~ers in the current 
file Dr cORbine to a single la~er? 

LaMers 

CORbine 
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~ Default Layer 
background 
red 
green 
blue 
LAYERS 

Save Command 

Layers 

The file is merged with its layer structure intact. The 
new layers are placed on top of the other layers in the file 
and keep the names they had in the original file. 

background J 
red 
Add Layer ... 

Duplicate layer names are possible in this case, but the 
new layers are always added on the top-farther down 
the list displayed by the Layer tool. 

Combine 

Artline combines all the layers in the merge file into a sin­
gle new layer in the current file. The new layer's name is 

_ the same as the merge file's, and the new layer is on top 
of any other layers at the time it ~s added. 

Valid File Formats 

You can merge files in the .GEM and encapsulated PostS­
cript formats. (See the description of the Open command 
on page 3-3.) 

Save Command 

File Menu 

The Save command saves the current picture under the 
name that appears in the title bar. Save your work at reg­
ular intervals to protect it from power failures or other un­
expected occurrences. 

The current display status of the Layer Manager (Active, 
Visible, All, or Slides) is saved with the file. For example, 
a file that is saved in Slides mode will automatically be in 
Slides mode the next time you open it. Display status is 
discussed on page 10-15. 

You can set your preferences so that the last version of 
your picture file is saved as a backup each time you save. 
Backups are described on page 9-2. 
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Save As Command 

Save As Command 

You do not have to 
type the .GEM exten­
sion. Artline supplies 
it automatically. 
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The Save As command displays the Item Selector so 
you can: 

o name and save a picture for the first time; 

o save an existing picture under a new name, permitting 
you to keep two distinct versions; 

o save a picture to another directory or disk. 

The Item Selector is described on page 1-20. 

Saving for the First Time 

To name and save a picture for the first time, choose the 
Save As command, set the path in the Item Selector to 
the directory in which you want to save the file, and type 
a name into the Selection line of the Item Selector. 

Artline saves files to the \ARTLINE\ARTWORK direc­
tory unless you change the path specification in the Item 
Selector. 

Saving Under a New Name 

To save a file under a new name, choose the Save As com­
mand and type the new name in the Item Selector's Selec­
tion line. 

Note that the name in the window's title bar changes to 
the new name. Any additional work on the picture takes 
place in the new version of the file, and the original pic­
ture is unchanged. 

Saving to Another Disk or Directory 

To save a picture to another disk or directory, first change 
the path in the Item Selector's Directory line, and then 
enter the filename in the Selection line. 
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Export Command 

Export Command 
You do not have to 
save the current file 
before exporting it. 

File Menu 

The Export command displays the Export Picture dialog 
so you can create a variety of other files from part or all of 
the current file. 

Export Picture 

r E.port Fro. 
_ Source I Active La~er I~I 

I 
Export To 

@D Single-Sheet .GEM File 
() Multiple .GEM files 
() Multiple-Page .GMP file 

I OK II Cancel I 

Export From 

The Export From pop-up menu determines what is 
exported. 

Export Fron --------, 
Source Active La er 

'--__ --; Active La!}er 
Uisib1e La!}ers 
Slides 
Spot Colors 
Selected Elenents 

Active Layer 

Only the active layer is exported. 

Visible Layers 

All layers flagged as Visible in the Layer Manager (Chap­
ter 10) are exported. 
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Export Command 

3-8 

Slides 

All layers are exported. If a layer is designated as the 
background to one or more slides (page 10-8), it is ex­
ported only with the layers to which it is linked; it is not 
exported separately. 

Spot Colors 

All elements currently displayed on the drawing surface 
are exported, including elements hidden from view by 
overlapping layers. 

Spot color separation produces one page or file for each 
color exported. All occurrences of a given color are ex­
ported to a single page or file, regardless of the layer on 
which they occur. 

Remember the following about spot colors: 

o Any small variation in a color causes it to be treated as 
a distinct color that is exported separately. For exam­
ple, a color that is 66.6% red is exported separately 
from a color that is 66.7% red, although the two colors 
might otherwise be identical. 

o The actual colors are not exported to the file (or files). 
Instead, the area occupied by the color is exported as 
solid black or (in the case of fountains and blends) as 
shades of gray. This allows you to go directly to offset 
plates. 

Selected Elements 

All selected elements on the drawing surface are 
exported. 
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Available for Active 
Layer, Visible Layers, 
or Selected Elements. 

Available for Visible 
Layers, Slides, or 
Spot Colors. 

Available for Visible 
Layers, Slides, or 
Spot Colors. 

Abandon Command 

Export To 

The Export To options determine what kind of file is pro­
duced by the Export command. The availability of the 
options depends on the Export From option chosen above. 

Single-Sheet. GEM File 

The result is a single file containing the active layer, visi­
ble layers, or selected elements. This file can be opened in 
Artline or merged into an Artline file. 

Multiple .GEM Files 

The result is a separate file for each exported layer, slide, 
or color. Each file can be opened in Artline or merged into 
an Artline file. 

When exporting to multiple .GEM files, the filename you 
specify cannot be more than five characters long. Artline 
uses the remaining three characters for automatic num­
bering of the files-for example, SLIDEOOO.GEM, 
SLIDE001.GEM, and SLIDE002.GEM. Note that the 
numbering starts with 000. 

Multiple-Page .GMP File 

The result is a single file with separate pages for each ex­
ported layer, slide, or color. U sing the Output program, 
you can print this file or display it on the screen. For ex­
ample, using the Slides option and a series of layers shar­
ing one or more backgrounds, you can create an entire 
on-screen slide presentation in a single file. 

Abandon Command 

The Abandon/Save 
alert is displayed (see 
page 3-2). 

File Menu 

The Abandon command discards all unsaved changes to 
the picture you are working on and opens the current 
saved version of the file. 
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Page Layout Command 

Page Layout Command 

Letter 
'''' Letter 

Legal 
Din A3 
Din A4 
Din AS 
Din B4 
Din BS 
Slide 
CustO[11 
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The Page Layout command displays the Page Layout 
dialog. 

Page La!.'out 
Page 
Size I Letter 1"'1 
1 t .00 )( 8.50 ::Inch 

Orientation I Portrait 1"'1 

Unit of Measure I Inches 1"'1 

Marks 
[] Registration Marks [] Tri[11 Marks 

Offsets: Horizontal l.nl inch 

Uertical I B.BBI inch 

I OK I I Cancel I 

Page Options 

The Page options menus allow you to specify the size of 
your paper, its page orientation, and the current unit of 
measure. 

Size 

The Size pop-up menu lists the standard American and 
European paper sizes, plus two special options: 

o The Slide option sets a page size with the same aspect 
ratio (height-width ratio) as a 35mm slide. 

o The Custom option dis­
plays the Custom Page 
Size dialog so you can set 
a custom page size. 

CustO[11 Page Size 
Page Size 
Width 16.75 I inch 

Height 19.2SLI inch 

I OK I I Cancel I 
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Portrait 
Landscape 
Portrait 

Page Layout Command 

Orientation 

Portrait is a vertical page orientation; Landscape is a 
horizontal page orientation. 

Unit of Measure 

Inches I'" 
The unit of measure chosen in this pop-up menu is re­
flected throughout Artline in the rulers and in all dialogs 
that have measurement fields. 

Inches 
Centill1eter 
Millill1eter 
Points 
Picas 

File Menu 

Marks Options 

The Marks options turn on registration marks and trim 
marks and set offsets for these marks. 

Registration Marks 

Registration marks are used for printing color separa­
tions. The marks, which are placed outside the picture's 
trim area (see the description of trim marks below), en­
sure that each color is accurately placed as the paper 
passes through the press. 

Trim Marks 

Trim marks indicate the actual size of the finished page. 
All paper outside the trim marks is cut away after the 
page is printed. 

NOTE: Some programs refer to trim marks as "crop marks," a term 
that more commonly refers to the marks used to indicate 
where a photograph should be cut before it is pasted onto a 
layout page. 

Offsets 

The offset values make it possible to specify a trim size 
smaller than the specified paper size. The values are mea­
sured from the edges of the paper and determine where 
the trim marks are placed on the page. 
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Page Layout Command 

1.5" 1 

To calculate the trimmed size, subtract twice the offset 
value from each dimension. For example, on 8.5 by 11-
inch paper, Horizontal and Vertical values of 1.0 and 1.5 
inches, respectively, define a trim size of 6.5 inches by 8 
inches. 

1" 
~ 

1" 
~ 

trim marks 

registration marks 

1.5,,1- 1 

~--------------------------.. 
+ 

When the offset values 
are zero, marks are vis­
ible only in Full view or 
a wider view. 

You can use offset values of zero when preparing files for 
a phototypesetter, where the actual sheet size is usually 
considerably larger than a standard piece of paper. To 
place trim marks that define your true page size, specify 
the actual trim size in the Size option and set the Marks 
offsets to zero. 

NOTE: For trim marks and registration marks in PostScript out­
put, you must turn them on in the PostScript dialog. See 
page 3-20. 
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PostScript Command 

PostScript Command 
You do not have to 
save the current file 
before starting Post­
Script output. 

The PostScript command displays the PostScript Out­
put dialog so you can print directly to a PostScript printer 
or create a file in the standard PostScript or the encapsu­
lated PostScript format. 

PostScript Output Dialog 

To stop PostScript out­
put, press the Esc key. 

LPT 1 I· 
LPT 1 
LPT 2 
LPT 3 
COM 1 
COM 2 
COM 3 
File 
EPSF 

File Menu 

PostScript@ Output 

r Device 
_ Output to I LPT 1 '·1 ~ of copies [g] 

I 
Printer Paper 
Size 1 Letter '.11 Portrait '·1 11.00 )( 8.50 1nc.h 

Scaling @ Fit to Paper 0 [}Q[] % 

Options 
Separation I None '·1 I I OK 
I Screen 0etions ... 1 I Cancel I 

Device Options 

The "Output to" menu lists a choice of three parallel Post­
Script devices (LPTl through LPT3), three serial devices 
(COMl through COM3), and two file options. 

For all options except encapsulated PostScript (described 
on the next page) you can specify as many as 99 copies. 
Type the number of copies directly into the field or use 
the pop-up slider. 
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PostScript Command 

The directory path in 
the Item Selector must 
name a real directory, 
even though the file 
will not be written to it. 

The EPSF file includes 
all layers currently 
visible on the screen. 

Documents with EPSF 
files must be printed on 
a PostScript printer. 

You can produce an 
EPSF file without 
saving the picture. 
See the caution on 
page 3-3. 
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File 

The File option creates a file (with extension .COO) that 
you can print on a PostScript device. You could, for exam­
ple, print to a file on a floppy disk and then: 

o go to a print shop and print on a phototypesetter; 

o take the disk to a computer connected to a PostScript 
printer. 

To print on the PostScript device, use the operating 
system's Copy command in this format: 

COpy FILENAME.COO LPT1 

[or LPT2, COM1, COM2, etc.] 

If you are on a network and your printer's device number 
is higher than those available in the "Output to" menu­
LPT6, for example-you can print to a file whose name is 
the same as the device number. If, for example, you print 
to a file called LPT6, the operating system will intercept 
the file and send it to device LPT6. 

EPSF 

The encapsulated PostScript option produces a file specif­
ically intended for inclusion in documents created with 
programs like Xerox® Ventura Publisher® or Aldus® 
PageMaker®. 

The Include Preview option adds a TIFF-format "snap­
shot" of the drawing surface to the file, so the file can be 
displayed in PageMaker or Ventura (Release 2.0 or 
higher). This option replaces the "# of copies" field. 

The TIFF preview increases the size of the EPSF file by 
an amount ranging from 5Kb to 25Kb, according to the 
resolution of your screen and the size of the picture rela­
tive to the full drawing surface. The more the picture fills 
the drawing surface, the larger the preview. 

For files created with the preview option turned off, a 
large X fills the frame in Ventura. Although not visible on 
the screen, the picture will print correctly. 
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Printer Paper options 
are not available for 
EPSF output. 

Letter I'" 
Letter 
Legal 
Din A3 
Din A4 
Din AS 
Din B4 
Din BS 
Slide 
(ustOIl\ 

The aspect ratio 
(relative height and 
width) of the original 
is maintained. 

File Menu 

PostScript Command 

Printer Paper Options 

These options specify the size and orientation of the 
printer paper and a percentage for scaling the picture to 
the output page. 

Size 

The Size menu lists the standard American and European 
paper sizes, plus two special options: 

D The Slide option sets a page size with the same aspect 
ratio (height-width ratio) as a 35mm slide. 

D The Custom option displays the Custom Page Size dia­
log (page 3-10) so you can set a custom page size. 

Orientation 

The orientation options in the PostScript dialog refer to 
how the paper is inserted into the printer; they are not 
the same as the options in the Page Layout dialog. 

The Portrait option is for most typical PostScript printers; 
the paper is inserted vertically. The Landscape option is 
for wide-carriage PostScript printers and phototypsetters; 
the paper is inserted in a horizontal orientation. 

Scaling 

These options determine the size of the picture on the 
printed page. 

"Fit to Paper" enlarges or reduces the picture as needed 
to fit the selected paper size. The percentage field allows 
you to scale the picture to a specific size, ranging from 
10% to 500% of its size in the file. At 100% the picture is 
printed in its original size. 

If the picture size is larger than the paper size, the pic­
ture is cropped. 
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PostScript Command 

Separation Options 

Separation options are The Separation pop-up menu gives you these options: 
not available for EPSF 
output. 

3-16 

Options 
Separation Spot Color If. 

None 
I Screen Opt· 4-Color 

Spot Color "-
Layers 
Slides 

None 

There is no separation. Everything appears on one page 
or in a single file. 

4-Color 

The colors in the file are divided into the four process 
printing colors-cyan, magenta, yellow, black (CMYK). A 
separate page is printed for each color. (In file output, 
each color is stored as a separate page within the file.) 

Spot Color 

Each color in the file is printed on a separate page or is 
stored as a separate page within a file. 

Layers 

Every layer in the file is printed on a separate page or is 
stored as a separate page within a file. 

Slides 

The layers in the file are printed on separate pages or are 
stored as separate pages within a file. Background layers 
are printed only with the layers to which they are linked. 
Slides are described on page 10-8. 
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PostScript Command 

PostScript Screen Options 

When you click on the Screen Options button, a new dia­
log appears on top of the PostScript Output dialog. 

PostScript@ Q[tions 
Halftone Screen Options 
Screen Function I Default 1·1 
Resolution 00 lpi 

Screen Angle OJ 
Output Options 
[] Color Correction 
[] Separation Na~es 
[] Tri~ Marks 
[] Registration Marks 

I OK I I Cancel I 

NOTE: PostScript Screen Options are not available for EPSF out­
put. However, any fountain screens set with PostScript Fill 
Options (see page 12-15) do appear in EPSF output. 

Halftone Options 

Unless you are experi­
enced at halftone 
screening, it is strongly 
recommended that you 
use the device's 
screen values. 

Default I. 
Default 
Round Dot 
line 

File Menu 

The Halftone Options give you greater control over how 
your picture is printed in PostScript output. 

Screen Function 

You can use the PostScript device's values for screen type, 
resolution, and angle or you can set your own values. 

If you set your own values, first choose between a Round 
Dot screen and a Line screen. In a Dot screen, colors and 
shades of gray are created by varying the weight of col­
ored or black and white dots. In a Line screen, colors and 
shades of gray are created by varying the thickness of 
parallel lines. Dot screen and line screen are illustrated 
on page 12-16. 
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PostScript Command 
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Resolution 

Screen resolution (also known as "halftone screen fre­
quency") allows you to control the sharpness of halftones. 
Resolution for both dot screens and line screens is mea­
sured in lines per inch (lpi). 

Because the resolution of output devices is fixed-for ex­
ample, 300 dpi for a typical laser printer and 2540 dpi for 
a phototypesetter-increasing the halftone resolution sig­
nificantly reduces the number of available gray levels. 
This equation shows how the two are related: 

l
. dpi 

Pl-- -Vgrays 

or, stated another way: 

grays = (dP~J2 
lpl 

For example, on a 300 dpi printer, a resolution of 50 lpi 
produces thircy-six gray levels; a resolution of 100 lpi pro­
duces only nine gray levels. The resolution is twice as 
great, but the number of gray levels is one fourth what it 
was. (The effective resolution of solid colors is unchanged.) 

Screen Angle 

Screen Angle refers to the physical angle at which screens 
are printed relative to each other. This option is intended 
primarily for creating special effects in unseparated out­
put and in spot color separations. 

In 4-color separation, the screen angles are set automati­
cally (to avoid undesirable moire patterns in the ink) and 
override anything set with this option. 
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File Menu 

PostScript Command 

Output Options 

This portion of the Set Screen Options dialog allows you 
to turn on the following: 

o color correction 
o separation names 
o trim marks 
o registration marks 

Color Correction 

Color correction is intended to compensate for two prob­
lems commonly encountered in printing color separations: 

o Typical CMY inks are "contaminated," containing 
sometimes significant amounts of the other colors. For 
example, cyan usually contains 30% magenta, and ma­
genta contains 50% yellow. 

This aspect of color correction is called undercolor re­
moval, as it removes the colors that are "underneath" 
the main color. For example, without undercolor re­
moval, an area where magenta overlaps cyan might 
contain too much magenta because of the magenta al­
ready in the cyan. 

The specifics of undercolor removal are: 

- Where yellow and magenta overlap, the yellow sepa­
ration is reduced by 50% of the amount of magenta. 

- When magenta and cyan overlap, the magenta sepa­
ration is reduced by 30% of the amount of cyan. 

o The only way to get a good black is to use black ink, 
not by combining cyan, magenta, and yellow. Color cor­
rection adds enough black to give the colors extra inten­
sity and contrast. 

For more information on colors, see the discussion of color 
models in Chapter 12. 
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PostScript Command 
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Separation Names 

This option places the name of the color separation on 
each page. 

Trim Marks 

This option places trim marks on each page. Trim marks 
are important when the page size is different from the 
sheet size, often the case with phototypesetters. See the 
discussion of trim marks on page 3-11. 

Registration Marks 

This option places registration marks on each page. Reg­
istration marks are essential for proper alignment of col­
ors in color separations. See the discussion of registration 
marks on page 3-11. 

NOTE: To get trim marks and registration marks in PostScript 
output, you must turn on these options in the PostScript 
dialog, regardless of their state in the Page Layout dialog. 
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To App Command 

To App Command 

File Menu 

The To App command allows you to start another applica­
tion from Artline, pass a file to that application, and then 
return to Artline when you are done. 

When you choose the To App command, Artline displays 
the Run Application dialog: 

Run Application 

Run I None I 

Parallleters Application Type -
@ Current File o GEM 
o Current IlIIage @ DOS 
o Request ... 
o None o Full Melllory 

Options 
~ Auto-Save Current Picture I OK I o Return To Artline 

I Cancel I 

The Run button displays the Item Selector so you can 
choose an application. The application does not have to 
be on the same drive as Artline. 

The Item Selector is described on page 1-20. 

Parameters 

These options determine the information passed to the 
application you are running. The information is often the 
name of a file, which is automatically opened when the 
other application starts. 

Current File 

Select this option to pass the name of the current file to 
the other application. 
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To App Command 
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Current Image 

Select this option to pass the name of the current back­
ground image to the other application, typically ScanX­
press™, or GEM® Paint™. 

Request 

Select this option to display the Command Line dialog, 
which allows you to specify something other than the 
current picture or image. 

COlllllland Line 

Enter the cOlllllland line for PAINT.APP 

OK I I Cancel I 

If you are running an application like Presentation Team, 
enter a filename. Give the entire path, as in this example: 

C:\REPORTS\MONTHLY\JANUARY.PTP 

If you are running a DOS executable program, enter any 
parameters in this dialog. 

None 

Select this option if you want to run the application with­
out supplying a filename or any parameters. 

Application Type 

These options identify the type of application you are 
starting. 

GEM 

The application is a graphics-based program running 
under the same "system software" as Artline. Select this 
option if you are running applications like Presentation 
Team, GEM Draw Plus or GEM® Desktop PublisherTM. 
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To App Command 

CAUTION: Some GEM-based applications, including Xerox Ventura 
Publisher, should not be started in this manner. Ventura 
uses its own system software, different from Artline's. 

File Menu 

DOS 

The application is a "non-graphics" application-perhaps 
a word processor, database, spreadsheet, or one of the op­
erating system executable files. 

When you specify a DOS application, you can also identify 
it as a "Full Memory" application-one that requires a 
large amount of memory. 

When a full-memory application is started, most of the un­
derlying GEM system software is removed from memory 
to make room for your DOS application. As a result, re­
turning to Artline takes slightly longer than it would if 
you had not requested full memory. 

Options 

These two choices determine what occurs before and after 
you run the other application. 

Auto-Save Current Picture 

Artline automatically saves the current picture file before 
the other application is started. 

Return to Artline 

When you exit or Quit the other application, Artline is 
automatically re-started. When this check box is turned 
off, you exit to the operating system command line or 
wherever you were when you started Artline. 
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To Output Command 

To Output Command 

The Abandon/Save 
alert is displayed if the 
drawing surface con­
tains unsaved work 
(see page 3-2). 

The To Output command starts the Output program so 
you can print the current picture file, display it in screen 
output, or make transparencies with a camera. 

Output is described in the Artline Utilities Guide. 

Quit Command 
The Abandon/Save 
alert is displayed if the 
drawing surface con­
tains unsaved work 
(see page 3-2). 
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The Quit command ends your session with Artline and re­
turns you to the point from which you started, either the 
operating system command line or the GEM Desktop. 
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Image Menu 

THIS chapter describes the Image menu commands, which are 
used in connection with image tracing. Chapter 11 describes 

image tracing in detail. 

Load IMage ... 
Unload IMage 
IMage Options ... 

Load Image Command 
Image files serve only 
as a drawing aid for 
tracing. They cannot 
be edited with Artline, 
and they cannot be 
saved as Artline files. 

The Load Image command loads an image into the draw­
ing surface background. You can use the Trace tool, Quill, 
or other drawing tools to trace the image. 

You can load files in the IMG, PCX or TIFF formats (see 
''Valid Image File Formats" on the next page). If you 
change the extension in the Item Selector to anything else 
(.GEM, for example), Artline displays this alert: 

Wrong file type. 
The file extension 
Must be *.IMGJ*.PCXJ*.TIF. 

Retry 

Cancel 

Only one image can be loaded at a time. If you load a new 
image, the old image is removed; no alert is displayed. 
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Load Image Command 

4-2 

Valid Image File Formats 

This section provides more information on the supported 
IMG, PCX, and TIFF formats. 

IMG and PCX Files 

The following kinds of files can be loaded: 

o black and white Line Art images: no restrictions. 

o color Line Art images: a maximum of sixteen colors is 
supported. 

o Grayscale images: files with sixteen or 256 grayscale 
values are supported. 

TIFF Files 

There are several different formats used by programs gen­
erating TIFF files. The following are general guidelines 
describing the supported formats: 

o black and white Line Art images: compressed and un­
compressed formats are supported. 

o color Line Art images: uncompressed and some com­
pressed formats, both with a maximum of sixteen col­
ors, are supported. 

o Grayscale images: only uncompressed images with six­
teen or 256 grayscale values are supported. Because of 
the dithering scheme used, images with 256 grayscale 
values will lose some information when displayed. , 

Invalid Formats 

If the file you are trying to load is not in one of the sup­
ported image file formats, Artline displays this alert: 

Wrong inage file fornat. r:2B:] 
Inage files nust be in supported 
IN6, P(X, or TIFF file fornats. 

(annot load inage. 
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Unload Image Command 

Unload Image Command 

The Unload Image command removes the currently 
loaded image from the drawing surface background and 
from memory. 

The image is deleted immediately; Artline does not dis­
play an alert. Do not use this command if you only want 
to check the progress of your tracing; use the Image com­
mand in the View menu or the F9 key instead. 

Image Options Command 

Image Menu 

The Image Options command displays the Image Op­
tions dialog. The settings in this dialog control how an 
image is displayed. 

The Image Options dialog and its settings are described 
on page 11-4. 
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View Menu 

THIS chapter describes the commands in the View menu. Several 
of these commands enable you to use features of Artline that 

make possible great precision in your drawings. 

~ IMage F9 
~ Colors F10 
~ Fountains ' 

Rulers 
Status Line 
Grid 

~ Snap to Grid 
Set Grid ... 

Guide Lines 
Set Guide Lines ... 

~ Toolbox 

Toggles 

Most of the View menu commands are toggles. They func­
tion like a light switch, turning something on and off. For 
example, the Rulers command turns the rulers on (dis­
plays them) or, if the rulers are already on, turns them off 
(removes them from the screen). 

When in its "on" state, the command is flagged with a 
marker in the menu. (In the illustration above, the 
Colors command is one of several that are toggled on. 
The Rulers command is toggled off.) 
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Image Command 

Image Command 
Image tracing is 
described in 
Chapter 11. 

The Image command toggles the display of an image 
loaded for tracing on and off. Its keyboard command 
equivalent is F9. 

You can check the progress of a tracing with the image 
turned off. (The image is still in memory. To remove an 
image from memory, choose the Unload Image command 
from the Image menu.) 

Colors Command 
When colors are 
turned off, all elements 
appear as thin black 
outlines. 

The Colors command toggles the display of all fill colors, 
fountains, line colors, and other line attributes on and off. 
The keyboard command equivalent is FlO. 

Turning off colors reduces the amount of time required to 
draw elements on the screen and can greatly speed your 
work in Artline. (There is one exception. See the Caution 
below') 

Colors are automatically turned off when you select the 
Plane tool. 

I 
.-. 

IV W 

=tt /<- ....I ( 

-- ,"~i<" 

L This is a blend.---.J colors turned off 

CAUTION: Do not turn off colors when working with masked elements, 
especially complex ones. The redraw time for masks can be 
substantially longer with colors turned off. 
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Fountains Command 

Fountains Command 

The Fountains command toggles the display of fountains 
off and on. Turning off fountains can improve Artline's 
speed in drawing elements, especially those that contain 
fountains drawn at an angle. 

When fountains are turned off, the fountain is replaced 
by the fill pattern shown below. 

The Colors command overrides the Fountains com­
mand. If colors are turned off, the fountained element ap­
pears as an outline. When colors are turned back on, the 
state of the fountained element is determined by the 
Fountains command. 

Rulers Command 

View Menu 

The Rulers command toggles the display of the rulers on 
and off. The rulers use the Unit of Measure set in the 
Page Layout dialog. 
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Status Line Command 

Status Line Command 

default fill color _ 
default line color _ 

5-4 

The Status Line command is a toggle that turns the dis­
play of the status line on and off. 

The status line always gives this information: 

o current defaults for fill and line color 
o name of current tool selected 
o number of elements selected 
o X and Y values of the pointer's current position 

Too~: R~ctan9~~ R~ct: X= 7.03 Y= 2.06 

o E~~~~nts s~~~ct~d H= 2.54 H= 1.21 
~--~----------------~----------------~ 

1 
width & height of rectangle being drawn 

The pointer's X and Y values are measured from the 
upper left corner of the drawing surface. The values use 
the current Unit of Measure from the Page Layout dialog. 
When the pointer is off the left side of the drawing sur­
face or above it, the status line shows negative values. 
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View Menu 

Status Line Command 

The additional information displayed in the status line 
depends on the currently selected tool or action: 

D Selector tool: The status line display depends on what 
you are doing: 

- moving elements: the change in the mouse's X and Y 
positions. Positive values indicate that you are mov­
ing the element down or to the right; negative val­
ues indicate movement up or to the left. 

- scaling elements: horizontal and vertical scaling 
values. 

- moving the guide lines: the guide lines' current posi­
tion, measured from the upper left corner of the 
drawing surface. 

D Rectangle tool: the width and height of the rectangle 
you are drawing. 

D Circle tool: the horizontal and vertical "radius" of the 
circle or ellipse you are drawing. 

Tool: C~rclc Tool C~rclc: X= 3.00 Y= 0.78 

1 ElcMcnts Sclcctcd Rad~us: H= 0.90 V= 0.40 

( .............. __. ~··r·· ' .. -.. ~......... .... ;) 
""". ..' .... ' . 

......................................................... 

D Line Tool: the angle of the line you are drawing. 

D Rotator Tool: the current rotation angle. 

D Flipper Tool: the current flip angle. 

+ 

D Rolling Pin Tool: horizontal and vertical scaling per­
centages. 
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Grid Command 

Grid Command 

The Grid command is 
not available when the 
grid spacing is set to 
zero. See the descrip­
tion of the Set Grid 
command. 

The Grid command toggles the display of the grid on and 
off. The grid is a pattern of dots-at intervals set with 
the Set Grid command-that aid in the drawing and 
placement of elements. 

Snap to Grid Command 
The Snap to Grid com­
mand is not available 
when the grid spacing 
is set to zero. See the 
description of the Set 
Grid command. 

The Snap to Grid command toggles the grid snap on and 
off. Grid snap has two meanings, depending on when you 
use it. 

o When you are drawing elements: 

All points-corners of rectangles, anchor points, and so 
on-automatically "snap" (attach themselves) to the 
grid point nearest to the location at which you clicked 
or to which you dragged. 

Grid snap allows you to draw elements in precise sizes 
and at precise locations on the drawing surface. 

o When you are moving or scaling elements with the Se­
lector or moving anchor points or direction points with 
the Plane: 

The pointer moves by exact multiples of the grid's cur­
rent horizontal and vertical spacing (see the Set Grid 
command, next). Elements or points snap to a grid 
point only if they start from one. 

In this case, the command is more "Snap by Grid Incre­
ments" than Snap to Grid. 

NOTE: When Snap to Grid is turned on, elements snap to the grid 
or move by grid increments whether the grid is visible or not. 
The one exception is the Sketch tool, which never snaps to 
the grid, regardless of the state of this command. 
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Set Grid Command 

View Menu 

The Set Grid command displays the Set Grid dialog. 

Set Grid 
Spacing 
Vertical le.125 1 inch 

Horizontal 1 e.187511 inch 

I OK II Cancel I 
.. 

Spacing 

These fields set the Vertical and Horizontal spacing of the 
grid points, using the Unit of Measure currently set in 
the Page Layout dialog. Note the following: 

o Acceptable values vary according to the current unit of 
measure. For Inches, the acceptable values are multi­
ples of one sixteenth of an inch (0.0625). 

If you enter an invalid number, the field is automati­
cally reset to the nearest valid multiple lower than the 
number you entered. 

o The default value for grid spacing is a single unit of 
the current unit of measure-for example, 1 inch if the 
Unit of Measure is Inches. 

o If you try to enter a value larger than the maximum 
allowed in these fields, Artline displays an alert and 
then sets the value to the maximum. 

o The Vertical and Horizontal values do not have to be 
the same; the grid does not have to be a square. 

When the Spacing values are set to zero-in other words, 
when there is no grid-the Grid and Snap to Grid com­
mands are not available. 
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Guide Lines Command 

Guide Lines Command 

5-8 

The Guide Lines command toggles the guide lines on 
and off. 

The purpose of the guide lines is to help you place ele­
ments on the drawing surface. In addition, you can use 
the guide lines in conjunction with specific commands to: 

o align elements (Align command, page 6-9) 
o rotate elements (Rotate command, page 7-7) 
o scale elements (Scale command, page 7-9) 
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Set Guide Lines Command 

Set Guide Lines Command 

Vert. Line value 

Horiz. Line 
value 

View Menu 

The Set Guide Lines command displays the Set Guide 
Lines dialog so you can locate the guide lines precisely on 
the drawing surface. 

Guide Lines 
Position 
Uert. Line 

Horiz. Line 

I 

1 

!lmfil inch 

! 5.501 inch 

OK I I Cancel I 

The position of the guide lines is mea­
sured from the upper left corner of the 
drawing surface. 

The value in the Vert. Line field sets the 
position of the vertical guide line relative 
to the left edge of the drawing surface. 
The value in the Horiz. Line field sets the 
position of the horizontal guide line rela­
tive to the top edge of the drawing sur­
face. 

When initially displayed, the guide lines 
intersect at the center of the drawing sur­
face, and the values are half the width 
and height of the current page size. 

You can also move the guide lines by dragging them with 
the Selector tool. For greater accuracy, display the status 
line first. 
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Toolbox Command 

Toolbox Command 

5-10 

The Toolbox command toggles the display of the toolbox 
off and on. 

When the toolbox is turned off, a somewhat larger work­
space is available. Before turning off the toolbox, make 
sure you select the tool you want to use; you cannot select 
tools while the toolbox is not displayed. 

Artline User Reference Guide 



Element Menu 

YlrHIS chapter describes the commands in the Element menu, 
JL which affect only selected elements in the active layer. 

Send to Back 
Bring to Front 
Step in Back tA 
Step in Front t~ 

~~~~~~******@*@~@****~ 

Lock 
Unlock 
Group *M 
Ungroup *B 

---------------------~ Align to Grid 
Align ... 

@@*~@@***@********@**~ 

Ele(1lent Info ... 

Element Order 

Several of Artline's features-including blends and 
masks-are affected by the order of elements in the stack. 
(See the discussion of stacks in Chapter 1.) 

The first four commands in the menu-Send to Back, 
Send to Front, Step in Back, and Step in Front­
change the order of selected elements in the stack. 

Each command can work on a single element, on several 
elements, and on grouped elements. 
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Send to Back Command 

Send to Back Command 

Keyboard command: 
down-arrow. 

The Send to Back command moves selected elements to 
the bottom of the stack. 

If you select several elements to Send to Back, all are 
sent to the bottom of the stack, but their order relative to 
each other is maintained. 

Bring to Front Command 

Keyboard command: 
up-arrow. 

The Bring to Front command moves selected elements 
to the top of the stack. 

If you select several elements to Bring to Front, all are 
brought to the top of the stack, but their order relative to 
each other is maintained. 

Step in Back Command 

Keyboard command: 
Shift-down-arrow. 

The Step in Back command moves a single selected 
element down one level in the stack. 

Step in Front Command 

Keyboard command: 
Shift-up-arrow. 
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The Step in Front command moves a single selected 
element up one level in the stack. 
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Step in Front Command 

Send to Back ~ / Bring to Front 

Step in Back / ~ Step in Front 
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Lock Command 

Lock Command 

The Lock command "locks" selected elements or groups 
so that they cannot be changed in any way. You cannot de­
lete or move locked elements, change their fill or outline 
colors, mask or blend them. The only thing you can do to 
locked elements is unlock them. 

Locking elements is especially useful if you are creating a 
complex picture and want to safeguard specific parts of 
the picture from accidental changes. (You can also protect 
parts of your pictures by separating them onto layers. 
See Chapter 10.) 

When you click on a locked element with the Selector, Art­
line indicates that it is locked by using a different kind of 
handle-a hollow square at the corners only, as shown 
below. 

Unlock Command 
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The Unlock command changes selected locked elements 
or groups back to their regular state. The standard ele­
ment handles are restored, and you can again delete, 
copy, move, change color, and so on. 
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Group Command 

The Group command makes all selected elements into a 
group, which Artline then treats as a single element. The 
group is enclosed within a single selection frame. 

ungrouped grouped 

You can do almost anything to a group that you can do to 
a single element: move, copy, delete, rotate, and so on. 

Characteristics of Groups 

Element Menu 

o When you group elements, they are automatically 
brought to the top of the element stack. The order of 
the elements in the group relative to each other is un­
changed. 

o When you change the size of a group, you change the 
size of every element in the group proportionally. 

o Elements in a group can have different colors or foun­
tains and different line attributes.· However, if you as­
sign a color, fountain, or line attribute after you make 
the group, it will appear in every element in the group. 
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ungroup Command 

o The appearance of fountains in grouped elements de­
pends on whether you assign the fountain to the ele­
ments before or after you make the group. 

- If you assign the fountain before you group the ele­
ments, each element contains the full color range of 
the fountain. 

- If you assign the fountain after you group the ele­
ments, the entire group is treated as a single ele­
ment, and the color range of the fountain is applied 
to the entire group. 

fountains assigned before grouping fountain assigned after grouping 

o Groups cannot be merged or blended and cannot be 
used as a path element for text along a path. 

o You can nest groups within groups, up to a maximum 
often "levels." For example, you could group two ele­
ments, then select a third element and group it with 
the group. 

Ungroup Command 
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The Ungroup command breaks a selected group into its 
component elements or groups. 

Ungroup is the exact reverse of Group. If you create a 
nested group with a series of five Group commands, it 
takes five Ungroup commands to break it apart entirely. 
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Align to Grid Command 

Align to Grid Command 

The Align to Grid command snaps selected elements to 
grid points in the following manner: 

D single element or group 

The upper left corner of the selection frame snaps to 
the first grid point above and to the left of its current 
position. If the element or group is already on a grid 
point, it does not move. 

D two or more elements 

The elements are aligned as if they were a group. The 
upper left corner of an imaginary frame enclosing the 
selected elements snaps to the first grid point above 
and to the left. The position of the elements relative to 
each other is unchanged. 

NOTE: Align to Grid works whether or not the grid is visible or 
the grid snap is turned on. The command is not available 
when the grid spacing is set to zero-in other words, when 
there is no grid. See the description of the Set Grid com­
mand on page 5-7. 
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Align Command 

Align Command 
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The Align command allows you to align selected ele­
ments several different ways and to several reference 
points. When you choose the Align command, Artline dis­
plays the Element Alignment dialog. 

EleMent AlignMent 
Align To 

@D Selection FraMe Center 
o ThunhtJCK 
o Guide lines 

~ Horizontal I (enterl~1 ~ 

[g] Vertical 1 Middle I ... ' 

I OK I I Cancel I 

Align To 

This option determines the point of reference used for 
alignment. 

Selection Frame 

Elements are aligned to the center, corners, or midpoints 
of an imaginary frame enclosing them. 

Thumbtack 

Elements are aligned to the position of the Thumbtack. 

Guide Lines 

Elements are aligned to the guide lines. The guide lines 
are described on page 5-8. 
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Align Command 

Horizontal and Vertical Alignment 

Use Horizontal settings to align elements to the left, cen­
ter, or right and Vertical settings to align to the top, mid­
dle, or bottom. You can combine Horizontal and Vertical 
alignment options. See the examples on the next page. 

To select an alignment option: 

o Display the Horizontal or Vertical menu and choose 
the alignment from the menu. 

o Drag the alignment tool bars to the position you want. 
The name of the alignment you have chosen appears in 
the pop-up bar. 

Note that the vertical bar controls Horizontal align­
ment (left to right) and the horizontal bar controls Ver­
tical alignment (top to bottom). 

o Click in the gray area of the alignment tool where you 
want the elements aligned. For example, for an upper 
right alignment, click in the upper right corner of the 
alignment tool. 

To turn off alignment in one direction: 

Element Menu 

Click on the box to the left of the alignment name so that 
no X appears. When an alignment is turned off, its pop­
up bar is grayed out, and the aligning tool for that direc­
tion is not displayed. 
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Align Command 
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Element Info Command 

Element Info Command 

Double-clicking on the 
selected element has 
the same effect as 
choosing the Element 
Info command. 

The Element Info command displays one of several dif­
ferent dialogs, depending on the type of element that is 
currently selected, as described below. 

The command is available only for a single element or 
group-anything within a single selection frame. You can­
not choose Element Info when more than one element 
has been selected. 

The following table lists the dialogs displayed by the Ele­
ment Info command. 

element type dialog displayed 

elements drawn with Quill, Trace, Sketch, Rectangle, Circle, Element Info 
and Line tools 

groups Element Info 

merged elements Element Info 

text converted to curves Element Info 

text (not converted to curves) Create Text Element 

text along a path Text Along a Path 

blends Blend Elements 

masks Mask Elements 
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Element Info Command 
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Element Info Dialog 

EleMent Settings 
Position & Size 
Uertical I-I-Ill Width I 5.881 

Horizontal I 8.491 Height I 2.841 

This eleMent has 59 points. 

I OK I I Cancel I 

You can use the Element Info dialog to place an element 
precisely on the drawing surface, set an exact size, or to 
find out how many points or elements it contains. 

To set an element's position: 

Enter values in the Vertical and Horizontal fields. These 
values set the location of the upper left corner of the 
frame enclosing the selected elements. The distances are 
measured from the upper left corner of the page. 

To set an element's size: 

Enter values in the Width and Height fields. These val­
ues set the width and height of the frame enclosing the se­
lected elements. This frame is always a rectangle. 

Counter 

The Element Info dialog's counter tells how many points 
an element contains or, in the case of groups, how many 
elements are contained in the group. 

When the selected element is a group or text converted to 
curves (which is treated as a group), the counter tells how 
many "child" elements the group contains. See the illus­
tration on the next page. 
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Element Info Command 

EleMent Settings 
Position & Size 
Uertical I~:II Width 1 4.551 

Horizontal I 5.741 Height I 1.5al 

This group contains 25 child eleMents. 

I OK I I Cancel I 

Text Elements 

For selected text, Element Info displays the Create Text 
Element dialog so you can edit the text or choose a differ­
ent font, point size, line spacing, or alignment. 

Masked Elements 

For selected masks, Element Info displays the Mask Ele­
ments dialog so you can choose whether to draw the mask 
element. Masking elements is described on page 8-1. 

Blended Elements 

For selected blends, Element Info displays the Blend 
Elements dialog so you can choose a different number of 
steps for the blend or reverse the curve direction. Blend­
ing elements is described on page 8-8. 

--' 

Text Along a Path 

Element Menu 

For selected text along a path, Element Info displays the 
Text Along a Path dialog so you can choose a different text 
scaling option, whether to show the path element, or 
whether to rotate the text around the path. Text along a 
path is described on page 8-14. 
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Edit Menu 

THIS chapter describes the commands in the Edit menu. Most of 
the Edit menu commands affect the currently selected element 

or elements on the drawing surface. 

Cut 
Copy 
Paste 
Delete 

+U 

+X 
+C 
+P 
+E 

Select All +S 
Duplicate +D 
Clone +L 

Move. .. +W 
Rotate... +R 
Scale... +Q 

Re eat +F1 
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Undo Command 

Undo Command 

The Undo command allows you in several cases to cancel 
your last action and restore the drawing surface to the 
way it was. 

You can undo the effects of these tools and commands: 

o Delete command 
o Selector tool (move or scale) 
o Rotator tool 
o Flipper tool 
o Rolling Pin tool 
o Align command 
o Align to Grid command 
o Move command 
o Rotate command 
o Scale command 
o Repeat command 

The command name that appears in the menu is Undo 
followed by the name of the action to be undone-like 
Move, Scale, or Align. 

Cut Command 
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The Cut command removes the selected elements from 
the drawing surface and places them in the paste buffer. 

Paste Buffer 

The paste buffer is an area of your computer's memory re­
served for elements that you cut or copy. The contents of 
the paste buffer can then be pasted back onto the drawing 
surface. 

The paste buffer is "one level deep." Each time you cut or 
copy something to the buffer, the previous contents of the 
buffer are cleared out and can no longer be pasted. 
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Copy Command 

Copy Command 

The Copy command places copies of the selected ele­
ments in the paste buffer. The original elements 
remain on the drawing surface. 

Paste Command 

The Paste command takes the contents of the paste 
buffer and places it on the active layer of the picture. 

Pasting does not empty the buffer. You can Paste the con­
tents of the buffer as often as you want. When you quit 
Artline, however, the paste buffer is emptied. 

Cutting and Pasting Between Files or Layers 

The New command 
and Open command 
do not affect the 
contents of the paste 
buffer. 

You can use Cut and Paste (or Copy and Paste) to take 
something from one file or layer to another file or layer. 

To cut and paste between files: 

[JJ Select and Cut (or Copy) the elements you want. 

Because the paste buffer is only one level deep, you 
must select and cut all the elements you want. 

[]] Choose the New command or the Open command, 
depending on whether you want to paste the ele­
ments into a new file or an existing file. 

When the "Abandon/Save" alert is displayed, save or 
abandon the current file. 

[]] Choose the Paste command to paste the elements 
into the file now in the workspace. 
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Delete Command 

To cut and paste between layers: 

[]] Select and Cut (or Copy) the elements you want. 

[ill Use the Layer Selector to select the layer into which 
you want to paste the elements. 

[]] Choose the Paste command to paste the elements 
into the active layer. 

Delete Command 

The Delete command removes the selected elements 
from the drawing surface, but does not place them in the 
paste buffer. 

Delete is the command to use when you want to throw 
something out. You can still "undelete" the elements by 
choosing the Undo Delete command, as long as you have 
not done anything else in the meantime that can be un­
done (see page 7-2). 

Select All Command 
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The Select All command selects all the elements on the 
drawing surface. If the picture is divided into layers, the 
command selects all the elements on the active layer only. 

CAUTION: Remember that, depending on the current view, the work­
space might enclose only a portion of the drawing surface. 
The Select All command can select elements that are not 
visible in the workspace. Actions that affect selected ele­
ments (like Delete) can affect elements you don't see. 
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Duplicate Command 

Duplicate Command 

The Duplicate command copies the selected elements di­
rectly onto the drawing surface. The copies are offset 
slightly below and to the right of the originals and are se­
lected. If grid spacing has been set, the duplicate ele­
ments appear one grid increment below and to the right 
of the originals. (See the description of the Set Grid com­
mand on page 5-7.) 

NOTE: The Duplicate command does not use the paste buffer, so 
copying elements in this manner does not affect what is in 
the buffer. 

Clone Command 

Edit Menu 

The Clone command copies the selected elements directly 
onto the drawing surface. Unlike the Duplicate com­
mand, Clone places the copies directly on top of the 
originals. 

The Clone command can be used, among other things, in 
creating multi-color blends. See page 8-13. 

7-5 



IVlove c-ommana 

Move Command 

You can also move ele­
ments with the Selec­
tor tool or the Element 
Info command. 
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The Move command displays the Move Elements dialog 
so you can move the selected elements a specified dis­
tance. This method of moving elements gives you greater 
precision than does moving elements with the Selector 
Tool. For example, to move an element exactly 1.6 inches, 
use the Move command. 

Move EleJ'11ents 

Horizontal 

Uertical 

o Make Copy 

I~I inch 

B,BOI inch 

OK I I Cancel I 

Type directly into the Horizontal and Vertical fields, or 
use the pop-up sliders to enter values. To move the ele­
ments to the left or toward the top of the drawing surface, 
enter negative values in the Horizontal and Vertical 
fields, respectively. 

The Make Copy option makes copies. The original ele­
ments remain where they were, and the copies are moved 
by the distances specified in the dialog. 
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Rotate Command 

Rotate Command 

You can also rotate 
elements with the 
Rotator too\. 

The illustrations on 
the next page show 
examples of the three 
centers of rotation. 

Edit Menu 

The Rotate command displays the Rotate Elements dia­
log so you can rotate the selected elements. 

Rotate Elelllents 
Rotate Around 
~ Selection Center 

Rotation Angle ,_111° 
o ThulIlbtack o Make COP!I 
o Guide Lines 

I I OK I Cancel I 

Rotate Around 

Use these buttons to select a center of rotation for the 
selected elements. 

Selection Center 

A single element is rotated around the center of its selec­
tion frame. If you select more than one element to rotate, 
the elements are treated as if they were a group and are 
rotated around the center of an imaginary selection frame 
enclosing them. 

Thumbtack 

The Thumbtack serves as the center of rotation for a sin­
gle element or for the imaginary selection frame enclosing 
more than one selected element. 

Guide Lines 

The intersection point of the guide lines serves as the cen­
ter of rotation for a single element or for the imaginary se­
lection frame enclosing more than one selected element. 
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Rotate Command 

............ \ 

'i. .. _ ... _._ .... _. __ ..... _.( .. -....... _ .. : 
i 
i 
i 

r·--........ _ ........ _·_ .. ;.· .. ·· .. ·· .... · 
~/,: 

i! 

................ _ ... _ .... , 

Rotate Around: Selection Center Rotate Around: Thumbtack 

Rotate Around: Guide Lines 

Rotation Angle 

270
0 This field determines the angle through which the 

Do rectly into this field or drag the pop-up slider to 
180°-+~---~=-~-+-~ 

element (or elements) will be rotated. Type di-

~) enter a value. Elements are rotated clockwise. 
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9~ 

Make Copy 

The Make Copy option makes copies rotated by the angle 
specified in the dialog. The original elements remain 
where they were. 
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Scale Command 

Scale Command 

You can also scale ele­
ments with the Selec­
tor tool or the Element 
Info command. 

The Scale command displays the Scale Elements dialog 
so you can scale (change the size of) selected elements. 

Scale Elel'llents 
Scale 
@ Uniforl'll o Non-Uniforl'll 

Size Illsllll % 

Relative To D Make Cop!:, 
@ Selection Center 
o Thul'Ilbtack 
o Guide Lines 

I II Cancel I OK 

Scale Options 

Use these options to choose uniform or non-uniform scal­
ing and to choose the scaling percentage. 

NOTE: The scaling values are percentages of the original. 100% is 
the element's original size. 50% is half size; 200% is twice 
the original size. 

Edit Menu 

Uniform 

The height and width of the elements are scaled equally, 
and the proportions of the elements are unchanged from 
the original. 

When you choose Uniform scaling, a single Size field is 
available. Type a percentage directly into the field, or use 
the pop-up slider to set a percentage. This percentage is 
used for both horizontal and vertical scaling. 
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Scale Command 

Non-Uniform 

The height and width of the elements are scaled sepa­
rately, allowing you to change the proportions of the 
originals. 

When you choose Non-Uniform scaling, separate Horizon­
tal and Vertical fields are displayed. Type percentages di­
rectly into the fields, or use the pop-up slider to set 
percentages. 

Scale -------------, 
o UniforJll @ Non-Uniforl'll 

Horizontal /WUI/% Vertical /188 /% 

Relative To 

7-10 

Use these buttons to select a point relative to which the 
selected elements will be scaled. 

Selection Center 

A single element is scaled around the center of its selec­
tion frame. If you select more than one element to scale, 
the elements are treated as if they were a group and are 
scaled around the center of an imaginary selection frame 
enclosing them. 

Thumbtack 

The Thumbtack serves as the scaling point for a single ele­
ment or for the imaginary selection frame enclosing more 
than one selected element. 

Guide Lines 

The intersection point of the guide lines serves as the 
scaling point for a single element or for the imaginary 
selection frame enclosing more than one selected element. 
The guide lines are described on page 5-8. 
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Scale Command 

When you scale relative to the Thumbtack or guide lines, 
the distance of the element from the scaling point 
changes as well. In the illustration below, the element 
was scaled uniformly 130% relative to the guide lines. 

The width and height of the element is 
130% of the original, and its distance 
from the intersection of the guide lines 
is also 130% of the original. 

Edit Menu 

If you scale an element non-uniformly-for example, 50% 
horizontal scaling and 200% vertical scaling-the result­
ing element is half as wide and twice as tall. The horizon­
tal distance from the rotation center is half what it was 
before, but the vertical distance is now doubled. 

Make Copy 

The Make Copy option makes copies scaled by the percent­
age (or percentages) specified in the dialog. The original 
elements are unchanged. 
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Repeat Command 

Repeat Command 

7-12 

The Repeat command repeats the last action of these 
tools and commands on selected elements: 

o Selector tool (moving or copying) 
o Rotator tool 
o Move command 
o Rotate command 
o Scale command 
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Combine Menu 

THIS chapter describes the commands in the Combine menu. 
These commands include some of the most powerful features of 

Artline. 

Mask 
Merge Ele(l1ents 
Blend ... 
Text Along Path ... 

Convert to Curves 
S lit Ele(l1ent 

Mask Command 
To restore a masked 
element to its compo­
nent elements, choose 
the Split Element 
command. 

The Mask command creates a "cookie cutter" effect, mak­
ing it possible for you to insert patterns and designs of 
your own creation into the elements you draw. 

The Mask command combines a mask element with a 
background to create a single element. The shape of the 
final masked element is the shape of the area where the 
mask and background overlap, as in the illustration on 
the next page. 
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Mask Command 

The background can­
not contain a fountain 
or another mask. 

8-2 

background 

mask 

Mask 
The mask is the cookie cutter. Its shape determines the 
shape of the element created by the Mask command. 

These rules apply to the mask element: 

o The mask must be a single element, drawn with one of 
the drawing tools (like the Quill or the Rectangle tool) 
or created by the Merge Elements command (page 8-
4). Merged elements are treated as a single element. 

You cannot use grouped elements as a mask. 

o The mask must be the topmost of the selected 
elements. 

To make sure the mask element is on top: 
Select the element and then choose the Bring to Front 
command from the Element menu. 

Background 

The background is the design that will appear inside the 
mask shape. It can include: 

o one or more separate elements; 
o grouped elements; 
o merged elements. 
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Mask Command 

Draw Mask Element Option 

The Mask Elements dialog, displayed when you choose 
the Mask command, gives you the option of drawing the 
mask element. When Draw Mask Element is turned on, 
the mask element's complete outline is visible. 

Mask Elenents 

~ Draw Mask Elenent 

OK I I Cancel I 

To re-display the Mask Elements dialog and change the 
setting of the Draw Mask Element option, double-click on 
the masked element. 

Text as a Mask 

To use text as a mask, you must convert it to a single 
non-text element. 

To use text as a mask: 

Combine Menu 

[]] Using the Text tool, enter the text into the Create 
Text Element dialog. Choose the typeface, point size, 
alignment, and other attributes you want, and exit 
the dialog. 

At this point the text does not have to be where you 
will want it located as the mask. In fact, it is easier 
to do the text manipulations in the next step in an 
open part of the workspace. 

[]] Using the Selector, Rotator, or other appropriate 
tools, make the text the size and shape you want. 
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Merge Elements Command 

Once converted to 
curves, the text can 
no longer be edited 
as text. 

[]] If you haven't already, display the Combine menu 
and choose the Convert to Curves command. 

You may have already converted the text to curves, 
since that is required before you can manipulate the 
text with the Plane or Rolling Pin tools. 

[±] Display the Element menu and choose the Ungroup 
command. 

[]] Display the Combine menu and choose the Merge 
Elements command. The text is now merged into a 
single element that can be used as a mask element. 

NOTE: Because text characters generally contain a larger number 
of points than other elements, you may find that you can use 
only a few words in your mask. To mask longer text strings, 
break the string into several separate masks. 

Merge Elements Command 
To restore a merged 
element to its compo­
nent elements, choose 
the Split Element 
command. 
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The Merge Elements command merges selected ele­
ments together to make a single element. In this new ele­
ment, the areas where the original elements overlapped 
become hollow. 

The two main characteristics of merged elements-that a 
single element is created and that the common areas be­
come hollow-make it possible to do the following: 

o create a mask element (including text) 
o create a "window" to an element below (page 8-6) 
o create your own text characters 

Creating text characters (described on page 8-7) takes 
advantage of both features of merged elements. 
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Merge Elements Command 

In some respects, merging is the opposite of masking-a 
kind of "reverse cookie cutter." When you mask elements, 
Artline draws only the area shared by the two elements. 
When you merge elements, Artline draws everything but 
the area shared by the two elements. 

Merged elements are not the same as groups. There are 
some important differences. 

o You can use merged elements as mask elements; you 
cannot use groups as mask elements. 

o You can edit the points of a merged element with the 
Plane tool; you cannot edit the points of a group. 

o In a group, each element retains its original attributes: 
color, line width, and so on. 

In a merged element, all the elements take on the attri­
butes of the element on the top. 

o In a group, elements can sit on top of other elements. 
For example, you can put a red square on top of a blue 
circle. 

In a merged element, overlapping elements create a 
hollow area. A square inside a circle creates a circle 
with a square hole cut out of it. 

o Artline treats merged elements as a single element. 

If you select a merged element and then display Ele­
ment Info, the Element Info dialog tells you how 
many points the element has. 

If you select a group and then display Element Info, 
the Element Info dialog tells you how many elements 
the group contains. 

NOTE: You can merge as many elements as you wish, as long as the 
resulting merged element does not exceed the 255 point 
limit. 
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Merge Elements Command 
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Creating a Window 

Merged elements can create a window or border to ele­
ments underneath, a "picture frame" effect. 

To create a simple window: 

[]J Draw and align the elements you want to merge-in 
this case, a rounded rectangle and a guitar. 

[]] The merged element will take the color and line attri­
butes of the element on the top. Select one element, 
bring it to the top (if it is not already there), and as­
sign its color and line attributes. 

[]] Select the elements you want to merge, display the 
Combine menu and choose the Merge Elements 
command. The elements are now merged. 

[±] Drag the merged element on top of the background 
design, which will now appear through the circular 
picture frame. 

You can use text in your merge, although it must first be 
converted to curves and ungrouped. 
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Merge Elements Command 

To use text in a merge: 

IT] Enter the text using the Text tool and the Create Text 
Item dialog. 

[1] With the text selected, choose the Convert to 
Curves command from the Combine menu. 

[]] With the text still selected, choose the Ungroup com­
mand from the Element menu. 

[]] Select all the elements you want to merge and choose 
the Merge Elements command. 

Creating Text Characters 

This technique is nec­
essary only for letters 
with fully enclosed 
counters or bowls­
like A, B, or g. 

Merge this 

By merging a letter's outline and its interior shape-in ty­
pographical terms, the counter or the bowl-you can cre­
ate your own custom text characters. 

This method is especially useful for creating custom dis­
play characters for use in advertising, logos and letter­
heads, and presentations. Here is an example of a custom 
text character: 

. .. to create the merged 
letter. Note that the 
background shows 
through the interior of 
the letter. 

NOTE: Text characters created in this manner are actually graphic 
elements shaped like letters; they are not true text charac­
ters. You cannot enter or edit them with the Text tool. 
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Blend Command 

To restore a blend 
to its component 
elements, choose 
the Split Element 
command. 
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The Blend command creates an element where the shape 
and color of one element blend over a specified series of 
steps into the shape and color of another element. 

You can use blends for a variety of effects, including these: 

o metamorphosis-changing one object into something 
else entirely 

from guitar to star in 20 
steps, with no outline, 

over a black background 

from guitar to 
star in five steps 

even spacing of elements-horizontal, vertical, or 
diagonal 

The two rows were created by blending from one guitar to 
the other in four steps (top row) and five steps (bottom row). 

o shading effects 

o "rainbows" -blends of colors that produce the effect of 
a fountain containing more than two colors 

Creating rainbows 
is described on 
page 8-13. 
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Blend Command 

To blend elements: 

[] Select the two elements you want to blend. 

[]] Display the Combine menu and choose the Blend 
command. 

Artline displays the Blend Elements dialog. 

Blend Elenents 

# of Steps: lillill 
[] Reverse Curve Direction 

OK I I Cancel I 

[]] Type a number directly into the "# of Steps" field or 
use the pop-up slider to enter a value. The number of 
steps-which refers to the number of intermediate 
steps between the start element and the end ele­
ment-can range from one to ninety-nine. 

Turn the "Reverse Curve Direction" option on or off. 
See the description and illustrations on the next page. 

[!] Exit the Blend Elements dialog. Artline draws the 
blended element. 

NOTE: Blends always go from the element that is lower in the stack 
to the element that is higher in the stack. 

To choose a different number of blend steps: 

[] Double-click on the blended element. Artline 
redisplays the Blend Elements dialog. 

[]] Enter a new number into the "# of Steps" field. 

[]] Exit the dialog. Artline re-blends the two elements, 
using the new number of steps specified in the dialog. 
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Blend Command 

8-10 

Point Mapping 

In a blend, the points on one element are mapped to the 
points on the other element. You could draw lines from a 
point on the start element through the intermediate steps 
to the corresponding point on the end element. 

If one element has fewer points than the other, Artline 
adds points to it so that both have the same number. 
(These points are added only for blending; they go away if 
you split the blend.) 

Reverse Curve Direction 

On some elements the direction of the points from first to 
last is clockwise; on other elements the direction is coun­
terclockwise. (You can check the point direction with the 
Plane tool-see page 2-54.) If you blend from a clockwise 
element to a counterclockwise element, the result can be 
an undesirable corkscrew effect, as in the example below. 

The "Reverse Curve Direction" option solves this problem 
by treating the end element of the blend as if its points 
were arranged in the reverse direction. For example, a 
counterclockwise element is treated as ifit were a clock­
wise element, with the results shown below. 
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Blend Command 

Blending Dissimilar Elements 

Creating visually pleasing blends of dissimilar elements 
can require modification of the elements before blending. 

For example, blending a square to a letter C results in the 
effect on the left below. The desired effect is on the right. 

1IIIi~(~fE 1IIIIIm 
The exact number 
and location of points 
on text characters 
varies from one font 
to another. 

The unmodified blend does not work successfully because 
the two starting points are located in different relative po­
sitions (the arrow in the illustration below shows how the 
starting points map from one element to the other) and 
the elements have a different number of points. 

starting point - lrl-------:Ii 

Remember that the 
letter must first be 
converted to curves 
and then ungrouped. 

starting point 

To blend successfully, you must move the square's start­
ing point and, because in this case you want the points on 
the square's right side to map to the inside of the C, you 
must add points to specific locations on the square (in­
stead of letting Artline do it for you). 

-
new start/finish point ---i~--" ~~ 

II 

I~ 

-
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To modify the square: 

OJ Use the Plane tool (page 2-53) to add one point to the 
top and bottom of the square and four points to the 
right side. 

[]] Select the point on the right side nearest the upper 
right corner and split it (Split Point command­
page 2-59). 

These points will become the new start and finish 
points of the square. 

[ill Select the old start and finish points at the square's 
upper left corner and join them (Join Points com­
mand-page 2-59). 

You can now blend the square to the letter. (You 
might have to reverse the curve direction to get the 
desired effect.) 

Elements Not Allowed in Blends 

These types of elements cannot be included in blends: 

o grouped elements 
o masked elements 
o merged elements 
o fountained elements 
o text along path 

Merged elements include text characters with fully en­
closed counters-like "A" or "B" -and dotted letters like 
the lowercase "i." These characters are formed by merg­
ing a background shape with the counter or the main let­
ter body '.vith the dot. 

Colors in Blends 

The intermediate colors contained in the blend are not 
added to the current color file. Artline keeps track of the 
colors for screen display and output to a printer or file. 
See the description of the Convert to Curves command 
(page 8-18). 
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Rainbow blends are 
especially effective 
when the elements 
have no outline. 

Blend #1: 
from square 
to triangle 

Blend Command 

Creating Rainbows 

U sing the Blend command, you can create a rainbow of 
colors and shapes. The technique involves multi pIe blends 
and precise placement of elements. 

There are many ways you can create an effect like this. 
Several of Artline's commands and other features are es­
pecially useful-notably the Clone command and the use 
of the F4 key to select elements lower in the stack. 

The example above was created with six blends of twenty­
five steps each. With the exception of the squares at each 
end of the design, each element was cloned. The blend 
numbers below indicate the order of the blends in the 
stack, with the first blend on the bottom and the sixth on 
the top. 

Blend #2: 
from clone 
of triangle 
to square 

Blend #6: 
from clone of 
square to 
clone of triangle 

Blend #5: 
from clone 
of square to 
triangle 

Blend #4: 
from clone of 
triangle to 
square 

Blend #3: 
from square 
to triangle 
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Text Along Path Command 

Text Along Path Command 

To restore text along a 
path to its component 
elements, choose the 
Split Element 
command. 

The Text Along Path command fits a selected text ele­
ment to a selected path element. 

The path can be any single element, like curves drawn 
with the Quill or shapes drawn with the Circle, Rectan­
gle, or Rounded Rectangle tools. You can also use merged 
elements, but the effect can be a little odd. 

Groups or other combined elements cannot be used as 
paths. 

call it macaroni text 

path 

Text Along a Path Dialog 
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When you choose the Text Along Path command, Artline 
displays the Text Along a Path dialog. 

Te)(t Along a Path 
Te)(t Scaling 
@ None 
() Change Spacing to Fit 
() Change Size to Fit 

Options 
o Show Path 
~ Rotate Te)(t around Path 

I OK I I Cancel I 
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Text Along Path Command 

Text Scaling 

~. 

~. 

These options determine whether the text is scaled to fit 
the path element and, if so, how it is scaled. 

None 

The text is not scaled. Its point size and letter spacing 
are unchanged. If the path is shorter than the text, the 
text is cut off at the end of the path. 

Change Spacing to Fit 

The space between letters is increased or decreased to 
make the text fit the path. The text's point size is un­
changed. If the path is shorter than the text, the letters 
will overlap each other to the degree required to make the 
text fit the path. 

Change Size to Fit 

The point size of the text is increased or decreased to 
make the text fit the path. The spacing between letters 
varies according to the point size. With this option the let­
ters will not overlap each other. 

Options 

Combine Menu 

Show Path 

When this option is turned on, the path element is drawn 
along with the text element. When the option is turned 
off, the text element is drawn to the shape of the path, 
but the path element itself is not drawn. 

Show Path: Show Path: 
OFF ON 
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Text Along Path Command 
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Rotate Text Around Path 

When this option is turned on, the text orients itself to 
the curve of the path element. When the option is turned 
off, the text retains its orientation. 

text rotation: .'\:\ ;~ • 
ON ~ V 

text rotation: 
OFF 

Other Text to Path Effects 

When you combine text to a path, the text string always 
starts from the first point of the path. The illustration 
below shows text combined to a circle. 

first point ----..... _-=--_ 

If this is not the effect you seek, you can rotate the path 
element before or after you combine it with the text. 

To place inside a path, combine the text to the path as you 
would normally, and then flip the combined element. 
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Text Along Path Command 

Changing Options 

You can change the options at any time by re-displaying 
the Text Along a Path dialog. 

To change text along a path options: 

[] Select the text along a path element. 

[]J Double-click on the element. 

Artline displays the Text Along a Path dialog. 

~ Choose the options you want, and exit the dialog. Art­
line will redraw the text along a path element accord­
ing to the new options you have chosen. 

Editing Text Along a Path 

Text along a path cannot be edited directly. First you 
must split the text apart from the path and then re-open 
the Create Text Element dialog. 

To edit the text you have placed along a path: 

[]] Select the text along a path element. 

Combine Menu 

[]J Display the Combine menu and choose the Split Ele­
ment command. The text along a path element is 
split back into separate text and path elements. 

The Split Element command is described on 
page 8-20. 

~ Select the text element and double-click on it. This 
displays the Create Text Element dialog. 

[]] Edit the text and then re-combine it with the path 
element. 
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Convert to Curves Command 

Convert to Curves Command 
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The Convert to Curves command works on only two 
kinds of elements: 

o text elements and text along a path 
o blends 

Text Elements and Text Along a Path 

Convert to Curves converts a text element to a graphic 
element with the same properties as an element drawn 
with the Quill, Rectangle tool, or any of the other tools. 

Text must be converted to curves before you can: 

o use the Plane tool 
o use the Rolling Pin 
o merge text (for example, to use it as a mask element) 

Before you convert text or text along a path to curves, 
keep these facts in mind: 

o Any text element that is converted to curves-even if it 
is only a single character-is a group. 

A number of operations-merging, for one-cannot be 
done with groups. For that reason, you may still need 
to Ungroup the text after you convert it to curves. 

o Once converted to curves, text can no longer be edited 
and cannot be converted back to a text element. 

If you have created a complex or lengthy text element 
or have scaled it very precisely, double-check the text 
one last time before you convert it to curves. If you 
have made a text-entry error, you can save yourself 
from having to re-enter the entire text element. 

o Only what is visible on the screen is converted to 
curves. If the Show Path option is turned off, the path 
element is lost when text along a path is converted to 
curves. 

Artline User Reference Guide 



Blends 

five-step blend 

Combine Menu 

Convert to CUNes Command 

When a blend is converted to curves, it becomes a group 
containing the original start and end elements and the in­
termediate steps of the blend as elements. 

You can break the group and select any of its component 
elements. 

The intermediate elements take on the color and line at­
tributes of the start element. (Otherwise, all the interme­
diate color steps would be added to your picture's color 
palette, creating a potentially very large color file.) 

five-step blend 
converted to curves 
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Split Element Command 

Split Element Command 
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The Split Element command takes any of the combined 
elements-mask, merge,blend, or text along a path-and 
splits it back into its original components. 

You might split combined elements: 

o to reposition elements; 
o to use another element; 
o to change color in the elements; 
o to edit text that has been placed along a path. 

Before splitting elements, remember the following: 

o Do not split a mask, blend, or text along a path if you 
simply want to change the options you chose when you 
combined the elements in the first place. To re-display 
the Mask Elements, Blend Elements, or Text Along a 
Path dialogs, double-click on the combined element. 

o When merged elements are split, they are split into all 
their components. Keep this fact in mind when split­
ting merged elements containing text. Letters with 
fully enclosed counters-like A and O-and dotted let­
ters are actually merged elements. Splitting them 
breaks them apart entirely-for example, making two 
circles out of an O. 

o After you split a merged element, the separate ele­
ments all take on the color and line attributes of the 
merged element. The colors and line attributes the ele­
ments had before they were merged-if different from 
those of the merged element-are not restored. 
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Options Menu 

THIS chapter describes the commands in the Options menu. 
These commands allow you to set many of the characteristics of 

your Artline work environment. 

Preferences ... 
Save Preferences 

Layer Manager .. . 
Color Manager .. . 
Font Manager .. . 
Tools Mana er .. . 
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tJrererences Command 

Preferences Command 

Backup picture files 
have the extension 
$EM. 

The Preferences command displays the Global 
Preferences dialog: 

Global Preferences 
Make Backups Of Open Files With -

[8J Picture Files @ Color On 
[8J Tools Files o Color Off 
[8J Color Files o Current Settings 

Menus Redraw Speed - Double-Click -
@ Drop-Down o Qualit!J o Slow 
o Pull-Down @ Auto @ MediurIJ 

o Fast o Fast 

I OK I I Cancel I 

Make Backups Of 

The last saved version of your picture file, tools file, or 
color files can be kept as backups. Turn backups off if you 
want to save disk space. 

Picture Files 

When this check box is marked, Artline keeps a backup of 
your picture file when you choose the Save command 
from the main File menu. 

Tools Files 

Backup tools files have When this check box is marked, Artline keeps a backup of 
the extension $LS. the tools file when you choose the Save command from 

the File menu in the Tools Manager. 

Color Files 

Backup color files have When this check box is marked, Artline keeps a backup of 
the extension $OL. your color file when you choose the Save command from 

the File menu in the Color Manager. 
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Preferences Command 

Open Files With 

This setting determines whether colors are displayed 
when you open a file. 

Colors On 

When you open a file, all colors and fountains are dis­
played. This setting overrides the current setting of the 
Colors and Fountains commands in the View menu. 

Opening a file with Colors On automatically turns the 
Colors command on (if it is isn't already). 

Colors Off 

When you open a file, no colors and fountains are dis­
played. This setting overrides the current setting of the 
Colors and Fountains commands in the View Menu. 

Opening a file with Colors Off automatically turns the 
Colors command off (if it is isn't already). 

Turning colors off can speed up the display of your pic­
tures. Pictures with a lot of colors or fountains or with 
many blends can take a long time to draw with colors 
turned on. 

NOTE: There is one exception to this general rule. Some masks­
depending on their complexity-can actually take longer to 
draw with colors turned off. 

Current Settings 

When you open a file, colors and fountains are displayed 
according to the current settings of the Colors and Foun­
tains commands in the View menu. 

Menus 

Options Menu 

This option determines how you display Artline's menus, 
in the main window and in the Layer Manager, Color 
Manager, and Tools Manager. Artline's menu function­
ality is described on page 1-12. 

9-3 



Preferences Command 

Redraw speed has no 
effect on the quality of 
your printed output. 

9-4 

Redraw Speed 

This option lets you choose between how precisely and 
how fast elements are drawn on the screen. 

Quality 

Elements are drawn as well as the resolution of your 
screen will allow. 

With this setting, complex pictures can take a long time 
to draw at Full view or any wider view of the drawing sur­
face. See page 2-14 for a description of views. 

Auto 

Artline uses the Quality redraw at all views except Full 
view and any wider views, where it uses the Fast redraw. 
The Auto setting (the default) is intended to give you the 
best of the other two options-a precise redraw where the 
screen can display it and a fast redraw where the precise 
redraw would not show up well. 

Fast 

Elements are drawn as fast as possible, regardless of the 
current view. Curves might not appear smooth, but could 
appear as a series of line segments. 

Double-Click 

This option determines how fast you must press the 
mouse button for a double-click. Your selection is entirely 
a matter of personal preference. 
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Save Preferences Command 

Save Preferences Command 

Options Menu 

The Save Preferences command saves a new set of de­
faults for your next Artline work session. 

Defaults are saved in a file called ARTLINE.INI, which is 
in the same directory as the Artline program file. 

These are the defaults saved by the Save Preferences 
command: 

o all choices in the Global Preferences dialog 
o all choices in the Page Layout dialog 
o current size and position of the window 
o most recent directory paths for: 

- opening picture files (. GEM, .EPS) 
- loading image files (.IMG, .PCX, .TIF) 
- PostScript file output 
- loading fonts 
- loading color files 
- loading tools files 

o current state of rulers and status line 
o current state of grid and grid snap 
o current position and state of guide lines 
o PostScript output parameters 
o image options: 

- foreground and background colors 
- pattern 
- scaling 
- image offsets 

o current set of fonts and their attributes-
ResidentlDownloadlVector 

o current toolbox configuration 

The next time you start Artline, all these defaults will be 
in effect. 
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Layer Manager Command 

Restoring the Original Defaults 

When you first install it, Artline already has a "default 
set" of defaults. 

If you have saved preferences and then want to restore 
the original set of defaults, you have two options: 

o If you do not mind losing the defaults you have saved, 
delete the file ARTLINE.INI. 

o If you do not want to lose the defaults you have saved, 
rename ARTLINE.INI to something like ARTINI.SAV 
or ARTLINE.INX. 

In either case, Artline will create a new ARTLINE.INI the 
next time you start the program. 

Layer Manager Command 

The Layer Manager command displays the Layer Man­
ager so you can add or modify layers or set their attri­
butes. 

Layers are described fully in Chapter 10. 

Color Manager Command 
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The Color Manager command displays the Color Man­
ager so you can add or modify colors and fountains, load 
or modify color files. 

Color management is described fully in Chapter 12. 
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Font Manager 

Font Manager 

The Font Manager command displays the Font 
Manager. 

Font Manager 
T~pefaces 't -Advantage Bold 
[~£~~m~~I~I\1~~1 talic 
Advantage Italic 
Booker De(IJi 
Booker De(IJi Italic 

... 
Attributes - IRe(IJove T~~eface I o Resident 
o Download IAdd T~~eface ... I 
@ Uector 

I I OK I Cancel I 

Typefaces 

This window lists the typefaces that are currently avail­
able. The names that appear in this list are the same as 
those appearing in the pop-up menu in the Create Text 
Element dialog. 

You can select a typeface from the list, either to set attri­
butes or to remove it from the list. 

To select a typeface: 

Options Menu 

[]] Scroll the window (if necessary) to bring the name 
into the window. 

[]] Click on the typeface's name. Artline highlights the 
name to indicate that it is selected. 
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Font Manager 

Attributes 

These options apply 
only as long as text re­
mains true text. Once 
converted to curves, 
text becomes a purely 
graphical element. 

In Artline's default setup, your printer receives text char­
acters as patterns of lines and curves. Although you can 
still edit the text, from the printer's point of view the char­
acters are no different from elements drawn with the 
Quill or other tools. 

Text characters can, however, be very complicated pat­
terns, and pictures that contain a great deal of text can 
take a long time to print. 

If you have a PostScript printer, the Attributes options 
can increase the speed with which text is printed. Note, 
however, that the attributes are available only when 
printing with Artline's PostScript command and not 
with the Output program. 

To set attributes, select a font name from the list and 
then click on one of the Attributes buttons. 

Resident 

PostScript printers have a set of resident fonts, for which 
all the information necessary to draw the characters is al­
ready in the printer. These fonts are often identified in a 
startup sheet that is printed when you first turn on the 
printer. Artline's names for the PostScript resident fonts 
are listed in Appendix A. 

To increase printing speed, set the attribute of each of the 
resident fonts to Resident. When you print, Artline tells 
the printer what characters it wants, and the printer 
draws them from the resident set. 

NOTE: In many PostScript printers the resident Courier font can­
not reproduce the fill or style attributes you can set in 
Artline. Instead, the characters appear as thin lines. Test 
your printer by sending it the same Courier text, once with 
the font set to Resident and again with it set to Vector. If the 
resident Courier does not print correctly, leave Courier set 
to Vector. 
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Options Menu 

Font Manager 

Download 

The Download option makes your PostScript printer pro­
cess non-resident fonts as if they were resident. When 
PostScript output is started, the font information is sent 
to the printer (downloaded) with each picture and is kept 
in the printer's memory. 

The entire font is downloaded-all characters, not just the 
characters you are using in your picture. For that reason, 
downloading is most effective for pictures that contain a 
lot of text in a few non-resident fonts. 

In some cases, downloading can increase printing time: 

D if t4e picture contains only a few characters in each 
non-resident font; 

In this case, downloading the fonts could take longer 
than actually printing the picture. 

D if the printer does not have enough memory for both 
the downloaded fonts and the picture. 

Vector 

Vector is the default attribute for all fonts. Characters 
are sent to the printer as lines and curves. 

If you have a non-PostScript printer, all text is treated as 
Vector, regardless of the attributes set in this dialog. 

If you have a PostScript printer, leave the attribute for 
non-resident fonts as Vector if: 

D the picture contains only a few text characters; 

D the picture contains a lot of text, but it is in several 
different fonts and only a few characters in each font 
are used. 
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Tools Manager Command 

Remove Typeface 

This button removes the selected font from the typeface 
list. 

The font file (the file with the .AF4 extension) is not de­
leted from your disk, so you can always restore the name 
to the list at a later time. 

You can remove typefaces if memory or disk space are be­
coming limited or if you simply want a shorter list of fonts 
in the Create Text Item dialog. 

Add Typeface 

This button displays the Item Selector so you can add a 
font name to the list. 

There are two things to remember when adding fonts: 

o All fonts must be in the Artline .AF4 format. You can­
not add ~AFF fonts from GEM Artline (Release 1.0). 

o Fonts must all be in your designated font directory. If 
you try to add a font from another directory, Artline dis­
plays an alert asking if you want the font file copied to 
your fonts directory. Click on OK if you want to add the 
font to the list. 

Tools Manager Command 
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The Tools Manager command displays the Tools Man­
ager so you can create your own custom toolbox. 

The Tools Manager is described fully in Chapter 13. 
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Layers 

P ICTURES can be created in layers, as if they were made up of 
transparent sheets laid on top of each other. 

~---Iayer 

~---Iayer 

elements in stack ----+ 
on bottom layer ~+-=:::±:::::£: ~---Iayer 

Layers make complex pictures manageable and give you 
an extra measure of protection. 

o You control which layers are visible. The entire pic­
ture does not always have to be on the screen. 

o The work you do in one layer-adding or deleting ele­
ments, changing colors, drawing new elements-has 
no effect on elements in other layers. 

The elements in each layer exist in a stack. See the dis­
cussion of stacks and layers, "Selecting Overlapping Ele­
ments," in Chapter 2. 
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Layer Tool and Layer Manager 

Limits on Layers 

There is no limit on the number of layers you can create­
except for the limitations imposed by your computer's 
memory and available disk space. 

Layer Tool and Layer Manager 
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The Layer tool (described in Chapter 2) has two functions: 

o activating layers 
o adding new layers 

The Layer Manager can also be used to activate or add 
layers, but it has these additional functions: 

o changing layer order 
o modifying layers 
o removing layers 
o deciding which layers will be displayed 

Displaying the Layer Manager 

To display the Layer Manager: 

close box-+ 

Choose the Layer Manager command from the Options 
Menu. 

The Layer Manager window contains these parts: 

menu bar -+ I--'o:~--=~:..;.=-...:..:.::..:.=-r..::=---I 

layer list -+ -*- Default La er 
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The Layer Manager 
initially appears in the 
middle of the work­
space. Moving the 
Layer Manager gives 
you a relatively unob­
structed view of the 
drawing surface. 

Layer Tool and Layer Manager 

To move the Layer Manager: 
Drag the Layer Manager's title bar. 

Each time you choose the Layer Manager command in 
the current work session, the Layer Manager appears . 
where you last left it. At the beginning of your next Art­
line work session, the Layer Manager will again appear 
in its default location, the middle of the workspace. 

To remove the Layer Manager from the workspace: 

Click on the Layer Manager's close box or choose the 
Close command from the Layer Manager's File menu. 

Layer List 

The layer list identifies the layers in the current picture. 

The layers are listed in order from bottom to top-the 
first layer in the list is the bottom layer; the last layer in 
the list is the top layer. 

If your picture has more layers than fit the list, use the 
arrows, scroll bar, or slider to scroll the list. 

Activating Layers 

You can also activate 
layers with the PgUp 
and PgDn keys. 

Layers 

To work in a given layer of your picture, you must first 
make that layer the active layer. The active layer is iden­
tified in the main title bar above the workspace. 

o If you activate a layer with the Layer tool, Artline auto­
matically updates the screen. 

o If you activate a layer with the Layer Manager, the 
screen update depends on the state of the Auto Re­
draw and Redraw commands (page 10-20). 

To activate a layer with the Layer tool: 
[] Click on the Layer tool to display the pop-up list of 

the names of the layers in the current file. 

r]] Click on the name of the layer you want to activate. 
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Layer Tool and Layer Manager 

To activate a layer with the Layer Manager: 

[]] Open the Layer Manager by choosing the Layer 
Manager command from the Options Menu. 

[]] Click on the layer's name in the layer list. 

You cannot work on your picture while the Layer Man­
ager is open. For that reason, if you simply want to acti­
vate a layer, use the Layer tool. 

However, if you want to activate a layer and do something 
else related to layers-for example, add a layer and mod­
ify an existing layer-use the Layer Manager. 

Adding Layers 

The new layer is 
automatically the 
active layer. 
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When you start a new picture in Artline, there is one 
layer, called the default layer. You can add new layers 
with the Layer tool or the Layer Manager. 

To add a layer with the Layer tool: 

[]J Click on the Layer tool to display the layer pop-up. 

[]] Click on the New Layer option. Artline displays the 
Add Layer dialog. 

Add Layer 

Layer NaPle 1'~i'14. 
[] Background Layer 

Link To I None 

OK I I Cancel I 

[]] Enter a name for the new layer into the dialog. 

The other options in the dialog-Background Layer 
and Link To-are for creating slides. See page 10-8. 

ITl Exit the Add Layer dialog. 
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Layers 

Layer Tool and Layer Manager 

To add a layer with the Layer Manager: 

[!] Display the Options menu and choose the Layer 
Manager command. 

[]] Display the Layer Manager's Edit menu and choose 
the Add Layer command. The Add Layer dialog ap­
pears on top of the Layer Window. 

QJ Enter a name for the new layer into the dialog. 

The other options in the dialog are for creating slides. 
See page 10-8. 

[}] Exit the Add Layer dialog. 

~ When you have added all the layers you want, click 
on the Layer Manager's close box or choose the Close 
command from the Edit menu. 

NOTE: Merging a file into your picture also adds at least one new 
layer. See the description of the Merge File command 
(page 3-4). 

Changing Layer Order 

Using the Layer Manager, you can change the order of 
the layers on the drawing surface. 

To change layer order: 

[!] Open the Layer Manager. 

[]] In the layer list, drag the layer's name to the position 
you want. 

[]] Close the Layer Manager. 
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Layer Tool and Layer Manager 
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Copying and Moving Elements Between Layers 

Elements can be copied or moved from one layer to other 
layers. 

To copy elements from one layer to another: 

OJ Use the Layer tool to activate the layer containing 
the elements you want to copy. 

[]J Select the elements. 

[]J Display the Edit menu and choose the Copy com­
mand. 

[}] Use the Layer tool to activate the layer to which you 
want to copy the elements. 

[]] Display the Edit menu and choose the Paste com­
mand. 

To move elements from one layer to another: 

OJ Use the Layer tool to activate the layer containing 
the elements you want to move. 

[]J Select the elements. 

[]J Display the Edit menu and choose the Cut command. 

[}] Use the Layer tool to activate the layer on which you 
want to place the elements. 

[]] Display the Edit menu and choose the Paste com-
mand. 

You can use these steps to copy or move single elements, 
multiply selected or grouped elements, or even the entire 
contents of a layer. 

Combining Elements into a Single Layer 

You may find that you want to convert a multi-layer pic­
ture to a single-layer picture-in other words, to combine 
all the elements from all the layers into a single layer. 
You can do it, using the Merge File command from the 
File menu. 
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Layers 

Layer Tool and Layer Manager 

To combine elements into a single layer: 

[]] Save your picture. (This is a good practice to observe 
before any such changes.) 

[]] Display the File menu and choose the New command 
to clear the drawing surface. 

[]] Display the File menu and choose the Merge File 
command. Artline displays the Item Selector. 

[]] Select the file you want to combine to a single layer. 

[]] Artline displays this alert: 

Merging ~ultiple-Iayer file. 
Merge to separate layers in the current 
file or co~bine to a single layer? 

[ill Click on the Combine button. 

Layers 

(o~bine 

The file is merged into a single layer in the current 
picture. 

[1] Save the new picture. 

[]] The new picture has two layers, a default layer with 
nothing in it, and the new layer containing the pic­
ture you just merged. The new layer's name is the 
name of the file you merged. 

If you want the new picture to have only one layer, 
use the Layer Manager to remove the default layer. 
See page 10-14. 
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Slides 

Slides 

10-8 

Slides are pairs of layers-a foreground and a back­
ground-that are displayed together. You can combine 
many slides to create an entire slide presentation in a 
single file. 

You can display slides on the screen with the Layer 
Manager's Slides command (page 10-19), export slides to 
files (page 3-7), or produce PostScript output of your 
slides (page 3-13). 

Creating Slides 

A slide is created when one layer is designated a back­
ground layer and another layer-the foreground layer-is 
linked to it. You can create slides when you add new lay­
ers or with existing layers. 

To designate a layer as a background layer: 

o If you are adding the layer, click on the Background 
Layer check box in the Add Layer dialog. 

o If the layer already exists: 

-1 Open the Layer Manager. 

-2 Select the layer's name in the layer list. 

-3 Display the Edit menu and choose the Modify 
Layer command. 

-4 In the Modify Layer dialog, click on the Back­
ground Layer check box. 

Modify layer 

lalJer NaJlle 

~ Background lalJer 

OK I I Cancel I 
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Layers 

Slides 

To link a layer to a background: 

o If you are adding the layer, display the Link To menu 
in the Add Layer dialog. Choose the name of the layer 
you want as the background of the new layer. 

Layer Nalile 

Link To 

Add La er 

Iblues lead __ I 
[J Background Layer 

o If the layer already exists: 

-1 Open the Layer Manager. 

-2 Select the layer's name in the layer list. 

-3 Display the Edit menu and choose the Modify 
Layer command. 

-4 In the Modify Layer dialog, display the Link To 
menu. Choose the name of the layer you want as 
the background of this layer. 

NOTE: You can link more than one layer to a single background. A 
typical background layer contains all elements that are 
found in every slide, and the foreground layers contain the 
elements that are unique to each individual slide. See the 
example on the next page. 
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Slides 

SPECIAL REPOIlr: 

From Bebop 
toHeavyMeta1· 

wt..DIdW.001V'tl:lnf? 

July 1990 

The Fine 
(and Difficult) 

Art of the Concert 
.. Steel String 
Guitar 

This background ... . .. and these two foregrounds ... 

.. . combine as slides to create these two magazine covers. 

This magazine is entirely fictitious and any resemblance to a real publication is unintentional. 
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Layers 

Slides 

Printing Slides 

To print slides, you have these options: 

o If you have a PostScript printer, you can print the 
slides directly to it. Choose the PostScript command 
(page 3-13) and set the Separation Options to "Slides." 

o If you do not have a PostScript printer, you can export 
the slides to files that can be printed. Choose the Ex­
port command (page 3-7) and set the Export Mode to 
"Slides." Then choose either of these File Type options: 

- Multiple .GEM Files 

This option creates a separate file for each slide. 
You can print these files, and you can open them in 
Artline or include them in files created with pro­
grams that use .GEM files, like Presentation Team 
and Xerox Ventura Publisher. 

When exporting to multiple .GEM files, the 
filename you specify cannot be more than five char­
acters long. Artline uses the remaining three char­
acters for automatic numbering of the files-for 
example, SLIDEOOO.GEM, SLIDEOO1.GEM, and 
SLIDE002.GEM. 

- Multiple-Page .GMP File 

This option creates a single file with a separate 
page for each slide. Using the Output program, you 
can print your slides from this file. You cannot open 
a .GMP file in Artline or use it with other programs. 

CAUTION: The disk space occupied by multiple .GEM files is usually 
more than the space occupied by a single .GMP file. 
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Slides 
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Slide Shows on the Screen 

Using Artline, you can create "slide shows" for display on 
the screen. These can be especially effective on some of 
the large-screen high-resolution monitors available today. 

To create a slide show: 

[] Create the slides in Artline. 

[]] Export the slides to a .GMP file or to .GEM files. 

In most instances, it is easiest to export the slides to 
a .GMP file. You need only a single file in your out­
put list, and the Screen Preferences apply to the 
pages of the .GMP file just as they do to the separate 
.GEM files. 

[]] Start the Output program (To Output command). 

[] In Output, add the .GMP file or .GEM files to the out­
put list, set your Screen Preferences, and start output 
to the screen. 

If you are creating slides exclusively for screen output, 
make sure they conform to the screen's orientation (Por­
trait or Landscape). For most standard monitors, use 
Landscape orientation; for vertically oriented full-page 
monitors, use Portrait orientation. 
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Layer Manager Command Reference 

Layer Manager Command Reference 

Edit Menu 

The next two sections describe the commands in the 
Layer Manager's two menus. 

Note that the Layer Manager menus list keyboard com­
mand equivalents. When the Layer Manager is open, 
these keyboard commands are activated, and the key­
board commands in Artline's main menus are inactive. 

This section describes the commands in the Layer 
Manager's Edit menu. Note the keyboard command 
equivalents for the first three commands . 

• illl ... 

Add Layer... .A 
Modify Layer ...• M 
Renove Layer .D 

~********************~ 

Close 

Add Layer Command 

Layers 

The Add Layer command displays the Add Layer dialog. 
Use the dialog to add a new layer to your picture. 

Layer Name 

Each layer must have a name. Enter a name in this field 
or accept the name supplied. 

Background Layer 

Click on this check box if you want the new layer to be a 
background layer for slides. Slides are described on page 
10-8. 
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EdifMenu 

Link To 

This option makes the layer a slide foreground. Select a 
name from this pop-up menu to link the new layer to an 
existing background layer. You cannot link a foreground 
until you have created at least one background layer. 

Modify Layer Command 

You can also display 
the Modify Layer dialog 
by double-clicking on 
the layer's name in the 
list. 

The Modify Layer command displays the Modify Layer 
dialog so you can change the name of the current (active) 
layer or change its slide attributes. The Modify Layer dia­
log is identical to the Add Layer dialog. 

You can use the Modify Layer command to give your lay­
ers unique names when you merge a file into your pic­
ture, resulting in layers with duplicate names. See the 
description of the Merge File command (page 3-4). 

Remove Layer Command 
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The Remove Layer command removes the current layer 
from your picture. If the layer contains elements, Artline 
displays an alert warning you that the elements will also 
be deleted from the picture. 

Removed layers are not placed in your computer's mem­
ory or on the Clipboard. For that reason, once a layer is 
removed, it cannot be restored except by being recon­
structed from scratch. 

Close Command 

The Close command closes the Layer Manager. You can 
also close the Layer Manager by clicking on the close box 
at the left end of the title bar. 
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Display Menu 

Display Menu 

Layers 

This section describes the commands in the Layer 
Manager's Display menu . 

... Active +C 
Uisible +U 
All +L 
Slides+S 

~~~-@@--@@@@-~@-~ 

Redraw +R 
Auto Redraw +U 

The menu's first four commands give you control over 
how layers are displayed on the screen; your current 
choice is indicated with a marker. These display choices 
remain in effect after you have closed the Layer Manager. 
(The screen display commands have no effect on printed 
output other than PostScript EPSF. Printing of layers is 
controlled by the Export and PostScript commands de­
scribed in Chapter 3.) 

The menu's last two commands control the redraw of lay­
ers while the Layer Manager is open. 

Display Status 

The current display status of the Layer Manager (Active, 
Visible, All, or Slides) is saved with the file. For example, 
a file that is saved in Slides mode will automatically be in 
Slides mode the next time you open it. 
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Display Menu 

Display Markers: Circles and Light Bulbs 

Active layer. It will be 
displayed. 

This layer will also be 
displayed. 

To the left of each layer name is a display marker, either 
a circle or a "light bulb." These markers indicate whether 
the layer will be displayed in the current display mode. 

o The light bulb marker indicates that the layer will be 
displayed. The active layer is marked with a light bulb 
in all display modes. 

o The empty circle indicates that the layer will not be dis­
played. 

.*. cover tel'11 late 
~ blues lead . *. concert steel 

This layer will not 
be displayed . 

If Auto Redraw in the Layer Manager is turned off, 
changes in the display status of layers will not be re­
flected until you choose the Redraw command or until 
you close the Layer Manager. Auto Redraw is described 
on page 10-20. 

All Command 
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The All command displays all the layers in the picture. 

Active Command 

The Active command displays only the active layer. Re­
gardless of the number of layers in your picture, you see 
only one layer at a time. 
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Display Menu 

Visible Command 

You can only set or 
change the visibility of 
layers in Visible mode. 

The Visible command switches the Layer Manager into a 
special mode in which the only layers that are displayed 
are the active layer and any other layers that are specific­
ally designated as Visible. This option makes it possible 
for you to: 

o display a selection of the layers in your picture; 
o view the layers in your picture as a series of overlays; 
o print a selection of layers, using the Visible option in 

the Export command. 

To set a layer's visibility: 

OJ Open the Layer Manager. 

[]] (Optional) For greater convenience, turn off Auto 
Redraw in the Display menu, if it is on. The Auto 
Redraw command is described on page 10-20. 

[]J Choose the Visible command from the Display menu 
and look at the display markers next to each layer 
name. 

[]] Click on the display marker for each layer whose visi­
bility status you want to change. 

[§] To set the visibility status of the current active layer, 
you must first de-activate it by clicking on one of the 
other names in the layer list. This gives you a clear 
view of the display marker. 
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Display Menu 
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Displaying Selected Layers 

You can use the Visible setting to display a selection of 
the layers in your picture. This can be useful when you 
want to see how various layers look in combination with 
each other. 

To display selected layers: 

[I] Open the Layer Manager. 

[]] Switch the Layer Manager to Visible mode. 

[]] Turn on the display markers for the layers you want 
visible. Turn off the display markers for any layers 
you do not want visible. 

By moving the Layer Manager to one side of the screen, 
you can continue to view layers without closing the Layer 
Manager each time you change a layer's display status. 

Using Layers as Overlays 

Using the Visible command, you can "build up" your pic­
ture layer by layer, as if you were putting down a series of 
overlays. You can start by looking at the bottom layer, 
then add a layer, another layer, and so on. 

To view layers as overlays: 

[I] Open the Layer Manager. 

[]] Turn on Auto Redraw (if it is not already on). 

[]] This process can only be done while the Layer Man­
ager is open, so move it off to one side of the screen so 
that it blocks your view of the workspace as little as 
possible. Make sure the layer list is still accessible. 

[}] Choose Visible from the Display menu. 

[]] Activate the bottom layer (the first name in the list). 
The bottom layer will remain the active layer 
throughout all these steps. 
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Layers 

Display Menu 

[ill Start by making sure that the display markers are 
turned off for other layers. At first you should see 
only the bottom layer. 

[1] Make the second layer Visible by clicking on its dis­
play marker. You now see the first two layers. 

~ Make the third layer Visible. You now see the first 
three layers together. 

[ill Continue making layers Visible, one by one, until you 
see the complete picture. 

Slides Command 

The Slides command displays slides (page 10-8). When 
the Slides option is marked, activating layers (either 
with the Layer tool or from within the Layer Manager) 
has this effect: 

o If the layer you activate is the foreground of a slide, 
the entire slide-foreground and background-is dis­
played. 

o If the layer you activate is not the foreground of a 
slide, the layer is displayed by itself. In this case, the 
Slides command has the same effect as the Active 
command. 
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Display Menu 
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Auto Redraw Command 

The Auto Redraw command is a toggle. Auto Redraw is 
either on (as indicated by a marker in the menu) or off. 

Auto Redraw determines whether Artline redraws (up­
dates) the screen when you make changes in the Layer 
Manager. 

o When Auto Redraw is on, Artline redraws the screen 
every time you do something that changes what is dis­
played on the screen-like activating a layer or chang­
ing layer order. 

o When Auto Redraw is off, the screen is redrawn only 
when you choose the Redraw command. Turning off 
Auto Redraw is useful when you are doing something 
that involves several steps, and you do not want the 
screen to redraw after each step. 

The state of Auto Redraw has no effect when the Layer 
Manager is closed; the screen is always redrawn when 
changes wan'ant it. 

Redraw Command 

The Redraw command redraws the screen when Auto 
Redraw is turned off. 

The Redraw command is only available when Auto Re­
draw is turned off and only when you have done some­
thing that would change the way layers are displayed on 
the screen. 
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Image Tracing 

TRACING is a technique in which you use the Trace tool or Quill 
(or other tools) to create Artline pictures from bit-image files, typ­

ically created by scanning programs and paint programs. 

Image Files and Vector Files 

Image files are made up of individual dots called pixels. 
Some image files can be very detailed-scanned images of 
photographs, for example-but these image files can be 
extremely large, requiring a lot of memory to load and a 
lot of disk space to store. 

Artline's files are called vector (or "object") files. Ele­
ments are stored as complete objects, rather than as a pat­
tern of dots. An element drawn in Artline can be moved 
or rotated, can have its size or color changed, and other 
elements in the picture are not affected. 

Tracing creates a vector "replica" of the bit-image origi­
nal, making available all of Artline's editing capabilities 
and enabling you to take advantage of the full resolution 
of your output device. 
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Autotracing and Hand Tracing 

Aufotracing and Hand Tracing 

Autotracing and hand 
tracing are not mutu­
ally exclusive. You 
might autotrace one 
part of an image and 
trace another part of 
the same image by 
hand. 

There are two ways you can trace an image: 

o interactive autotracing 
o hand tracing 

Interactive Autotracing 

Using the Trace tool, you can make Artline trace an 
image, setting anchor points and drawing curves and 
lines automatically. Autotracing is interactive because 
you can stop the autotrace at any time and then: 

o change the tracing precision; 
o retrace the entire image; 
o use different tracing precisions for different parts of 

the same tracing line. 

Hand Tracing 

You can trace an image by hand, using the Quill, Sketch 
tool, or other drawing tools to draw all the lines and 
curves. When tracing with the Quill, you choose where to 
place anchor points and where to drag tangent lines. 

Loading Images 

The image does not 
become part of your 
Artline file. It is simply 
there as a guide for 
tracing. 
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Before you can trace an image, you must load it, to make 
it visible on the screen. The image is "under" the drawing 
surface, as if you had placed a picture under a piece of 
tracing paper. 

Images can be loaded for tracing in any of three formats: 

o IMG (file extension .IMG) 
o PCX (file extension .PCX) 
o TIFF (file extension. TIF) 

Images in other formats can be converted to IMG, PCX, or 
TIFF with several conversion utilities. 
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Loading Images 

To load an image: 
If an image is already 
loaded, it is replaced. 
No alert is displayed. 

Choose the Load Image command from the Image menu. 
Artline displays the Item Selector so you can select the 
image file. 

Selecting files with the Item Selector is described in 
Chapter 1. 

Image Frame 

Image Tracing 

When an image is loaded into Artline, it is contained 
within an invisible rectangle called the image frame. 
(To see the extent of the image frame, set the image 
background to a color other than white. See page 11-5.) 

image frame 
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Image Options 

Image Options 
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After loading an image, you can set these image options: 

o image color and fill pattern 
o background color 
o image scaling 
o position of the image on the drawing surface 

To set image options: 

Choose the Image Options command from the Image 
menu. Artline displays the Image Options dialog. 

Irila e 0 tions 
Colors & Patterns 
Irilage ~I Background I~I 

Pattern ~I 

Scaling 
@ Uniforrll o Non-Uniforrll 

Horizontal \1111111 % 

Offsets 
Horizontal [!;][J inch 

[!;][J 
OK 

Vertical inch 
I Cancel I 

Color & Patterns 

These options set the color and pattern of the image and 
the color of the image background. 

Image 

This menu contains a list of colors that can be assigned to 
the image. The initial default color is black. 

The set of colors that appears in the menu is always the 
same; it is independent of the currently loaded color file. 
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Image Options 

Pattern 

This menu contains a list of patterns that can be assigned 
to the image. The initial default is a solid pattern. 

The patterns are for your convenience, as it is sometimes 
hard to see the line as it traces around a solid pattern. 
The patterns do not affect tracing precision in any way. 

Background 

The background is the part of the area contained within 
the image frame that has no image pixels. In the illustra­
tion on page 11-3, the background is the shaded area. 

The Background menu contains the same colors as the 
Image menu. The initial default is a white background. 

Scaling 

Image Tracing 

To make the image the most convenient size for tracing, 
you can scale it larger or smaller. 

Uniform 

In Uniform scaling, a single percentage (ranging from 1% 
to 999%) is applied to the image's width and height. The 
image cannot be distorted. 

Non-Uniform 

In Non-Uniform scaling, two fields are available: Horizon­
tal and Vertical. The image's width (Horizontal) and 
height (Vertical) can be scaled separately, and the image 
can be distorted. 

Scaling -------------, 

o UniforM @ Non-UnifOrM 

Horizontal IIUUII % Uertical 11BB 1 % 
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Image Options 

Offsets 

By default, an image appears at the upper left corner of 
the drawing surface. Using the Offsets fields, you can 
move the image to a specific location on the drawing sur­
face. The unit of measure in both fields is taken from the 
current setting in the Page Layout dialog (page 3-10). 

Horizontal 

This setting moves the image the specified distance from 
the left edge of the drawing surface. 

Vertical 

This setting moves the image the specified distance down 
from the top edge of the drawing surface. 

Saving Image Options 

For accurate tracing, 
Scaling and Offsets 
values must be exactly 
the same each time 
you load the image. 
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The current settings in the Image Options dialog are 
saved as defaults when you choose the Save Prefer­
ences command. See page 9-5. 

If you do not want to save the options as defaults, but still 
want the information available the next time you open 
the file, use the Text tool to enter the options in an open 
part of the drawing surface. (Text with hollow fill draws 
most quickly.) Save this text with the picture, use the val­
ues for reference each time you load the image, and delete 
the text when you no longer need the information. 
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Autotracing 

Autotracing 

Autotracing is a fast and easy way of creating Artline ele­
ments from scanned images or other image files. 

Typical steps for autotracing an image are: 

OJ Load the image. (See page 11-2.) 

[1] Set image options. (See page 11-4.) 

[]] Set the Tracing Options. 

[±] Select the Trace tool and begin tracing. 

[]] Ifnecessary, use the Plane tool to fine-tune the final 
picture. 

Tracing Options 

Image Tracing 

Before you begin auto tracing, set the options that deter­
mine how Artline will trace the image: 

o image type 
o gray levels (grayscale images only) 
o gap size 
o timing 
o precision 
o contrast 

To set tracing options, double-click on the Trace tool. Art­
line displays the Tracing Options dialog: 

Tracing Options 
IlIIage 

Type o 6rayscale @ Line Art 

6ap Size @ ••••••• 0 ··V·· 0 ··CI· 0 .~. 

Tillling CI1 illS 

Precision 1"1111 
I OK I I Cancel I 
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Autotracing 

Image 

A grayscale image 
should not be confused 
with a halftone image 
like a photograph. 

The Precision setting 
also affects how 
closely the image is 
traced. 

original image 
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This setting describes the kind of image you are tracing. 

Grayscale 

The image consists of areas of even shades of gray. 

When you select Grayscale, two additional options-Gray 
Levels and Contrast-become available. See "Tracing 
Grayscale Images" on page 11-14. 

Line Art 

The image contains only solid areas of black and white. 

Gray Levels 

This menu is available only when Grayscale has been se­
lected for the Image Type. See "Tracing Grayscale Im­
ages" on page 11-14. 

Gap Size 

The gap size determines how closely autotrace follows any 
little "pits" and gaps in the outline of the image. The set­
tings range from zero pixels to three pixels. 

A gap size of zero causes autotrace to follow the outline 
closely (see the tracing on the left below). Increasing the 
gap size produces a smoother outline by causing autotrace 
to jump over irregularities in the scanned image. The 
tracing on the right was made at a gap size of three pixels. 

Gap Size @ ...... . Gap Size @ .'l.....)'. 

When your image contains blocks of pixels that are close 
to each other, a small gap size can prevent the trace line 
from jumping from one block of pixels to the other. 
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Autotracing 

Timing 

An autotracing is a series of connected lines or curve seg­
ments. The Timing setting (measured in milliseconds) 
determines how long autotrace waits before starting the 
next curve segment. 

In its default timing (0 ms), autotrace is continuous. In­
creasing the timing increases the amount of time required 
to trace the image, but it also allows you to stop the au­
totrace precisely where you want to stop it. 

Precision 

This percentage determines how closely autotrace follows 
the outline of the image. A Precision of 50% or 60% is 
often sufficient. 

A lower percentage results in smoother curves with fewer 
anchor points. The tracing follows the general outline of 
the image. 

A higher percentage produces a more exact tracing of the 
image, but also results in more anchor points. High Preci­
sion tracing (especially with the Gap Size set to zero) 
often follows all the irregularities of the edges of scanned 
images, producing an outline that is needlessy "fussy." 

Contrast 

This option is available only when Grayscale has been se­
lected for the Image Type. 

See "Gray Levels" (page 11-15). 

Autotrace Direction 

Image Tracing 

The line drawn by the Trace tool always leaves the image 
to its right. 

o If you are tracing the outside of the image, the line 
moves clockwise. 

o If you are tracing inside an image, the tracing line 
moves counterclockwise. 
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Autotracing 

Autotracing Techniques 
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This section describes how you trace entirely around the 
outside or inside of an image. The next section describes 
how you trace a specified part of an image. 

To autotrace, set tracing options and then: 

[]] Select the Trace tool in the toolbox. 

[]] Start the autotrace by clicking next to the image. 

If you click too far from the image, Artline displays 
the "Cannot find tracing image" alert. 

Cannot find tracing inage. ~ 
Click closer to the outline 
of the inage or change the 
6ra~scale tracing values. 

If you click outside the image frame, Artline displays 
this alert: 

Cannot find tracing inage. ~ 
Click inside the inage frane J 

close to the outline of the 
inage ~ou want to trace. 

[]] When the image is traced, Artline displays the Pre­
view Curve dialog. (See page 11-12.) 

If the autotrace reaches the point limit before finish­
ing the tracing, Artline displays the alert shown 
below and then the Preview Curve dialog. 

The outline of this inage is too long [JQB:] 
or too conplex to trace in a single 
step. Tr~ tracing the inage in segnents 
or at a lower precision. 
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Autotracing 

Trace Segments 

A trace segment is a partial tracing of the image, where 
you set both the starting and finishing points. 

To set a trace segment: 

[] Select the Trace tool. 

Image Tracing 

[]] Drag a line from the trace segment's starting point to 
its end point. Place the end point next to the image. 

traced segment 

- If you place the end point inside the image frame 
(page 11-3) but not next to the image, the image 
will be traced completely or until the point limit is 
reached. 

- If you place the end point outside the image frame, 
this alert is displayed: 

Cannot trace segnent. ~ 
The selected end point lies outside 
the inage frane. Drag a new tracing 
segnent line and place the end point 
next to the inage. 

[]] When the segment is finished, the Preview Curve dia­
log is displayed. (See page 11-12.) 
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Autotracing 
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Stopping Autotrace 

You can stop the Trace tool at any time by pressing the 
spacebar. Artline then displays the Preview Curve dialog. 
(See page 11-12.) 

Preview Curve Dialog 

Artline displays the Preview Curve dialog when: 

D the image is fully traced; 
D the point limit is reached; 
D you stop the tracing. 

The dialog has three exit buttons. The second and third 
are always OK and Cancel. The first varies according to 
the circumstances in which the dialog was displayed. 

D If the dialog was displayed because the image has been 
completely traced or because the point limit was 
reached, the first exit button says "Retrace." 

If you click on the Retrace button, the image is 
retraced from the beginning. 

o If the dialog was displayed because you stopped the au­
totrace by pressing the spacebar, the first exit button 
says "Go On." 

If you click on the Go On button, the tracing continues 
from the point at which it left off. 

The Preview Curve dialog gives you these options: 

D You can accept the tracing. 
D You can change precision and retrace. 
D You can trace part of the image at a different precision. 
D You can delete tracing points and then continue. 
D You can -cancel the tracing. 
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Pressing the right­
arrow or the Tab key 
advances the tracing 
one anchor point at a 
time. 

Image Tracing 

Autotracing 

Accepting the Tracing 

If the tracing is satisfactory as it is, click on OK or press ...1. 

Changing Precision and Retracing 

To change the tracing precision, click on the dialog's 
arrow buttons: left-arrow to lower the precision or right­
arrow to raise the precision. 

If you hold the mouse button down over the arrow, the set­
ting changes continuously until it reaches zero or 100%. 

Click on the Retrace button to retrace the image. 

If the Preview Curve dialog was displayed because the 
tracing reached the point limit, you can use the Preview 
Curve dialog to lower the precision and then retrace. 

Tracing Part of the Image at a Different Precision 

By stopping the tracing before it is finished, you can trace 
a continuous line at varying levels of precision. For exam­
ple, you might start tracing at 80%, change to 40% for a 
region where you want to follow only the general outline 
of the image, and then conclude at 100%. 

To stop the tracing and display the Preview Curve dialog, 
press the spacebar. 

To change the precision, click on the left-arrow or right­
arrow buttons as described above. 

To continue the tracing, click on the Preview Curve 
dialog's Go On button. 

Deleting Tracing Points 

When you stop a tracing or when the tracing is complete, 
you can delete anchor points by pressing the Backspace 
key or the left-arrow key on the numeric keypad, "step­
ping" the tracing backwards point by point. 
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Autotracing 

Canceling the Tracing 

To abandon a tracing, click on the Preview Curve dialog's 
Cancel button. The current trace line is deleted in its en­
tirety, but the Trace tool remains selected. 

Line Widths-a Hint 

Before you start tracing, you might want to set the de­
fault line width to No Outline, especially if: 

o you want a solid color with no contrasting outline; 
o the thickness of the outline might distort or obscure 

the shape of the traced element. 

Tracing Grayscale Images 

11-14 

Grayscale images use dithering, patterns of white and 
black pixels, to create shades of gray. The Grayscale op­
tion in the Tracing Options dialog makes it possible for 
you to trace images composed of shades of gray. 

Because autotracing recognizes only black and white, it 
must have some way of determining which of the grays to 
treat as black and which to treat as white-in other 
words, where the black-white "threshhold" is. 

When you click on the Grayscale radio button, two addi­
tional options become available: 

o Gray Levels 
o Contrast 

Tracin 0 tions 
Il'Iage ----------------, 

Type @ Grayscale 0 Line Art 

~--,-"'-t Gra9 Le~ls 

Gap Size ~ ...... 0 .. 't,. ••• 0 .. 'L,l- 0 ~ 

Til'ling 

Precision [][] 

Contrast [][] OK I I Cancel I 
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Autotracing 

Gray Levels 

The Gray Levels menu lists a choice of 1, 4, 16, and 64 
gray levels. If you know how your image was dithered or 
how many gray levels were used in creating a TIFF file, 
choose that value from the menu. 

Contrast 

The Contrast setting determines which gray values 
are treated as black and which are treated as 
white-in other words, where the tracing line will be. 

In general, the lower the contrast setting, the 
lighter the gray value that will be traced. 

In the illustration at the left, the outer circle-the 
lightest gray value-is traced at the lowest contrast 
setting. 

Tips on Tracing Grayscale Images 

Image Tracing 

If you do not know how your image was dithered or how 
many gray levels there are in your TIFF file, experiment 
with combinations of Gray Levels and Contrast settings 
until you get the tracing you want. 

If the combination of settings is such that the grayscale 
area is seen by autotrace as white, this alert is displayed: 

Cannot find tracing inage. ~ 
Click closer to the outline 
of the i~age or change the 
Gra~scale tracing values. 

Adjust the Gray Levels or Contrast (or both) and try 
again. 

You may find that you have traced a single pixel. In that 
case, adjust the Gray Levels or Contrast (or both) and try 
again. 
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Hand Tracing 

Finally, unless the grayscale image you are tracing is very 
complex, consider the possibility of tracing it by hand, as 
described next. Hand tracing gives you complete control 
over the traced outline, and it avoids any need to set Gray 
Levels or Contrast. 

Hand Tracing 

Before tracing an 
image, load the image 
and set image options. 

If the Snap to Grid 
command has no 
marker, the snap is 
already off. 
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Hand tracing gives you the greatest control over the ap­
pearance of the tracing, but it can be time-consuming, be­
cause you must draw each curve yourself. 

In most cases, the Quill is the appropriate tool for tracing. 
You can use other drawing tools-for example, the Sketch 
tool, Rectangle tool, Circle tool, or Text tool-for parts of 
the image that are not suited to the Quill. 

To hand trace an image: 
[] Turn off the snap by displaying the View menu and 

choosing the Snap to Grid command. It is almost al­
ways easier to trace an image with the snap turned 
off. 

[]] Use the Magnifier to zoom in on the part of the image 
where you want to start tracing. 

[ill Select a tool from the toolbox. 

[]J Begin tracing. 
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Hand Tracing 

Tips for Hand Tracing 

Image Tracing 

When tracing an image by hand, keep these tips in mind: 

o Use as few anchor points as possible. For example, use 
compound curves wherever you can. (This skill will 
come with practice.) 

Fewer anchor points mean that you are less likely to 
encounter the 255-point limit and also that the ele­
ment will be easier to touch up when you're finished. 

o As a rule, it is easier to trace with the fill color turned 
off (Colors command or the FlO keystroke). 

o From time to time, check your tracing by hiding the 
image. Choose the Image command from the View 
menu or press F9. To re-display the image, choose the 
Image command or press F9 again. 

o Be as accurate as you can, but remember that you can 
always go back and "fine tune" the curves afterwards. 
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Color Manager 

THIS chapter describes how you work with Artline's Color Man­
ager. Using the Color Manager, you can: 

o load a color file, including PANTONE colors; 
o create or modify solid colors; 
o create or modify fountains; 
o add colors to a color file; 
o create a new color file. 

To display the Color Manager: 
You can move the 
Color Manager by 
dragging its title bar. 

Choose the Color Manager command from the Options 
Menu. 

close box --. H Color Mana er: ARTLINE.COL 
menu bar --. File Edit Uiew 

~ White 
~ Light gra!J 
~ Dark gra!J 
~ Black 
~ Red 

.-- title bar 

color bars --. 
~ Dark red 
~ Yellow ------1-1---- color names 

markers 

~ Dark !Jellow 
~ Green 
~ Dark green 
~ C!Jan 
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Colors and Fountains 

Colors and Fountains 

12-2 

Colors 

Artline's colors are available in two forms, as solid colors 
and as fountains. 

Solid colors can be assigned to an element's interior or its 
outline. The colors currently available for use in your pic­
tures are listed in: 

o Fill Color tool 
o Line Color tool 
o Color Manager (in Colors mode) 

Fountains 
Afountain is a blending of one color into another. Foun­
tains can only be assigned to an element's interior. The 
fountains currently available for use in your pictures are 
listed in: 

o Fountain tool 
o Color Manager (in Fills mode) 

NOTE:A fountain is not the same thing as a blend (described in 
Chapter 8). A blend combines the colors and the shapes of 
two elements over a specified number of steps. A fountain 
is a color blend that can be assigned to a single element or 
many elements. 
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Colors and Fountains 

Color and Fountain Availability 

Colors and fountains that appear in the color tools and in 
the Color Manager can be there for any of three reasons: 

D They are color file colors and fountains-they are part 
of the currently loaded color file. 

D They are picture colors (or fountains)-they are used in 
the picture on the drawing surface but are not part of 
the color file. 

D They are unaffiliated colors or fountains-you have 
created them but have not yet used them or saved 
them into a color file. 

Color Files 

Color files have the 
extension .COL. 

Color Manager 

Color files contain combinations of solid colors and foun­
tains that you can load and use repeatedly. Several color 
files are provided with Artline, and you can create your 
own according to your needs. 

When you load a color file, its solid colors are displayed in 
the Fill Color and Line Color tool palettes, and its foun­
tains appear in the Fountain tool palette. 

The name of the current color file appears in the Color 
Manager's title bar. 

The smallest possible color file is one that contains only 
black and white, but you can create color files with dozens 
of colors. The major limiting factors are disk space and 
the amount of time it takes to load a very large color file. 

Colors and fountains that are part of the current color file 
are indicated in the Color Manager by a marker. (See the 
illustration on the next page.) 



Colors and Fountains 

Picture Colors and Fountains 

Picture colors remain 
associated with the 
pictures in which they 
are used. 

When you open a picture, any colors or fountains in the 
picture that are not in the current color file are automati­
cally added to the colors that appear in the color tools and 
Color Manager. 

( 

Picture colors do not become a part of the color file unless 
you explicitly save them to the file. Adding colors to a 
color file is described on page 12-11. Adding fountains to 
a color file is described on page 12-19. 

Unaffiliated Colors and Fountains 
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A color or fountain is "unaffiliated" when you have cre­
ated it, but have not used it in the current picture or 
saved it to the current color file. 

Presumably you intend to use or save the colors you cre­
ate. If you do not, they will be lost when you: 

o load another color file; 
o open another picture; 
o qui t Artline. 

Markers: Picture Colors and Unaffiliated Colors 

Picture colors and unaffiliated colors are identified in the 
Color Manager by the absence of a marker between the 
color bar and the color name. You cannot tell whether a 
color is part of the color file by looking in the color tools 
(Fill Color, Fountain, or Line Color). 

H Color Mana er: ARTLINE.COL 
File Edit View 

• 
~ Dark yellow i:::;:;: 
: ~~~n 9reenll 

Cyan Dark +1 co::::: 

~ Dark cyan 
Blue Light -3 

~ Blue 
~ Dark blue 
~ Magenta 
~ Dark l'1Iagenta 

This color is part of 
the current color file. 

This color is not part of 
the current color file. It 
is either a picture color 
or is unaffiliated. 
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Color Models 

Color Models 

A color model is a description of how the colors of the spec­
trum are created. In Artline you can create colors in any 
of three color models: 

o CMY-Cyan/Magenta/Yellow 
o RGB-Red/GreenIBlue 
o HSB-Hue/SaturationlBrightness 

NOTE: The color models are not mutually exclusive. Color files 
(page 12-3) are all saved in the same format, so you can 
create colors using whichever model works best for you. 
There are no colors you can create with one model that you 
cannot create with the others. 

For a comparison of the three color models, see the table 
on page 12-8. 

CMY Color Model 

Color Manager 

The CMY model corresponds to the standard color model 
used for four-color printing, CMYK (the K stands for 
black). The CMY colors are also known as process colors. 

In this model, colors are created by combining percent­
ages of three colors: cyan, magenta, and yellow. 

Zero percent of all three colors is white; 100% of all three 
colors is black. 

Shades of gray are created by combining equal percent­
ages of all three colors. The higher the percentage, the 
darker the gray. 

See "Converting CMYK Colors to CMY" (page 12-8). 
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Color Models 

RGB Color Model 
Most color computer 
monitors create colors 
by combining RGB 
values. 

The RGB model creates colors by combining percentages 
of three colors: red, green, and blue. 

Zero percent of all three colors is black; 100% of all three 
colors is white. 

Shades of gray are created by combining equal percent­
ages of all three colors. The higher the percentage, the 
lighter the gray. 

HSB Color Model 
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In the HSB color model, the actual color is determined by 
the value in the Hue field, while the other two fields deter­
mine the relative lightness or darkness of the color. 

Hue 

This field determines the color. 

The color per,~entages are arranged in a circle, starting 
and ending with red. Thus, 0% Hue is red, and 100% Hue 
is also red. In between, green is 33.3% Hue, and blue is 
66.6% Hue. For a more detailed accounting of the Hue 
percentages, see the Color Model Comparison Table on 
page 12-8. 

To see the effect of the Hue field, select the field, type 0 
(zero) to set it to red, and then press the plus key on the 
numeric keypad. Each time you press the plus key, the 
percentage increases by 5%, and the color changes 
accordingly. 

N()TE: These color percentages are based on Brightness and Satu­
ration values of 100%. At less than 100% Brightness and 
Saturation, the colors are no longer "pure." 
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Color Models 

Brightness 

The Brightness value determines how much black is 
mixed with the color set by the current Hue percentage. 

At 100% Brightness, the color contains no black. 

At 0% Brightness, the color is pure black. Changes to the 
Saturation and Hue values have no effect. 

Saturation 

The Saturation value determines how much white is 
mixed with the color set by the current Hue percentage. 

At 100% Saturation, the color contains no white. 

At 0% Saturation, the color is pure white. Changes to the 
Hue values have no effect. Note, however, that changes 
to the Brightness percentage override the Saturation 
value. See the next section. 

Gray Levels in the HSB Model 

Color Manager 

In the HSB color model, grays are created when the Satu­
ration is 0% and the Brightness value is varied. (When 
the Saturation is 0%, changes to the Hue percentage have 
no effect.) 

The higher the Brightness percentage, the lighter the 
shade of gray. A Brightness of 100% is pure white, and a 
Brightness of 0% is solid black. 
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white 

black 

red 

yellow 

green 

cyan 

blue 

magenta 
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Comparison of Color Models 

C 

a 

100 

a 

a 

100 

100 

100 

a 

The following table compares how the three color models 
produce the same colors. 

Color Model Comparison Table 

CMV RGB HSB 

M V R G B H S B 

a a 100 100 100 x a 100 

100 100 a a a x x a 

100 100 100 a a 0/100 100 100 

a 100 100 100 a 16.7 100 100 

a 100 a 100 a 33.3 100 100 

a a a 100 100 50 100 100 

100 a a a 100 66.6 100 100 

100 a 100 a 100 83.2 100 100 

x = This setting has no effect. 

Converting CMYK Colors to CMY 

If you have a CMYK color you want to duplicate in Art­
line, you can convert it to the CMY model by adding the 
black value to each of the other colors. If this would pro­
duce a percentage greater than 100%, leave it at 100%. 

CMYK CMY 

cyan 20 40 

magenta 85 100 

yellow 20 40 

black 20 
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Creating and Modifying Colors 

Creating and Modifying Colors 

This section describes how you create new colors, modify 
existing colors, and add colors to color files. 

Creating Colors 

F1 
F2 

Sort b~ Na~e +N 
~ Sort b~ Hue +H 

Sort b Sri ht +L 

Color Manager 

You can create a new color by choosing: 

o the New Color option in either color tool; 
o the Add Color command from the Color Manager's 

Edit menu. 

The Add Color command is available only when the 
Color Manager is in Colors mode (as opposed to Fills 
mode). The Color Manager is in Colors mode when the 
Colors command in the View menu is marked. 

In either case, Artline displays the Add Color dialog. 

Add Color 

Color Nallle !Umiii.:., 

D 
% Red 1188,8 

% Green 1188,8 

% Blue 1188,8 

Color Model OCMY @RGB OHSB 

OK I Cancel I 
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To create a new color: 
[]] Enter a name directly into the Color Name field, or 

accept the name supplied by Artline. 

[]] Choose a color model. 

Color models are described on page 12-5. 

[]] Adjust the three percentage fields to create the color. 

When you exit the Add Color dialog, the new color ap­
pears in the color tool palettes and in the color list in the 
Color Manager. 

At this point, the new color is unaffiliated. You can make 
it a picture color by using it in the current picture, or you 
can add it to the current color file. Adding colors to a 
color file is described on page 12-11. 

Modifying Colors 
You can modify any color in the current color list. 

To modify a color: 
[]] Open the Color Manager. 

[]] Display the Modify Color dialog by doing either of the 
following: 

-Double-click on the name of the color you want to 
modify. 

-Select the color you want to modify by clicking on 
its name. Then display the Color Manager's Edit 
menu and choose the Modify command. 

Do not click on the color bar or the marker (if pres­
ent) or you will change the status of the color. 

The Modify Color dialog is identical to the Add Color dia­
log. You can use this dialog to: 

o change the color's name; 
o change the color model; 
o modify the color by changing percent values. 
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Adding Colors to Color Files 

Colors that do not have a marker between the color bar 
and the color name are not part of the color file. 

To add a color to the current color file: 

Use the Save As com­
mand to save the color 
file under a new name. 

[] Click on the color bar of the color you want to add to 
the file. A marker will appear next to the color name. 

[]] When you have marked all the colors you want to 
add, save the color file by choosing the Save com­
mand from the Color Manager's File menu. 

CAUTION: If you create a color and do not use it in a picture or save it 
to a color file, it will be lost when you load another color file, 
open another picture, or quit Artline. 

Removing Colors from Color Files 

You can remove a color from the current color file in 
either of two ways. 

D You can delete the color using the Delete command in 
the Color Manager's Edit menu. A deleted color is no 
longer available for the current picture and, once you 
save the color file, is also removed from the color file. 

D You can click on the color's color bar. Artline displays 
the following alert: 

The selected color will be reMoved frOM 
the current color file. The color will 
reMain in the palette associated with 
this picture file. 

OK 

Cancel 

Color Manager 

Colors removed in this manner are still available for 
the current picture but will no longer be part of the 
color file if you save the file. (As a precaution against 
losing a color you actually want, you can use the Save 
As command to save the color file under a new name.) 

12-11 



Creating and Modifying Fountains 

Creating and Modifying Fountains 

This section describes how you create new fountains, mod­
ify existing fountains, and include picture fountains into 
color files. 

NOTE: In some places, notably in the color tools and in the Color 
Manager, Artline refers to fountains as fills. 

Creating Fountains 

F1 
F2 

50rt by Hane +H 
~. 50rt by Hue +H 

Sort b Sri ht +l 

12-12 

You can create a new fountain by choosing: 

o the New Fill option in the Fountain tool; 
o the Add Fill command from the Color Manager's Edit 

menu. 

The Add Fill command is available only when the 
Color Manager is in Fills mode (as opposed to Colors 
mode). The Color Manager is in Fills mode when the 
Fills command in the View menu is marked. 

In either case, Artline displays the Add Fill dialog. 

Add Fill 

Hh1te: 

Angle [ll[J 0 

Bl<lc:k 

[ Gradation 
@ Even o Log 

[ Type 
~ Radial @ Linear 

Seecial ... OK I I Cancel I 
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Creating and Modifying Fountains 

To create a new fountain: 

Color Manager 

IT] Enter a name directly into the name field, or accept 
the name supplied by Artline. 

[]] Choose the fountain's start and end colors from the 
two pop-up menus. 

[ill If you are creating a Linear fountain, set its angle by 
entering a value directly into the Angle field, drag­
ging the pop-up slider, or dragging the head of the 
arrow in the preview window. The preview window 
shows the fountain you are creating. 

[!] Choose the fountain's Gradation and Type and, if you 
are sending your output to a PostScript device, set 

. PostScript Fill Options. 

Gradation, Type, and PostScript Fill Options are de­
scribed in the next sections. 

[]J Exit the Add Fill dialog. 

The new fountain will now appear in the Fountain Tool 
palette and in the fountain list in the Color Manager. 

At this point, the new fountain is unaffiliated. You can 
make it a picture fountain by using it in the current pic­
ture, or you can add it to the current color file. Adding 
fountains to a color file is described on page 12-19. 
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Gradation 

The Gradation option determines how the start color 
blends to the end color. 

Even 

The transition from start color to end color takes place in 
even steps over the span of the fountain. 

Log 

The transition from start color to end color is logarithmic, 
beginning gradually and then changing rapidly toward 
the end of the fountain. 

Even 

Log 

Type 

Radial 

A Radial fountain is circular, and the start color blends in­
ward to the end color. When you choose Radial, the Angle 
field is unavailable. 

Radial 

Linear 

In a Linear fountain, the colors blend as a series of bars of 
color. The Even and Log fountains above are both linear. 
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PostScript Fill Options 
Remember that 
there are two distinct 
dialogs: 
PostScript Options and 
PostScript Fill Options. 

PostScript Fill Options give you greater control over how 
fountains are printed on a PostScript device. You can set 
separate Fill Options for each fountain you create, and 
they override the Halftone Screen Options settings in the 
PostScript Options dialog (see page 3-17). 

If, for example, you create a fountain with Fill Options, 
use it in a picture, and print the picture with default Half­
tone Screen Options in the PostScript Options dialog, the 
fountain will print according to the Fill Options, and the 
rest of the picture will use the device's default settings. 

PostScript@ Fill OPtions 

r 
Fill ParaMeters 
@ Standard 0 Special 

Screen Function 

Screen Angle 

Screen Resolution 

I Default 

0 

60 
I 

I·' 
0 

!pi 

OK I Cancel I 

Fill Parameters 

Color Manager 

Standard 

The selected fountain has no special Fill Options;. it will 
be printed using the Halftone Screen Options from the 
PostScript Options dialog. 

Special 

The selected fountain will be printed using the Screen 
Function, Screen Resolution, and Screen Angle options 
set in this dialog, regardless of the settings in the Post­
Script Options dialog. 
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Screen Function 

This menu,allows you to choose the PostScript device's 
default screen function or select a specific screen function. 

Default 

The selected fountain will be printed using the PostScript 
device's default Screen Function (usually a form of dot 
screen). 

Line 

The selected fountain will be printed with a line screen. 
Color fountains are created by altering the thickness of 
parallel lines of the start and end colors. Grayscale foun­
tains are created by altering the thickness of parallel 
black and white lines. 

Round Dot 

The selected fountain will be printed with a dot screen. 
Color fountains are created by altering the size of dots of 
the start and end colors. Grayscale fountains are created 
by altering the size of black and white dots. 

The illustrations below show a fairly coarse (30 Ipi) line 
screen and dot screen of the same fountain. 

................ ................ ................ ................ ................ ................ ................ 

--

---

line screen 

••..................... . +++...................... . 
•• ee •••••••••••• •••• .. •••• . •••.................... . •...................... . _.e.................... . •••••.................. . 

•• e ••••••••••••••• ••••• . _................... . dot screen •.................. .... . • .. e..................... . •••.................... . ...................... . .. •• +.................. . _...................... . __ e.................... . ................... . 
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Creating and Modifying Fountains 

Screen Angle 

Screen Angle refers to the physical angle at which screens 
are printed. 

Screen Resolution 

This setting controls the sharpness of fountains. Screen 
Resolution for both dot screens and line screens is mea­
sured in lines per inch. 

Because the resolution of output devices is fixed-for ex­
ample, 300 dpi for a typical laser printer and 2540 dpi for 
a phototypesetter-increasing the screen resolution signif­
icantly reduces the number of available gray levels. This 
equation shows how the two are related: 

l
. dpi 

Pl-- ~grays 

or, stated another way: 

grays = (dP~ J2 
lpl 

For example, on a 300 dpi printer, a screen resolution of 
50 lpi produces thirty-six gray levels; a screen resolution 
of 100 lpi produces only nine gray levels. The resolution 
has doubled, but the number of gray levels is one fourth 
what it was. 
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Modifying Fountains 

You can modify any fountain listed in the Color Manager. 

To modify a fountain: 

OJ Open the Color Manager. 

[]] Display the Modify Fill dialog by doing either of the 
following: 

Double-click on the name of the fountain you want 
to modify. 

Select the fountain you want to modify by clicking 
on its name. Then display the Color Manager's 
Edit menu and choose the Modify command. 

Do not click on the color bar or the marker (if pres­
ent) or you will change the status of the fountain. 

The Modify Color dialog is identical to the Add Color dia­
log. You can use this dialog to: 

o change the fountain's name; 
o change the start or end colors; 
o change the fountain's angle; 
o change the Gradation or Type; 
o change the PostScript Fill Options. 
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Adding Fountains to Color Files 

Use the Save As com­
mand to save the color 
file under a new name. 

Fountains that do not have a marker between the color 
bar and the name are not part of the color file. 

To add a fountain to the current color file: 
[JJ Click on the color bar of the fountain you want to add 

to the file. A marker will appear next to the name. 

[]] When you have marked all the fountains you want to 
add, save the color file by choosing the Save com­
mand from the Color Manager's File menu. 

CAUTION:Ifyou create a fountain and do not use it in a picture or save 
it to a color file, it will be lost when you load another color 
file, open another picture, or quit Artline. 

Removing Fountains from Color Files 
You can remove a fountain from the current color file in 
either of two ways. 

D You can delete the fountain using the Delete com­
mand in the Color Manager's Edit menu. A deleted 
fountain is no longer available for the current picture 
and, once you save the color file, is also removed from 
the color file. 

D You can click on the fountain's color bar. Artline dis­
plays the following alert: 

The selected color will be renoved fran 
the current color file. The color will 
renain in the palette associated with 
this picture file. 

OK 

Cancel 

Color Manager 

Fountains removed in this manner are still available for 
the current picture but will no longer be part of the color 
file if you save the file. (As a precaution against losing a 
fountain you actually want, you can use the Save As com­
mand to save the color file under a new name.) 
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Creating Color Files 

12-20 

You can use the Color Manager to create entirely new 
color files of your own. 

The following steps are suggested; you can make up your 
own variations as you gain experience. 

To create a new color file: 

[]] To start with a "clean slate," save any work you have 
on the drawing surface and then choose the New com­
mand from the main File menu. 

[]] Open the Color Manager. 

[]] Choose the Reset command from the Color 
Manager's File menu. 

Artline displays an alert that all colors not used in 
the current picture will be deleted from the color list. 
Click on the alert's OK button or press .J. 

The color list should now show only White and Black. 

[]] Create the colors and fountains for your new color 
file. Use the steps described earlier in this chapter 
under "Creating and Modifying Colors" (page 12-9) 
and "Creating and Modifying Fountains" (page 12-12). 

[]] As you create each color and fountain, add it to the 
eventual color file by clicking on the color bar next to 
its name. The marker between the color bar and the 
name indicates that the color is now part of the file. 

[§] Save the new color file using the Save As command 
in the Color Manager's File menu. 

NOTE: If there is anything in the paste buffer, its color (or colors) 
will still appear in the color list after you choose the Reset 
command. To remove those colors, Cut or Copy something 
black or white to the paste buffer, choose the New command 
again, and then Reset the Color Manager. 
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PANTONE Colors 

Artline supports PANTONE colors through several files 
that were copied to your hard disk when you ran Setup. 

Pantone, Inc. provides a set of standardized colors that 
make possible consistent color matching and reproduc­
tion. Using PANTONE colors in Artline pictures assures 
you of predictable results with commercial printers and 
Pantone-approved computer output devices. 

Many corporations use the PANTONE system to specify 
their corporate colors. 

To load a PANTONE color file: 

OJ Open the Color Manager. 

[]] Display the File menu and choose the Load com­
mand. 

[]] In the Item Selector, double-click on the name of the 
PANTONE file you want. 

NOTE: Unless you have one of the printers or screens listed in the 
table on the next page, the colors that appear on the screen 
or in output to color printers may not match PANTONE­
identified solid color standards. Use current PANTONE 
Color Reference Manuals for accurate color. 

Color Manager 

To purchase PANTONE Color Reference Manuals or other 
related materials, write to: 

Pantone, Inc. 
55 Knickerbocker Road 
Moonachie NJ 07074 
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PANTONE Files 

PANTONE files are designed for specific output devices, 
both screens and printers. Choosing the PANTONE file 
for the device most like the one you are using assures you 
of the best possible color reproduction on that device. 

The PANTONE files support these devices: 

color file name target device 

CMYK-150.COL 150-line four-color process separations; 
screen angles: C = 105°, M = 75°, Y = 90°, K = 45° 

NEC-CMYK.COL NEC Colormate PostScript printer; 
C = 42°, M = 85°, Y = 36°, K = 24°; 
screen frequency = 50 lpi 

OCE-CMYK.COL Oce Graphics G5232 Color PostScript Printer; 
C = 42°, M = 85°, Y = 36°, K = 24°; 
screen frequency = 50 lpi 

OCECOLOR.COL OceColor Printer 

QMS-I0.COL QMS® ColorScripfM 100 Model 10 Printer; 
C = 42°, M = 85°, Y = 36°, K = 24°; 
screen frequency = 50 lpi 

QMS-30.COL QMS ColorScript 100 Model 20/30 Printer; 
C = 42°, M = 85°, Y = 36", K= 24°; 
screen frequency = 50 lpi 

TEK-CQS.COL Tektronix CQS printer 

TEK-PX.COL Tektronix Phaser PX printer 

PNTMITSU.COL monitors with Mitsubishi tubes 

PNTSONY.COL monitors with Sony tubes 

For files that will be printed on a phototypesetter, use the 
150-line PANTONE file CMYK-150.COL. 
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Color Manager Command Reference 

File Menu 

Reset AR 
Load. II AL 
Merge... AM 
Save AS 
Save As ••. AA 

Close 

The following sections describe the commands in the 
Color Manager's menus. 

Note that the Color Manager menus list keyboard com­
mand equivalents. When the Color Manager is open, 
these keyboard commands are activated, and the key­
board commands in Artline's main menus are inactive. 

This section describes the commands in the Color 
Manager's File menu. 

Reset Command 

The Reset command changes the color list so that it con­
tains only White and Black and any colors or fountains 
that are used in elements in the current picture or in the 
paste buffer. 

Colors or fountains that are not in use are deleted from 
the list. 

The Reset command can be used as the first step in start­
ing a new color file (see page 12-20) or as a means of elimi­
nating unused colors before saving a new color file. 

Load Command 

Color Manager 

The Load command displays the Item Selector with a list 
of the available color file names. The color file you choose 
from the Item Selector replaces the current color file. 
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Merge Command 

The Merge command displays the Item Selector with a 
list of the available color file names. The color file you 
choose from the Item Selector is merged with the current 
color file. The resulting color list contains the combined 
colors and fountains of both files. 

If the two files contain colors whose values are identical 
but whose names are different, the name from the cur­
rent file is retained; the colors are not duplicated. 

Save Command 

The Save command saves the marked colors and foun­
tains in the color list to the file named in the Color 
Manager's title bar. 

Colors or fountains that are not marked are not saved to 
the file, but if they are used in a picture, they become part 
of the picture and are loaded with the picture. 

Save As Command 

The Save As command displays the Item Selector so you 
can: 

o give a new color file a name and then save it for the 
first time; 

o save an existing color file under a new name. 

The second option usually occurs when you want to 
save a modified color file but still want to keep the orig­
inal. 

Close Command 

The Close command closes the Color Manager and re­
turns you to the Artline workspace. The colors and foun­
tains in the Color Manager at the time you close it will 
appear in the color tool palettes. 
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Edit Menu 

EdifMenu 

This section describes the commands in the Color 
Manager's Edit menu. 

+D 
+U 

Add Color +ji 
Modif +t1 
colors mode 

+D 
+U 

Add Fill +A 
Modif +M 

fills mode 

Delete Command 

The Delete command removes a selected color or foun­
tain from the color file. The deletion does not become per­
manent until you save the color file. 

To select a color or fountain, click on its name in the color 
list. The black highlight bar indicates that the color is se­
lected. Do not click on the marker (if present) or the color 
bar; that will simply change the color's status. 

Duplicate Command 
The current color or 
fountain is not altered; 
it is merely the starting 
point for the new color 
or fountain. 

Color Manager 

When the Color Manager is in Colors mode, the Dupli­
cate command displays the Modify Color dialog so you 
can create a new color from the currently selected color. 
The Modify Color dialog is identical to the Add Color 
dialog (page 12-9). 

The new color's percentage values must be unique. If 
they are not, Artline displays an alert that the color was 
not added because it already exists in the current file. 
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When the Color Manager is in Fills mode, the Duplicate 
command displays the Modify Fill dialog so you can cre­
ate a new fountain from the currently selected fountain. 

If you define a fountain whose start and end colors are 
the same as those in another fountain in the current file, 
Artline displays an alert that the fountain was not added 
because it already exists. 

Add Color IFill Command 
This command's name and function depend on your cur­
rent selection in the View menu. 

o If you select Colors, the command is Add Color, and 
it displays the Add Color dialog so you can add a new 
color. 

Adding colors is described on page 12-9. 

o If you select Fills, the command is Add Fill, and it dis­
plays the Add Fill dialog so you can add a new fountain. 

Adding fountains is described on page 12-12. 

Modify Command 
You Call also display 
the Modify dialogs by 
double-clicking on the 
color or fountain name. 
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The Modify command displays the Modify Color dialog or 
the Modify Fill dialog, depending on the currently se­
lected color or fountain. 

Modifying colors is described on page 12-10. 

Modifying fountains is described on page 12-18. 
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View Menu 

This section describes the commands in the Color 
Manager's View menu. 

F1 
F2 

Sort b~ Nane +N 
~ Sort b~ Hue +H 

Sort b Bri ht +L 
colors mode 

F1 
F2 

Sort by Hane +H 
~. Sort by Hue +H 

Sort b Uri ht +L 
fills mode 

Colors Command 

The Colors command switches the Color Manager to its 
mode in which: 
o the colors list shows the solid colors in the current pic­

ture file or in use on the drawing surface; 

o the commands in the Edit and View menus apply only 
to solid colors. The Add Color command is available 
only in this mode. 

Fills Command 

Color Manager 

The Fills command switches the Color Manager to its 
mode in which: 

o the colors list shows the fountains in the current pic­
ture file or in use on the drawing surface; 

o the commands in the Edit and View menus apply only 
to fountains. Th~ Add Fill command is available only 
in this mode. 
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View Menu 

Sort by Name Command 

This command is 
available only in 
Colors mode. 

The Sort by Name command sorts the color list alphabet­
ically by the names of the colors. 

Sort by Hue Command 

This command is 
available only in 
Colors mode. 

The Sort by Hue command sorts the color list by the 
Hue values of the individual colors. See the description of 
the HSB color model (page 12-6). 

The colors are sorted in ascending order from the lowest 
Hue percentage to the highest percentage. 

Colors with the same Hue percentage are grouped to­
gether and sorted in descending order by their Brightness 
percentage. 

Colors with the same Hue and Brightness values are 
sorted in ascending order by their Saturation percentage. 

Sort by Bright Command 

This command is 
available only in 
Colors mode. 
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The Sort by Bright command sorts the color list accord­
ing to the Brightness value in the HSB color model. 
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Tools Manager 

THIS chapter describes Artline's Tools Manager. You can use the 
Tools Manager to create special tools or custom toolboxes. 

To display the Tools Manager: 
You can move the Choose the Tools Manager command from the Options 
Tools Manager by menu. 
dragging its title bar. 

close box ~ title bar HI Tools Manager 
File Edit 

t 
I 

menu bar 

workspace 

On color screens, the blue background of the toolbox be­
comes a gray background when the Tools Manager is open. 
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Tools Manager Functions 
All tasks descr ibed in 
this chapter can be per­
formed only when the 
Tools Manager is open. 

Tools Files 

With the Tools Manager, you can: 

o create new tools; 
o add tools to the toolbox; 
o save custom tools files; 
o remove tools from the toolbox; 
o change the size of the toolbox; 
o change the arrangement of the tools in the toolbox; 
o change or edit a tool's icon. 

Toolboxes are saved in files with the extension .TLS. 

The Artline installation program installs a default tools 
file called ARTLINE.TLS in the \ARTLINE\ TOOLS 
directory. 

Using the Tools Manager, you can create and save your 
own special tools files. You can save them in the directory 
of your choice. 

Default Toolbox 
ARTLlNE:.INI cOlltaills 
a great deal more than 
just the toolbox configu­
ration. See page 9-5. 
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When you start Artline, the appearance of the toolbox is 
determined by the file ARTLINE.INI, which "remembers" 
how the toolbox was last configured and automatically 
loads that same configuration. 

To change the default toolbox: 
Load the toolbox you want as the new default just before 
you quit Artline. A new ARTLINE.INI is written each 
time you quit Artline, and the toolbox in place at that 
time automatically becomes the default. 
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Toolbox Design 

Tools File Backups 

The Global Preferences dialog includes an option that 
allows you to save a backup copy of your tools file 
(see page 9-2). 

When the Make Backups Of check box for tools files is 
turned on, Artline keeps the last saved version of the 
tools file as a backup each time you choose the Save 
command from the File menu in the Tools Manager. 

Backup tools files have the extension $LS. 

The backup file options in the Global Preferences dialog 
are described on page 9-2. 

Toolbox Design 

This section describes: 

o changing the size of the toolbox; 
o changing the arrangement of the tools. 

Toolbox Size 

You may need to 
change the size of 
the toolbox before 
rearranging, adding, 
or removing tools. 

You can change the width of the toolbox's shaded back­
ground, making room for more or fewer columns of tools. 
You cannot change the toolbox's height or its position at 
the left side of the workspace. (You can, however, hide 
the toolbox from view using the Toolbox command. See 
page 5-10.) 

To change the size of the toolbox: 

Tools Manager 

Drag the right side of the toolbox's background to the left 
or right. Note that you cannot drag the background 
under the tools-in other words, you cannot make the 
toolbox narrower than the tools themselves. 

13-3 



Custom Tools 

Tool Arrangement 

You can arrange the tools in the toolbox by dragging them 
to the position you want. The Tools Manager automati­
cally "snaps" tools into position to make them easier to 
align. To turn off the snap, hold down the Ctrl key. 

For precise placement of tools, select a tool and press one 
of the arrow keys on the numeric keypad. The selected 
tool moves by one-pixel increments each time you press 
an arrow key. 

You can use the Tools Manager as a temporary holding 
place. For example, you can drag tools to the Tools Man­
ager to make room while you rearrange the toolbox. 
When you are finished, drag the tools back to the toolbox. 

Custom Tools 

13-4 

Using the Tools Manager, you can create custom versions 
of three kinds of tools: 

o standard tools 
o menu tools 
o container tools 

Standard Tools 

A standard tool is any of the default Artline set of tools­
like the Quill, the Rectangle tool, or the Plane. 

Custom Standard Tools-Examples: 

o a Rectangle tool that draws only rounded rectangles 
o a Line tool that draws lines only at set angles 
o a Trace tool with pre-set Tracing Options 
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Custom Tools 

Menu Tools 

A menu tool is a tool that executes one of Artline's menu 
'commands, often with information pre-set into a dialog 
displayed by that command. 

Custom Menu Tools-Examples: 

o a Page Layout tool with specific options so you can 
switch rapidly to a particular layout 

o an Image Options tool with pre-set options for image 
and background colors, scaling, and offsets 

o a Rotate tool with a pre-set center of rotation and rota­
tion angle and the Make Copy button toggled on 

Container Tools 

Only menu tools 
can be placed in 
a container. 

Tools Manager 

A container tool is a special tool that executes more than 
one menu command at a time. Containers are like the 
macros that are available in many word processors and 
other programs. 

Container Tools-Examples: 

o a tool combining the Load Image and Image Op­
tions commands-the latter with its options pre-set 

This container would display the Item Selector so you 
can select an image to load and then set the image's 
colors, pattern, and scale, all in a single step. 

o a tool combining the Grid, Guide Lines, and Status 
Line commands 

This container would toggle the grid, guide lines, and 
status line on or off in a single step. 

o a tool combining the Rotate, Move, and Scale 
commands 

This container would rotate, move, and scale an ele­
ment in a single step. With the Make Copy option 
turned on for each command, the container could pro­
duce many rotated, moved, and scaled elements. 
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Creating Tools 

Creating Tools 

13-6 

This section des~ribes the steps for creating standard 
tools, menu tools, and container tools. 

NOTE: The maximum number of tools that can be placed in a 
toolbox is sixty-three. 

Standard Tools and Menu Tools 
Creating a standard tool or a menu tool typically involves 
the same sequence of steps in the Tools Manager. 

To create a standard tool or menu tool: 
[]] Choose the Add command from the Edit menu to dis­

play the Tool Attributes dialog. 

Specify the tool's name, type (Standard or Menu), and 
function in the Tool Attributes dialog (see page 13-9). 

[]] Choose the Function command from the Edit menu. 

Set parameters for the tool or command by filling out 
the dialog that is displayed. See the description of 
the tool or command for information on its associated 
dialog. 

The Function command is available if the tool you 
are creating is either of the following: 

_a standard tool for which you can set options, like 
the Trace tool and the Rectangle tool; 

_a menu command that displays a parameter dia­
log, like the Page Layout and Image Options 
commands. 

[]] Choose the Icon command from the Edit menu if you 
want to create a custom icon for this tool. The Tools 
Manager's Icon Editor is described on page 13-12. 
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[]] Drag the finished tool from the Tools Manager to the 
toolbox. 

[§] Save the modified toolbox. If you do not save the file, 
the modifications to your toolbox could be lost. See 
page 13-19. 

To overwrite the currently loaded tools file, choose 
the Save command from the Tools Manager's File 
menu. 

To save the modified toolbox under a new name, 
choose the Save As command from the File menu. 

Container Tools 

In creating a container tool, you create the container and 
the menu tools that go into it and then combine them. 

To create a container tool: 

Tools Manager 

OJ Choose the Add command from the Edit menu to dis­
play the Tool Attributes dialog. 

Specify the tool's name and type (Container) in the 
Tool Attributes dialog (see page 13-9). 

[]] Create the menu tools that will go into the container. 
Follow the steps listed previously under "Standard 
Tools and Menu Tools." 

[]] Drag each finished menu tool to the container tool. 
When the container tool is highlighted, release the 
mouse button. The menu tool "drops" into the con­
tainer tool. 
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[]] When all the tools are inside the container, select the 
container tool and open it by choosing the Function 
command from the Edit menu. The Tools Manager is 
now in its "Container" editing mode, in which you can: 

- Duplicate any menu tools that you want executed 
more than once; 

- set the Function of selected menu tools; 

- set the order in which the commands are executed. 

The commands are executed from left to right, row 
by row. Drag the tools to place them in the order 
you want. 

To leave "Container" editing mode, choose the Close 
command from the File menu or click on the close box. 

[]] If you want to create a custom icon for the new tool, 
choose the Icon command from the Edit menu to dis­
play the Tools Manager's Icon Editor (see page 13-12.) 

[]] Drag the finished container tool to the toolbox. 

[1J Save the modified toolbox. If you do not save the file, 
the modifications to your toolbox could be lost. See 
page 13-19. 

To overwrite the currently loaded tools file, choose 
the Save command from the Tools Manager's File 
menu. 

To save the modified toolbox under a new name, 
choose the Save As command from the Tools 
Manager's File menu. 

Artline User Reference Guide 



Tool Attributes 

Tool Attributes 

When you choose the Add command or the Attributes 
command (both are in the Tools Manager's Edit menu), 
the Tool Attributes dialog is displayed. 

[I] 
Tool Attributes 

ToolJ s Na(l1e II'f:Im;II~1 

T!lpe I Standard Tool I~I 

Colors -.:!] I I~I 

Function I Selector I ~ I 
Assign: IDefault IconliDefault Na(l1el 

OK I I Cancel I 

Icon Selector 

The Icon Selector and 
the Icon Editor are not 
the same thing. 

Tools Manager 

The Tool Attributes dialog has a hidden Icon Selector so 
you can assign existing icons to your custom tools. (You 
can also create new icons with the Icon Editor, which is 
described on page 13-12.) To display the Icon Selector, 
click on the tool icon in the dialog's upper left corner. 

Icon Selector 

~ I ., OK , Cancel 

To bring other icons into view in the Icon Selector, use the 
scroll arrows, scroll bar, or slider. 

Using the Icon Editor, you can create your own icons and 
add them to the Icon Selector, or you can delete icons you 
do not want. 
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Tool Attributes 

Standard Tool I'" 
Standard Tool 
Menu Tool 
Container Tool 
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To choose an icon from the Icon Selector: 
Click on the icon you want and then click on the Icon 
Selector's OK button. The icon in the Tool Attributes dia­
log is replaced by the one chosen from the Icon Selector. 

For information on using the Icon Selector with the Icon 
Editor, see page 13-13. 

Tool's Name 

Use this field to give the new tool a name. You have two 
options: 

o You can type a name directly into this field. 
o You can accept the name supplied automatically when 

you choose the tool's function. See the description of 
the Function button in this dialog. 

Type 

From this menu, choose the type of tool you are creating: 

o Standard Tool (described on page 13-4) 
o Menu Tool (described on page 13-5) 
o Container Tool (described on page 13-5) 

Colors 

The first pop-up sets the color for the tool icon's desigl1. 
(the black pixels in the Icon Editor). The second pop-u~ 
sets the color for the tool icon's background. 

Function 

This pop-up menu lists the available functions for Stan­
dard Tools and Menu Tools. 

o If your Type choice is Standard Tool, the menu lists the 
names of the standard tools for which a tool can be 
made. 

o If your Type choice is Menu Tool, the menu lists the 
commands for which a tool can be made. 
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Tool Attributes 

Assign 

Tools Manager 

These buttons are available only if you are creating a 
Standard Tool. To choose either option, click on the appro­
priate button. 

Default Icon 

The default icon for this tool, as determined by its Func­
tion, is assigned to the new tool. For example, the default 
icon for a Selector tool is the small arrow pointing up and 
to the left. 

Default Name 

The default name for this tool-the name listed in the 
Function menu-is assigned to the new tool. 
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Icon Editor 

The Icon Editor is a tool with which you can design your 
own custom tool icons. 

To display the Icon Editor: 

13-12 

toolbox ----+ 

Select a tool-either in the toolbox or in the Tools Man­
ager-and then choose the Icon command from the Edit 
menu. 

• •• ••• •• •• • • • • 
+-ii--- workspace 

•• •••••••• • •••• • • • • • • • •• •••• • • •• •••• •• •••••••• • •••• • • • • •• •• •• •• •• •• •• •• • • •• •• •• •• •• •• •• • • •••••••••••••••••• •••••••••••••••••• 

[QJu=JO[I][3J[J[SJ1Ul +- Icon Selector 

Workspace 

The Icon Editor's workspace is where you draw the tool 
icons. See page 13-15. 
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Icon Editor 

Toolbox 

• 

Tools Manager 

The Icon Editor's toolbox contains these tools: 

0 grid switch 
0 eraser 
0 upload tool 
0 download tool 
0 delete tool 
0 end-of-list tool 

Grid Switch 

The grid switch turns the workspace's grid on and off . 
This grid is simply a drawing aid, like a template; it is not 
comparable to the grid in the main Artline workspace. 

Eraser 

Unless you have marked a block, clicking on the eraser 
clears the Icon Editor workspace entirely. 

If you mark a block (page 13-16), clicking on the eraser de­
letes the block without affecting the rest of the icon. 
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Icon Editor 

II 
The upload tool is 
available only when 
you select an icon in 
the Icon Selector. 

The download tool is 
available only when 
you select an icon in 
the Icon Selector. 

The delete tool is 
available only when 
you select an icon in 
the Icon Selector. 

II 
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Upload Tool 

The upload tool copies a selected icon from the Icon Selec­
tor into the workspace. 

When you click on the upload tool, the Icon Editor dis­
plays an alert asking if you want the icon currently in the 
workspace to be replaced. 

o Click on OK if you do not mind losing the current icon. 

o Click on Cancel if you do not want to lose the current 
icon. You can preserve it by first using the download 
tool or the end-of-list tool. 

Download Tool 

The download tool copies an icon from the workspace to 
the Icon Selector, replacing the icon currently selected 
there. 

You can use the download tool to preserve an icon for 
later use. The download tool differs from the end-of-list 
tool in that it does not add to the total number of icons in 
the Icon Selector. 

Delete Tool 

The delete tool removes the currently selected icon from 
the icon selector. Deleted icons cannot be undeleted. 

End-at-List Tool 

The end-of-list tool copies an icon from the workspace to 
the end of the list of icons in the Icon Selector. 

You can use the end-of-list tool to preserve an icon for 
later use. The end-of-list tool differs from the download 
tool in that it does not replace any icons in the Icon Selec­
tor but does add to the total number of icons. 
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Icon Editor 

Icon Selector 

A11 tools are descnbed 
on the two previous 
pages. 

The Icon Selector holds tool icons you can use as starting 
points for the icons you are creating. 

o To copy a selected icon from the Icon Selector to the 
workspace, use the upload tool. 

o To replace a selected icon in the Icon Selector with the 
icon in the workspace, use the download tool. 

o To delete a selected icon from the Icon Selector, use the 
delete tool. 

o To copy the icon in the workspace to the end of the list 
of tools in the Icon Selector, use the end-of-list tool. 

Scrolling the Icon Selector 

The Icon Selector can hold more icons than can be dis­
played at one time. You can scroll the icons in the Icon 
Selector by clicking on an arrow, clicking in the scroll bar, 
or dragging the slider. 

Basic Drawing Techniques 

Tools Manager 

Icons are made of individual black and white dots called 
pixels. In drawing an icon, you are actually changing 
pixels from white to black or from black to white; the ac­
tion of the mouse changes the pixel to its opposite state. 

To draw one pixel at a time: 
Click in the Icon Editor's workspace. 

o If you click on a white pixel, it changes to black. 
o If you click on a black pixel, it changes to white. 
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To draw more than one pixel at a time: 

Drag in the Icon Editor's workspace. 

o If you start on a white pixel, all pixels touched by the 
pointer are changed to black. 

o If you start on a black pixel, all pixels touched by the 
pointer are changed to white. 

Marking Blocks 

You can mark rectangular areas of the Icon Editor work­
space as a block, much as you would mark a block of text 
in a word processing program. Having marked a block, 
you can then delete it or move it. 

To mark a block of pixels, hold down the Alt key as you 
drag a selector box around the area you want. The block 
is indicated by a gray pattern. 

Deleting Blocks 

•• •• • • • • •• •••••••• • •••• • • • • • • • •• •••• • • •• •••• •• •••••••• • •••• • • • • • • • • • • • • •• •• 

To delete a block, click on the eraser in the Icon Editor's 
toolbox. Deleted blocks cannot be undeleted. 
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Moving Blocks 

To move a block, drag it where you want it. The block will 
completely overwrite the area to which you move it. 

Unmarking Blocks 

To unmark a block, click anywhere in the Icon Editor 
workspace outside the block. 

Drawing a Straight Line 

Drag steadily and not 
too fast. If you drag 
too fast, the Icon Editor 
might skip a pixel here 
and there. 

To draw a horizontal or vertical straight line, hold down 
the Ctrl key as you drag in the Icon Editor workspace. 
Remember that the line will be the opposite color from 
your starting point. If you start on a white pixel, the line 
will be black. If you start on a black pixel, the line will be 
white, in effect erasing pixels in a straight line. 

Drawing a Pixel Rectangle 

Tools Manager 

To draw a rectangular outline, hold down the Shift key 
and drag. As you drag, the Icon Editor shows you a gray­
colored preview of the rectangle. Like the straight line, 
the rectangle will be the opposite color from your starting 
point-a black rectangle if you start on a white pixel; a 
white rectangle if you start on a black pixel. 
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Tools Manager Command Reference 

File Menu 

The next two sections describe the commands in the Tools 
Manager's two menus. 

Note that the Tools Manager menus list keyboard com­
mand equivalents. When the Tools Manager is open, 
these keyboard commands are activated, and the key­
board commands in Artline's main menus are inactive. 

This section describes the commands in the Tools 
AR Manager's File menu. AL 

Save AS 
Save As... AA 

Close 

Reset Command 
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The Reset command replaces the current tools file with 
the tools in the file ARTLINE. TLS. When you choose the 
Reset command, Artline displays the following alert: 

The current toolboK will be 
replaced with the default set 
of tools in ARTLINE.TLS. 

OK 

Cancel I 

The alert's Cancel button gives you the option of cancel­
ing the Reset command and returning to the Tools Man­
ager to save any changes you have made to the current 
tools file. 
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File Menu 

Load Command 

The Load command displays the Item Selector so you can 
load another tools file in place of the current one. 

When you choose the Load command, the Item Selector 
defaults to the. TLS extension and its directory window 
lists only files with that extension. 

Save Command 

The Save command saves the current selection and ar­
rangement of tools in the toolbox into the currently 
loaded tools file. 

If you have turned on backups of your tools files in the 
Global Preferences dialog (page 9-2), the previous version 
of the tools file is kept, with the extension $LS. 

If tools file backups are not turned on, saving the current 
file overwrites the previous saved version. 

CAUTION: Save any modifications to a tools file you want to keep. The 
changes to your toolbox are kept in ARTLINE.lNI, but if 
something happens to ARTLINE.INI, your modified tools 
will be lost if you have not saved the tools file. 

Save As Command 

Tools Manag~r 

The Save As command displays the Item Selector so you 
can save the current selection and arrangement of tools in 
the toolbox: 

o under a new name; 
o to another directory or disk. 
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Edit Menu 

Close Command 
Clrcklng on the close 
box has the same ef­
fect as choosing the 
Close command. 

Edit Menu 

+A 
+D 
+C 

Attributes ... +1 
Function... +F 
Icon... +1 

Or anize +L 

The effect of the Close command depends on what level 
of the Tools Manager you are working in: 

o If you are in the Tools Manager's main level, the Close 
command removes the Tools Manager from the screen 
and returns you to the Artline workspace. 

o If you are editing a container tool in the function edi­
tor, the Close command returns you to the main level 
of the Tools Manager. 

This section describes the commands in the Tools 
Manager's Edit menu. Except for Add and Organize, 
these commands are available only when a tool is se­
lected, either in the toolbox or in the Tools Manager. 

Add Command 

The Add command displays the Tool Attributes dialog as 
the first step in adding a new tool. 

The Tool Attributes dialog is described on page 13-9. 

Delete Command 
Be careful when 
deleting tools. 
Deleted tools 
cannot be undeleted. 
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The Delete command removes a selected tool from the 
Tool Manager window. 

As a safeguard, you cannot delete a tool directly from the 
toolbox; you must first drag it into the Tools Manager. 
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Edit Menu 

Duplicate Command 

The Duplicate command makes a copy of a selected tool 
in the Tools Manager. Note that you cannot duplicate a 
tool while it is in the toolbox; you must first drag it to the 
Tools Manager. 

A duplicate tool retains all the characteristics of the origi­
nal, including its attributes and function. 

Container Tools 

The Duplicate command is the easiest way to make a 
container tool that repeats the same action several times. 

For example, to make a dozen rotated copies of an ele­
ment, you would make a container tool that holds eleven 
copies of a Rotate command tool. (The original element 
plus eleven copies equals twelve.) 

The Function settings for each Rotate command tool 
would: 

o define the center of rotation; 
o set the angle of rotation; 
o turn the Make Copy option on. 

Attributes Command 

Tools Manager 

The Attributes command displays the Tool Attributes 
dialog, which is described on page 13-9. 
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Function Command 

The Function command's display varies according to the 
currently selected tool. 

o standard tool 

The tool's options dialog is displayed so you can set 
specific options for that tool-for example, the Tracing 
Options dialog (Trace tool) or the Plane Options dialog 
(Plane tool). 

If the tool does not have an options dialog, the Func­
tion command is not available. 

o menu tool 

The dialog associated with the command is displayed 
so you can pre-set command parameters-for example, 
the Image Options dialog (Image Options command) 
or the Set Grid dialog (Set Grid command). 

If the command does not display a dialog, the Func­
tion command is not available. 

o container tool 

The Tools Manager switches to container editing mode. 
Creating a container tool is described on page 13-7. 

Icon Command 

The Icon command displays the Tools Manager's Icon 
Editor, described on page 13-12. 

Organize Command 

The Organize command arranges the tool icons into neat 
rows and columns. 
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Resident PostScript 
Fonats 

'lflHIS appendix lists the names of the resident PostScript fonts 
JL and the names of their Artline counterparts. 

PostScript font name Artline font name 

ITC Avant Garde® Advantage 

ITC Bookman® Booker 

Courier Courier 

Helvetica® Nimbus Sans 

Helvetica® Narrow Suisse Thin 

New Century Schoolbook Scholar 

Palatino® Palladio 

Times® Roman Nimbus Serif 

ITC Zapf Chancery® Zapf Chancery 

ITC Zapf Dingbats® Wombat 

Symbol Symbol 
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Artline and Memory 

T HIS appendix describes how Artline uses system memory, ex­
panded memory, and disk space. 

Memory and Disk Requirements 

To run Artline, your computer must have the following 
minimum amounts of free system memory, available disk 
space, and expanded memory: 

o free system memory 

On systems with expanded memory, a minimum of 
510Kb is required. On systems without expanded 
memory, a minimum of 540Kb is required. 

o available disk space 

A minimum of 512Kb of disk space must be available 
on the drive on which the Artline application and sys­
tem software files are installed. 

o expanded memory 

Expanded memory is not required. However, a mini­
mum of 512Kb of expanded memory must be available 
for Artline to be able to use it. 

In addition, the following settings are suggested mini­
mums for your CONFIG.SYS file: 

FILES = 20 

BUFFERS = 20 
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Expanded Memory 

Not Enough Memory 

If you do not have enough free RAM and available disk 
space, Artline cannot be started. The screen will switch 
to graphics mode, but when Artline detects that there is 
not enough memory, this alert is displayed: 

Not enough ~e~or9 to run Artline. 

Re~ove desk accessories or 
~e~or9-resident progra~s. 

To make memory available, remove any desk accessories 
or other memory-resident programs. If you need more 
memory, reduce the BUFFERS count in CONFIG.SYS. 

Exparided Memory 

You may also need to 
set switches on your 
memory board. 

B-2 

Artline can use expanded memory (also referred to as 
EMS) for loading images and other functions. 

When you purchase a board with additional memory for 
your system, the memory can be configured as RAM (up 
to the limit of your system), expanded memory, or ex­
tended memory. To use extended memory as EMS, you 
must convert it to EMS by adding an expanded memory 
driver to your CONFIG.SYS file. For example, the line 

DEVICE=C:\DRDOS\EMM386.SVS 

loads the DR DOSTM 5.0 expanded memory driver. 

As mentioned above, note that expanded memory is not 
required in this version of Artline. If enough expanded 
memory is available, however, Artline will use it. 
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Paging Files 

Paging Files 

If you do not have EMS or if there is not enough ex­
panded memory to use, Artline opens a temporary paging 
file in the directory in which ARTLINE.APP is located. 

This paging file converts a portion of your hard disk to 
"virtual expanded memory" so that you can still use all of 
Artline's features. 

Lost Clusters 

If your computer "crashes" at any time (due to a power 
failure or other unforeseen circumstance), you may find 
that a portion of your disk space is occupied by "lost clus­
ters" that should be deleted. 

To detect lost clusters, type the following command from 
the operating system prompt: 

CHKDSK [d:] IF 

where [d:] is the identifier for the drive on which Artline 
is installed. If you are already logged on to that drive, 
you need not include the drive identifier in the CHKDSK 
command. 

Refer to your operating system manual for a description 
of the CHKDSK command and how to use it to remove 
lost clusters. 

Memory Status 

To display a dialog that includes information on how mem­
ory is being used, choose the Artline Info command from 
the ARTLINE menu (at the right end of the menu bar). 

This dialog tell whether expanded memory is being used 
and, if so, how much is being used. 
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nrhis appendix describes the five custom toolboxes included with 
JL the Artline installation. These toolboxes are contained in the 

following files: 

o l_COLUMN.TLS 
o 4_COLUMN.TLS 
oALIGN.TLS 
o CUSTOM.TLS 
oTRACE.TLS 

The Artline installation program placed these files in the 
\ARTLINE\TOOLS directory on the same drive that con­
tains the Artline application files. 

You can use the custom toolboxes as they come "out of the 
box," or you can use them as templates, the starting point 
for creating your own toolboxes. 

Opening and using custom toolboxes is described in 
Chapter 13. 
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7 _ COLUMN. TLS 

l_COLUMN,TLS 

C-2 

The tools in l_COLUMN.TLS are a subset of those con­
tained in ARTLINE.TLS, arranged in a single column to 
give you a larger workspace. The tools' icons and func­
tions are identical to those described in Chapter 2. 

+0--- Selector 

<1--- Magnifier 

+---- Layer tool 

+---- Rectangle tool 

+----Quill 

+---- Trace tool 

+0--- Text tool 

+---- Fill Color tool 

+---- Line Width tool 

+---- Plane 

+---- Rolling Pin 

+---- Rotator 

+0--- Flipper 

To use the Fill Color tool for fountains or line color, double­
click on the tool and change its function in the Color Tool 
Options dialog (see page 2-44). 
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The tools file 4_COLUMN.TLS contains all but one of the 
tools contained in ARTLINE.TLS. (The absent tool is the 
Rounded Rectangle tool.) 

This toolbox is primarily intended for low-resolution sys­
tems-such as those using CGA monitors-where the 
standard toolboxes are too "tall" for the screen . 

Custom Toolboxes 

.- Selector, View tool, Layer tool, Magnifier 

.- Line tool, Quill, Sketch tool, Trace tool 

.- Rectangle tool, Circle tool, Plane, Text tool 

.- Fill Color tool, Fountain tool, Line Color tool, 
Line Width tool 

.- Flipper, Rolling Pin, Thumbtack, Rotator 
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ALIGN.TLS 

ALIGN,TLS 

C-4 

The tools file ALIGN.TLS contains the same tools as 
ARTLINE.TLS, arranged in three columns, plus a special 
alignment tool. 

_ Selector, View tool, Magnifier 

_ Trace tool, Layer tool, Text tool 

_ Rectangle tool, Rounded Rectangle tool, Circle tool 

_ Quill, Sketch tool, Line tool 

_ Fill Color tool, Fountain tool, Line Color tool 

_ Plane, Rolling Pin, Line Width tool 
rr.--=i-~=--fl 

_ Flipper, Thumbtack, Rotator 
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AUGN.TLS 

The components of the alignment tool are shown below. 

Align top left, top center, top right 

Align left middle, center middle, right middle 

Align bottom left, bottom center, bottom right 

m ... --- Align top (no horizontal change) * * * Align middle (no horizontal change) 
_-- Align bottom (no horizontal change) 

~ I: 13 .... --- Align left, center, right (no vertical change) 

I::::::: 1 ... --- Align to Grid menu command tool 

The Align command is described on page 6-9. 

CAUTION: The alignment tool is made up of many small pieces care­
fully assembled. For that reason, we recommend that you 
not try to copy it to another toolbox or move it within this 
toolbox. 
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C;USTOM. TLS 

CUSTOM.TLS 

C-6 

The tools file CUSTOM. TLS contains the same tools as 
ARTLINE.TLS, in the same arrangement, plus six extra 
tools described below. 

Mask tool ---+ Blend tool 

Merge tool ---+ To Curves tool 

StatusRuler tool ---+ Rotate Grow tool 

Mask Tool 

The Mask tool is a menu tool for the Mask command 
(page 8-1). The Draw Mask Element option is turned off. 

Artline User Reference Guide 



CUSTOM.TLS 

Blend Tool 

The Blend tool is a menu tool for the Blend command 
(page 8-8). This tool blends the selected elements in ten 
steps. The Reverse Curve Direction option is turned off. 

Merge Tool 

The Merge tool is a menu tool for the Merge Elements 
command (page 8-4). 

To Curves Tool 

The To Curves tool is a menu tool for the Convert to 
Curves command (page 8-18). 

StotusRuler Tool 

The StatusRuler tool toggles the current state of the sta­
tus line and the rulers. For example, ifboth are turned 
off, clicking on the StatusRuler tool turns them on. If the 
status line is off and the ruler is on, clicking on the 
StatusRuler tool turns the status line on and the ruler off. 

Rotate Grow Tool 

The Rotate Grow tool is a container that holds six sets of 
the three commands described below: 

o A Rotate command tool, with a 30° Rotation Angle 
around the Selection Center-Make Copy turned on. 

o A Scale command tool, set for 110% Uniform scaling 
around the Selection Center-Make Copy turned off. 

o A Move command tool, with both the Horizontal and 
Vertical distance set to 0.20 inches-Make Copy 
turned off. 

When you click on this tool, the selected element is ro­
tated 30° and copied, scaled 110%, and then moved down 
and to the right 0.20 inches-and then the sequence is re­
peated five more times. 

Custom Toolboxes C-7 



TRACE.TLS 

TRACE.TLS 

The tools file TRACE. TLS contains a set of custom tools 
designed to expedite image tracing . 

Load Image ----+ .-- Image Options 

Trace tools with pre-set ----+ 
Tracing Options 

These tools are 
arranged in the 
order in which you 
would be likely to 
use them. 

Save As ----+ UR, ... ::::II-I· .. nlill.-- Save 

Unload Image ----+ .-- [Hide/Show] Image 

These tools use color 
for their icons. If you 
have a monochrome 
system, use the Tools 
Manager's Attrib­
utes command to 
change their color to 
black and white. 

TRACE.TLS also 
includes a standard 
Magnifier tool, 
Selector, Layer tool, 
Line Width tool, and 
Plane. 

C-8 

Cut----+ 

TRACE.TLS has five Trace tools with pre-set precision 
percentages of 0%, 25%, 50%, 75% and 100%. (Tracing 
precision is described on page 11-9.) Each tool has a gap 
size of zero and is set for Line Art. 

TRACE.TLS includes tools for the following menu com­
mands (references are to the pages on which the com­
mands are described in detail): 

o Load Image (4-1) 
o Image Options (11-4) 
o Save As (3-6) and Save (3-5) 
o Unload Image (4-3) 
o [Hide/Show] Image (5-2) 
o Cut (7-2) 

Artline User Reference Guide 



Inde)( 

The following is a list of the major entry categories in this Index, where much of the information 
in the Artline User Reference Guide can be found: 

o alerts o commands o dialogs 
o elements o files o tools 

Dialogs illustrated in the guide are indexed by the name that appears in the dialog's title bar. 
Alerts illustrated in the guide are indexed by the first line of text in the alert message. 

Misc. 
.$EM extension, 9-2 
.$LS extension, 9-2, 13-3 
.$OL extension, 9-2 
l_COLUMN.TLS, C-2 
4_COLUMN.TLS, C-3 
.J symbol, xviii 

A 
Abandon command, 3-9 
"Abandon/Save" alert, 3-2 
Active command (Layer Mgr), 10-16 
Active Layer (Export command), 3-7 
Add Color command (Color Mgr), 12-9, 12-26 
Add command (Tools Mgr), 13-20 
Add Fill command (Color Mgr), 12-12, 12-26 
Add Layer command (Layer Mgr), 10-5, 

10-13 
Add Point command (Plane tool pop-up), 2-58 
adding colors, 12-9 
adding fountains, 12-12 
alerts, 1-19 

exit buttons, 1-19 
"Abandon/Save," 3-2 
"Cannot find tracing image," 11-10, 11-15 
"Cannot trace segment," 11-11 
"Merging multiple-layer file," 3-4, 10-7 

"Not enough memory to run Artline," B-2 
"The current toolbox will be replaced," 13-18 
"The outline of this image is too long," 11-10 
"The selected color will be removed," 12-11, 

12-19 
"Wrong file type," 4-1 
"Wrong image file format," 4-2 

Align command, 6-8 
Align Horiz command (Plane tool pop-up), 

2-62 
Align to Grid command, 6-7 
Align Vert command (Plane tool pop-up), 2-62 
ALIGN.TLS, C-4 
aligning elements, 6-8 
alignment tool in ALIGN.TLS, C-4 
All command (Layer Mgr), 10-16 
anchor points, 2-20 
arrows (scrollers), 1-6 
Artline Info command, B-3 
ARTLINE.COL 

loaded by New command, 3-2 
ARTLINE.INI, 9-5 - 9-6, 13-2 
ascender, 2-33 
Attributes command (Tools Mgr), 13-21 
Auto (Create Text I tern dialog), 2-33 
Auto Redraw command (Layer Mgr), 10-20 
autotracing 

See "tracing" 
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B 
Backspace key 

deleting points drawn with Quill, 2-27 
backup files, 9-2 

saving, 3-5 
bit-image files, 11-1 
Blend command, 8-8 
Blend tool (CUSTOM.TLS), C-7 
blends, 8-8 

colors in, 8-12 
converting to curves, 8-19 
elements not permitted, 8-12 
rainbow effect, 8-13 
splitting, 8-20 

Brightness (HSB color mode!), 12-7 
Bring to Front command, 6-2 
BUFFERS setting (CONFIG.SYS), B-1 

c 
Cancel button, 1-18 
caps 

See "line end styles" 
CGA monitors, C-3 
check boxes, 1-15 
CHKDSK command, B-3 
Circle tool, 2-39 
circles 

drawing, 2-40 
drawing from center, 2-40 
screen distortion, 2-40 

click (mouse technique), 1-8 
clip art, xvi 
Clone command, 2-63, 7-5, 8-13 
Close command (Color Mgr), 12-24 
Close command (Layer Mgr), 10-3, 10-14 
Close command (Tools Mgr), 13-20 
clusters, B-3 
CMY color model, 12-5 

compared to RGB and HSB, 12-8 
converting to CMYK, 12-8 

Color & Patterns (Image Options dialog), 11-4 
color correction, 3-19 
color files, 12-3 

adding colors, 12-11 
adding fountains, 12-19 
creating, 12-20 

Index-2 

Color Manager, 12-1 
Colors mode, 12-9 
Fills mode, 12-12 
modifying colors, 12-10 
modifying fountains, 12-18 

Color Manager command, 12-1 
color models, 12-5 

CMY, 12-5 
comparison table, 12-8 
HSB, 12-6 
RGB, 12-6 

Color Options dialog, 2-44 
color selectors 

List and Palette, 2.;.45 
color separation, 3-16 
colors 

adding to color file, 12-11 
availability in Color Manager and tools 12-3 
creating, 12-9 ' 
deleting from color file, 12-25 
hiding, 5-2 
loading PANTONE, 12-22 
modifying, 12-10 
PANTONE, 12-21 
picture, 12-4 
removing from color file, 12-11 
unaffiliated, 12-4 

Colors command, 5-2 
Colors command (Color Mgr), 12-9, 12-27 
Colors mode (Color Mgr), 12-9 
Combine menu, 8-1 
commands 

available and unavailable, 1-13 
choosing, 1-12 
keyboard equivalents, 1-13 
toggles, 5-1 
Abandon, 3-9 
Active (Layer Mgr), 10-16 
Add (Tools Mgr), 13-20 
Add Color (Color Mgr), 12-9, 12-26 
Add Fill (Color Mgr), 12-12, 12-26 
Add Layer (Layer Mgr), 10-5,10-13 
A~d Point (Plane tool pop-up), 2-58 
Ahgn, 6-8 
Al~gn Horiz (Plane tool pop-up), 2-62 
Align to Grid, 6-7 
Align Vert (Plane tool pop-up), 2-62 
All (Layer Mgr), 10-16 
Artline Info, B-3 



Attributes (Tools Mgr), 13-21 
Auto Redraw (Layer Mgr), 10-20 
Blend, 8-8 
Bring to Front, 6-2 
Clone, 2-63, 7-5, 8-13 
Close (Color Mgr), 12-24 
Close (Layer Mgr), 10-3, 10-14 
Close (Tools Mgr), 13-20 
Color Manager, 12-1 
Colors, 5-2 
Colors (Color Mgr), 12-9, 12-27 
Convert to Curves, 8-18 
Copy, 7-3 
Cut, 7-2 
Delete, 7-4 
Delete (Color Mgr), 12-25 
Delete (Tools Mgr), 13-20 
Delete Point (Plane tool pop-up), 2-58 
Duplicate, 2-63, 7-5 
Duplicate (Color Mgr), 12-25 
Duplicate (Tools Mgr), 13-21 
Element Info, 2-21, 6-11 
Export, 3-7 
Fills (Color Mgr), 12-12, 12-27 
Font Manager, 9-7 
Fountains, 5-3 
Function (Tools Mgr), 13-22 
Grid, 5-6 
Group, 6-5 
Guide Lines, 5-8 
Icon (Tools Mgr), 13-22 
Image, 4-3, 5-2 
Image Options, 4-3,11-4 
Join Points (Plane tool pop-up), 2-59 
Layer Manager, 10-2 
Load (Color Mgr), 12-23 
Load (Tools Mgr), 13-19 
Load Image, 4-1,11-3 
Lock, 2-54, 6-4 
Mask, 8-1 
Merge (Color Mgr), 12-24 
Merge Elements, 8-4 
Merge File, 3-4 
Modify (Color Mgr), 12-10, 12-18, 12-26 
Modify Layer (Layer Mgr), 10-14 
Move, 7-6 
New, 3-2 
Open, 3-3 
Organize (Tools Mgr), 13-22 

Page Layout, 3-10 
Paste, 7-3 
PostScript, 3-13 
Preferences, 9-2 
Quit, 3-24 
Redraw (Layer Mgr), 10-20 
Remove Layer (Layer Mgr), 10-14 
Repeat, 7-12 
Reset (Color Mgr), 12-20, 12-23 
Reset (Tools Mgr), 13-18 
Rotate, 7-7 
Rulers, 5-3 
Save, 3-5 
Save (Color Mgr), 12-24 
Save (Tools Mgr), 13-19 
Save As, 3-6 
Save As (Color Mgr), 12-24 
Save As (Tools Mgr), 13-19 
Save Preferences, 9-5 
Scale, 7-9 
Select All, 2-4, 7-4 
Send to Back, 6-2 
Set Grid, 5-7 
Set Guide Lines, 5-9 
Slides (Layer Mgr), 10-19 
Smooth (Plane tool pop-up), 2-60 
Snap to Grid, 5-6 
Sort by Bright, 12-28 
Sort by Hue (Color Mgr), 12-28 
Sort by Name (Color Mgr), 12-28 
Split Element, 8-20 
Split Point (Plane tool pop-up), 2-59 
Status Line, 5-4 
Step in Back, 6-2 
Step in Front, 6-2 
Symmetric (Plane tool pop-up), 2-60 
Text Along Path, 8-14 
To App, 3-21 
To Curve (Plane tool pop-up), 2-59 
To Line (Plane tool pop-up), 2-58 
To Output, 3-24 
Toolbox, 2-2,5-10 
Tools Manager, 13-1 
Undo, 7-2 
Ungroup, 6-6 
Unload Image, 4-3 
Unlock, 6-4 
Visible (Layer Mgr), 10-17 
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compound curves, 2-23 
drawing, 2-24 

CONFIG.SYS, B-1 - B-2 
container tools, 13-5 

creating, 13-7 
contrast (tracing options), 11-15 
Convert to Curves command, 8-18 
Copy command, 7-3 
copying elements, 2-9 
corner points, 2-20 
Courier font 

PostScript resident form, 9-8 
creating color files, 12-20 
creating colors, 12-9 
creating fountains, 12-12 
crop marks 

See "trim marks" 
cross and crosshair (pointer forms), 2-22 
Ct.rl-click element selection, 2-4 
curves 

adding lines, 2-25 
compound, 2-23 - 2-24 
drawing, 2-23 
editing, 2-56 
re-opening, 2-27 
simple, 2-23 - 2-24 
solid tangent edits, 2-56 

Custom (Create Text Item dialog), 2-33 
Custom paper size, 3-15 
custom toolboxes, C-l 

I_COLVMN.TLS, C-2 
4_COLUMN.TLS, C-3 
ALIGN.TLS, C-4 
CUSTOM.TLS, C-6 
TRACE. TLS, C-8 

custom views, 2-16 
CUSTOM.TLS, C-6 
Cut command, 7-2 

D 
default layer, 10-4· 
Delete command, 7-4 
Delete command (Color Mgr), 12-25 
Delete command (Tools Mgr), 13-20 
Delete Point command (Plane tool pop-up), 

2-58 
descender, 2-33 

Index-4 

desk accessories, B-2 
dialogs, 1-14 

check boxes, 1-15 
clearing fields, 1-15 
direct entry fields, 1-15 
exit buttons, 1-18 
exiting, 1-18 
memory information, B-3 
moving, 1-19 
pop-up menus, 1-17 
pop-up sliders, 1-17 
radio buttons, 1-14 
Add Color, 12-9 
Add Fill, 12-12 
Add Layer, 10-4, 10-9 
Blend Elements, 6-13, 8-9 
Color Manager, 12-1 
Color Tool Options, 2-44 
Create Text Element, 2-30, 6-13 
Custom Page Size, 3-10 
Custom Size, 2-32 
Element Alignment, 6-8 
Element Info, 6-12 
Export Picture, 3-7 
Font Manager, 9-7 
Global Preferences, 9-2 
Guide Lines, 5-9 
Image Options, 11-4 
Layer Manager, 10-2 
Line Attributes, 2-48 
Line Options, 2-41 
Mask Elements, 6-13, 8-3 
Modify Layer, 10-8 
Move Elements, 7-6 
Page Layout, 3-10 
PostScript Options, 3-17 
PostScript Output, 3-13 
Preview Curve, 11-12 
Rectangle Options, 2-38 
Rotate Elements, 7-7 
Rotator Options, 2-51 
Run Application, 3-21 
Scale Elements, 7-9 
Selector Options, 2-11 
Set Grid, 5-7 
Text Along a Path, 6-13, 8-14 
Tool Attributes, 13-9 
Tools Manager, 13-1 
Tracing Options, 11-7, 11-14 



dingbats 
See "Wombat characters" 

direct entry fields, 1-15 
direction points, 2-23, 2-56 
directory path 

changing in Item Selector, 1-22 
directory tree, 1-22 
disk space requirements, B-1 
documentation set, xvi 
dot screen (fountains), 12-16 
dot screens, 3-17 
double-click (mouse technique), 1-8 
DR DOS 5.0 (operating system), B-2 
drag (mouse technique), 1-9 
Draw Mask Element (Mask Elements dialog), 

8-3 
drawing surface, 1-5 
drop-down menus, 1-12 
Duplicate command, 2-63, 7-5 
Duplicate command (Color Mgr), 12-25 
Duplicate command (Tools Mgr), 13-21 

E 
Edit menu, 7-1 
Element Info command, 2-21, 6-11 
Element menu, 6-1 
elements, 1-10 

255-point limit, 2-20 
aligning, 6-8 
aligning to grid, 6-7 
blending, 8-8 
changing order in stack, 6-2 
changing shape with Plane, 2-53 
cloning, 7-5 
combining into single layer, 10-6 
copying, 2-9 
copying between layers, 10-6 
copying part with the Plane, 2-63 
copying to paste buffer, 7-3 
copying while rotating, 7-8 
copying while scaling, 7-11 
copying with Rotator, 2-50 
copying with the Flipper, 2-64 
cutting to paste buffer, 7-2 
deleting, 7-4 
distorting with rolling pin, 2-65 
drawing to grid, 5-6 

duplicating, 7-5 
flipping, 2-64 
groups, 6-5 
information dialog, 6-12 
locking, 6-4 
masking, 8-1 
merging, 8-4 
moving, 7-6 
moving from layer to layer, 10-6 
moving or scaling with grid snap on, 5-6 
moving with Element Info dialog, 6-12 
pasting from buffer, 7-3 
rainbow effect, 8-13 
rotating, 2-50, 7-7 
scaling, 2-7, 7-9 
scaling with Element Info dialog, 6-12 
selected, 2-2 
selecting, 2-3 
selecting (table), 2-5 
selecting all, 2-4, 7-4 
selecting element on bottom of stack, 2-4 
selecting overlapping elements (F4 key), 2-4 
splitting, 8-20 
stacks, 1-10, 10-1 
ungrouping, 6-6 
unlocking, 6-4 

ellipses 
See "circles" 

EMM386.SYS, B-2 
EMS 

See "expanded memory" 
encapsulated PostScript, 3-14 
EPS file format 

opening in Artline, 3-3 
EPSF, 3-14 
ESC key 

as Cancel button, 1-18 - 1-19 
to redraw screen, 1-7 

exit buttons, 1-18 
.J key shortcut, 1-18 - 1-19 
Esc key shortcut, 1-18 - 1-19 

"exit the dialog," 1-18 
expanded memory, B-2 

drivers, B-2 
requirements, B-1 
virtual, B-3 

Export command, 3-7 
Active Layer option, 3-7 
Multiple .GEM Files option, 3-9, 10-11 
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Multiple-Page .GMP File option, 3-9, 10-11 
Selected Elements option, 3-8 
Single-Sheet .GEM File option, 3-9 
Slides option, 3-8, 10-11 
Spot Colors option, 3-8 
Visible Layers option, 3-7 

exporting files, 3-7 
extensions, 1-11 

F 
file formats 

valid for Artline, 3-3 
valid for merging, 3-5 

File menu, 3-1 
file types, 1-11 
files 

backups, 9-2 
bit-image, 11-1 
exporting, 3-7 
merging, 3-4 
merging from multiple layers, 3-4 
merging from one layer, 3-4 
opening, 3-3,9-3 
saving, 3-5 
saving for first time, 3-6 
saving to directory or disk, 3-6 
saving under new name, 3-6 
vector, 11-1 

FILES setting (CONFIG.SYS), B-1 
Fill Color tool, 2-42 

New Color option, 12-9 
fills 

See "fountains" 
Fills command (Color Mgr), 12-12, 12-27 
Fills mode (Color Mgr), 12-12 
flip line, 2-64 
Flipper tool, 2-64 

copying elements, 2-64 
font attributes 

Download, 9-9 
Resident, 9-8 
Vector, 9-9 

font filters, xvi 
Font Manager, 9-7 
Font Manager command, 9-7 

Index-6 

fonts 
adding, 9-10 
Artline equivalents of resident PostScript 

set,A-l 
attributes, 9-8 
downloading to PostScript, 9-9 
removing, 9-10 

Fountain tool, 2-42 
New Fill option, 12-12 

fountains, 12-2 
adding to color file, 12-19 
creating, 12-12 
even (gradation), 12-14 
grouped elements, 6-6 
hiding, 5-3 
linear, 12-14 
log (gradation), 12-14 
modifying, 12-18 
multi-color rainbow effect, 8-13 
PostScript Fill Options, 12-15 
radial, 12-14 
removing from color file, 12-19 
See also "colors" 

Fountains command, 5-3 
full box, 1-7 
full view, 2-17 
Function command (Tools Mgr), 13-22 

G 
gap size, 11-8 
.GEM file format, 3-3 
gradation (fountains), 12-14 
gray levels (tracing options), 11-15 
grayscale images, 11-8 

tracing, 11-14 
grid, 5-6, 6-7 

setting spacing, 5-7 
snap, 5-6 
spacing, 5-7 

Grid command, 5-6 
grid snap, 5-6 

turn off for tracing, 11-16 
Group command, 6-5 
groups, 6-5 

maximum nested levels, 6-6 
nesting, 6-6 
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guide lines, 5-8 
aligning to, 6-8 
moving, 2-10 
position, 5-9 
rotating around, 7-7 
scaling relative to, 7-10 

Guide Lines command, 5-8 

H 
halftone screen frequency, 3-18 
handles, 2-2 

effects of dragging (scaling), 2-7 
HSB color model, 12-6 

Brightness, 12-7 
compared to CMY and RGB, 12-8 
Hue, 12-6 
Saturation, 12-7 

Hue (HSB color model), 12-6 

Icon command (Tools Mgr), 13-22 
Icon Editor (Tools Mgr), 13-12 
Icon Selector (Tools Mgr), 13-9, 13-15 
icons 

drawing, 13-15 
Image command, 4-3, 5-2 
image files, 11-1 
image frame, 11-3 
Image menu, 4-1 
image options, 11-4 

saving, 11-6 
Image Options command, 4-3,11-4 
images 

grayscale, 11-8 
hiding, 5-2 
line art, 11-8 
loading, 4-1, 11-2 
options, 4-3, 11-4 
tracing, 4-1 
unloading, 4-3 
valid formats, 11-2 

.IMG extension, 4-1 
IMG file format, 11-2 
.IMG files 

valid formats for tracing, 4-2 

insufficient memory, B-2 
Item Selector, 1-20 

J 

changing directory path, 1-22 
choosing files, 1-23 
Directory line, 1-21 
editing keys, 1-22 
list window, 1-21 
wildcards, 1-21 

Join Points command (Plane tool pop-up), 
2-59 

junction points, 2-20 

K 
keyboard commands, 1-13 
keyboard shortcuts, 1-13 

L 
Landscape page orientation (Page Layout), 

3-11 
Landscape paper orientation (PostScript 

output),3-15 
Layer Manager, 10-1 

circle marker, 10-16 
closing, 10-3 
display markers, 10-16 
displaying, 10-2 
light bulb marker, 10-16 

Layer Manager command, 10-2 
Layer tool, 2-13, 10-2 
layers, 10-1 

activating, 10-3 
activating with PgUp and PgDn, 2-13 
adding, 10-4 
changing order, 10-5 
combining into single layer, 10-6 
default, 10-4 
display markers, 10-16 
display status saved with file, 3-5, 10-15 
displaying as overlays, 10-18 
displaying selected layers, 10-18 
limits on number, 10-2 
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printing slides, 10-11 
slide background, 10-8 
slide foreground, 10-9 
slides, 10-8 
Visible status, 10-17 

leading 
See "line spacing" 

line art images, 11-8 
line attributes 

setting, 2-48 
Line Color tool, 2-42 

New Color option, 12-9 
line end styles, 2-48 
line screen (fountains), 12-16 
line screens, 3-17 
line spacing, 2-32 

Auto, 2-33 
Custom, 2-33 
Solid,2-33 
table, 2-33 

Line tool, 2-41 
line width 

screen and printer limitations, 2-47 
Line Width tool, 2-47 
linear fountains, 12-14 
lines 

adding curves, 2-25 
List (color selector), 2-45 
Load command (Color Mgr), 12-23 
Load command (Tools Mgr), 13-19 
Load Image command, 4-1, 11-3 
loading images, 11-2 
Lock command, 2-54, 6-4 
lost clusters, B-3 

M 
MAGI Corp, xvi 
Magnifier, 2-17 

full view, 2-17 
minus (-) key, 2-18 
plus (+) key, 2-18 
zooming in on drawing surface, 2-17 
zooming out one level, 2-17 

Mask command, 8-1 
Mask tool (CUSTOM.TLS), C-6 
masked elements, 8-1 

splitting, 8-20 

Index-8 

memory 
dialog showing usage, B-3 
not enough to start Artline, B-2 

memory requirements, B-1 
memory-resident programs, B-2 
menu bar, 1-3 
menu tools, 13-5 

creating, 13-6 
menus 

displaying, 1-12, 9-3 
drop-down, 1-12 
pull-down, 1-12 
undisplaying, 1-13 
Combine, 8-1 
Edit, 7-1 
Element, 6-1 
File, 3-1 
Image, 4-1 
Options, 9-1 
View, 5-1 

Merge command (Color Mgr), 12-24 
Merge Elements command, 8-4 
Merge File command, 3-4 
Merge tool (CUSTOM.TLS), C-7 
merged elements, 8-4 

characteristics, 8-5 
splitting, 8-20 

merging files with layers, 3-4 
minus (-) key 

direct entry fields, 1-16 
Modify Color dialog 

displaying, 12-10, 12-18 
Modify command (Color Mgr), 12-10, 12-18, 

12-26 
Modify Layer command (Layer Mgr), 10-14 
modifying colors, 12-10 
modifying fountains, 12-18 
moire patterns, 3-18 
mouse techniques, 1-8 

click, 1-8 
double-click, 1-8 
drag, 1-9 

Move command, 7-6 
Multiple .GEM Files (Export command), 3-9, 

10-11 
Multiple-Page .GMP File (Export command), 

3-9, 10-11 



N 
nested groups 

maximum number of levels, 6-6 
New Color option (Fill Color and Line Color 

tools), 12-9 
New command, 3-2 
New Fill option (Fountain tool), 12-12 
New Layer (Layer tool), 10-4 
New View option (View tool), 2-16 
notational conventions, xviii 

o 
Offsets (Image Options dialog), 11-6 
Offsets (Page Layout dialog), 3-11 
OK button, 1-18 
Open command, 3-3 
opening files, 3-3 
Options menu, 9-1 
Organize command (Tools Mgr), 13-22 
Output, xvi 

p 

displaying slides, 10-12 
starting, 3-24 

Page Layout command, 3-10 
page orientation, 3-11 
paging files, B-3 
Palette (color selector), 2-45 
PANTONE colors, 12-21 

loading, 12-22 
paste buffer, 7-2 
Paste command, 7-3 
PCX file format, 4-1, 11-2 
.PCX files 

valid formats for tracing, 4-2 
pgDnkey 

activating layers, 2-13, 10-3 
direct entry fields, 1-16 

PgUpkey 
activating layers, 2-13, 10-3 
direct entry fields, 1-16 

picture colors, 12-4 
pixels, 11-1, 13-15 

Plane tool, 2-53 
selecting points, 2-54 
turns off fill and lines, 2-53 

plus (+) key 
direct entry fields, 1-16 

points 
anchor points, 2-20 
corner points, 2-20 
deleting, 2-27 
junction points, 2-20 
mapping in blends, 8-10 
moving with grid snap on, 5-6 
selecting with Plane, 2-54 
tangent points, 2-20 

polygons 
drawing, 2-25 

pop-up menus, 1-17 
pop-up sliders, 1-17 
Portra~t page orientation (Page Layout), 3-11 
Portrait paper orientation (PostScript 

output),3-15 
PostScript command, 3-13 
PostScript file output, 3-14 
PostScript Fill Options, 12-15 
PostScript fonts 

Artline equivalents, A-I 
PostScript output, 3-13 

color separation, 3-16 
paper orientation, 3-15 
paper size, 3-15 
picture scaling, 3-15 
resolution, 3-18 
slides, 3-16, 10-11 

PostScript printers, 9-8 
resident fonts, 9-8 

precision (tracing options), 11-9 
preferences, 9-2 

restoring original set, 9-6 
saved in ARTLINE.INI, 9-5 
saving, 9-5 

Preferences command, 9-2 
process colors, 12-5 
pull-down menus, 1-12 
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Q 

Quill tool, 2-22 
adding curves to lines, 2-25 
adding lines to curves, 2-25 
closing elements, 2-24 
drawing curves, 2-23 
drawing polygons, 2-25 
pointer forms, 2-22 
re-opening curves, 2-27 

Quit command, 3-24 
quitting Artline, 3-24 

R 
radial fountains, 12-14 
radio buttons, 1-14 
Rectangle Options dialog, 2-38 
Rectangle tool, 2-36 
rectangles 

drawing, 2-36 
drawing from center, 2-37 

redrawing the screen, 1-7 
Redraw command (Layer Mgr), 10-20 
Redraw Speed (Global Preferences dialog), 9-4 
registration marks (Page Layout dialog), 3-11 
registration marks (PostScript Output 

dialog), 3-20 
Remove Layer command (Layer Mgr), 10-14 
Repeat command, 7-12 
Reset command (Color Mgr), 12-20,12-23 
Reset command (Tools Mgr), 13-18 
resident fonts, 9-8 
Reverse Curve Direction (Blend Elements 

dialog), 8-10 
RGB color model, 12-6 

compared to CMY and RSB, 12-8 
rolling pin tool, 2-65 
root directory, 1-22 
Rotate command, 7-7 
Rotate Grow tool (CDSTOM.TLS), C-7 
Rotator tool, 2-50 
rounded rectangle 

drawing, 2-36 
Rounded Rectangle tool, 2-38 
rulers, 5-3 
Rulers command, 5-3 
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s 
Saturation (RSB color model), 12-7 
Save As command, 3-6 
Save As command (Color Mgr), 12-24 
Save As command (Tools Mgr), 13-19 
Save command, 3-5 
Save command (Color Mgr), 12-24 
Save command (Tools Mgr), 13-19 
Save Preferences command, 9-5 
saving files, 3-5 

backup files, 3-5 
Scale command, 7-9 
Scaling (Image Options dialog), 11-5 
scaling elements, 2-7 
screen, 1-2 

drawing surface, 1-5 
full box, 1-7 
menu bar, 1-3 
redrawing, 1-7 
scrollers, 1-6 
size box, 1-7 
surround, 1-5 
title bar, 1-3 
toolbox, 1-2 
window, 1-2 
workspace, 1-5 

Screen Angle (PostScript Fill Options dialog), 
12-17 

screen angle (PostScript output), 3-18 
Screen Function (PostScript Fill Options 

dialog), 12-16 
Screen Resolution (PostScript Fill Options 

dialog), 12-17 
scroll bars, 1-6 
scrollers, 1-6 

arrows, 1-6 
scroll bars, 1-6 
sliders, 1-7 

Select All command, 2-4, 7-4 
Selected Elements (Export command), 3-8 
selecting elements, 2-12 
selecting overlapping elements (F4 key), 2-4 
selection frame, 2-2 
Selector Options, 2-11 
Selector tool, 2-2 

using other tools as, 2-12 
Send to Back command, 6-2 
Set Grid command, 5-7 



Set Guide Lines command, 5-9 
Shift key 

direct entry fields, 1-16 
pop-up sliders, 1-17 

simple curves, 2-23 
drawing, 2-24 

Single-Sheet .GEM File (Export command), 
3-9 

size box, 1-7 
Sketch tool, 2-28 
sliders, 1-7 
slides, 10-8, 10-19 

background layer, 10-8 
creating, 10-8 
foreground layer, 10-9 
limit on length of filename (Export), 3-9 
printing, 10-11 
screen displays, 10-12 

Slides (Export command), 3-8, 10-11 
Slides command (Layer Mgr), 10-19 
Smooth command (Plane tool pop-up), 2-60 
Snap to Grid command, 5-6 
Solid (Create Text Item dialog), 2-33 
Sort by Bright command (Color Mgr), 12-28 
Sort by Hue command (Color Mgr), 12-28 
Sort by Name command (Color Mgr), 12-28 
Split Element command, 8-20 
Split Point command (Plane tool pop-up), 

2-59 
spot colors, 3-8 
Spot Colors (Export command), 3-8 
squares 

drawing, 2-37 
drawing from center, 2-37 
screen distortion, 2-37 

stacks, 1-10, 10-1 
standard tools, 13-4 

creating, 13-6 
status line, 5-4 
Status Line command, 5-4 
StatusRuler tool (CUSTOM.TLS), C-7 
Step in Back command, 6-2 
Step in Front command, 6-2 
surround, 1-5 
Symbol characters 

not displayable in text window, 2-35 
Symmetric command (Plane tool pop-up), 

2-60 

T 
tangent lines, 2-23, 2-56 
tangent points, 2-20, 2-23, 2-56 
text 

converting to curves, 8-18 
editing keys (table), 2-35 
group after converting to curves, 8-18 
line spacing, 2-32 
masking with, 8-3 
merging with, 8-7 
placing along a path, 8-14 
PostScript printers, 9-8 
re-opening for editing, 2-35 

text along a path, 8-14 
converting to curves, 8-18 
splitting, 8-20 

Text Along Path command, 8-14 
text characters 

creating with Merge, 8-7 
Text tool, 2-30 
Thumbtack, 2-63 

aligning to, 6-8 
rotating around, 7-7 
scaling relative to, 7-10 

TIFF file format, 4-1,4-2, 11-2 
TIFF preview 

EPSF output, 3-14 
title bar, 1-3 
.TLS extension, 13-2 
To App command, 3-21 
To Curve command (Plane tool pop-up), 2-59 
To Curves tool (CUSTOM.TLS), C-7 
To Line command (Plane tool pop-up), 2-58 
To Output command, 3-24 
toggles, 5-1 
Tool Attributes dialog (Tools Mgr), 13-9 
tool icons 

selecting, 13-9, 13-15 
toolbox, 1-2 

arranging tools, 13-4 
changing default, 13-2 
changing size, 13-3 
custom, C-1 
default, 13-2 
hiding, 2-2, 5-10 
low-resolution systems, C-3 
See also "custom toolboxes" 
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Toolbox command, 2-2, 5-10 
tools 

container, 13-5 
creating custom, 13-6 - 13-7 
drawing icons, 13-15 
maximum allowed in toolbox, 13-6 
menu, 13-5 
moving, 13-4 
standard, 13-4 
Circle, 2-39 
Fill Color, 2-42 
Flipper, 2-64 
Fountain, 2-42 
Layer, 2-13 
Line, 2-41 
Line Color, 2-42 
Line Width, 2-47 
Magnifier, 2-17 
Plane, 2-53 
Quill,2-22 
Rectangle, 2-36 
Rotator, 2-50 
Rounded Rectangle, 2-38 
Selector, 2-2 
Sketch, 2-28 
Text, 2-30 
Thumbtack, 2-63 
Trace, 2-29 
View, 2-14 

tools files, 13-2 
Tools Manager, 13-1 

Icon Editor, 13-12 
Tools Manager command, 13-1 
trace segments, 11-11 
Trace tool, 2-29 
TRACE.TLS, C-8 
tracing 

advancing or backing up, 11-13 
autotrace contrast, 11-15 
autotrace options, 11-7 
autotrace precision, 11-9 
autotrace techniques, 11-10 
autotracing, 11-2 
autotracing-typical steps, 11-7 
canceling autotrace, 11-14 
changing autotrace precision, 11-13 
direction of autotrace line, 11-9 
gray levels, 11-15 
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grayscale images, 11-14 
hand tracing, 11-2, 11-16 
image frame, 11-3 
image options, 11-4 
loading the image, 11-2 
saving image options, 11-6 
stopping autotrace, 11-12 
trace segments (part of the image), 11-11 
valid image file formats, 4-2, 11-2 

trim marks (Page Layout dialog), 3-11 
trim marks (PostScript Output dialog), 3-20 
typefaces 

See "fonts" 

u 
undercolor removal, 3-19 
Undo command, 7-2 
Ungroup command, 6-6 
Unload Image command, 4-3 
Unlock command, 6-4 

v 
vector files, 11-1 
View menu, 5-1 
View Tool, 2-14 
views 

defining, 2-16 
virtual expanded memory, B-3 
Visible command (Layer Mgr), 10-17 
Visible Layers (Export command), 3-7 

w 
wildcards, 1-21 
window, 1-2 

moving, 1-3 
Wombat characters 

not displayable in text window, 2-35 
workspace, 1-5 

z 
zooming, 2-17 




